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Legal information
Warning notice system

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent 
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert 
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are 
graded according to the degree of danger.

DANGER
indicates that death or severe personal injury will result if proper precautions are not taken.

WARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

CAUTION
indicates that minor personal injury can result if proper precautions are not taken.

NOTICE
indicates that property damage can result if proper precautions are not taken.
If more than one degree of danger is present, the warning notice representing the highest degree of danger will be 
used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to property 
damage.

Qualified Personnel
The product/system described in this documentation may be operated only by personnel qualified for the specific 
task in accordance with the relevant documentation, in particular its warning notices and safety instructions. Qualified 
personnel are those who, based on their training and experience, are capable of identifying risks and avoiding 
potential hazards when working with these products/systems.

Proper use of Siemens products
Note the following:

WARNING
Siemens products may only be used for the applications described in the catalog and in the relevant technical 
documentation. If products and components from other manufacturers are used, these must be recommended or 
approved by Siemens. Proper transport, storage, installation, assembly, commissioning, operation and 
maintenance are required to ensure that the products operate safely and without any problems. The permissible 
ambient conditions must be complied with. The information in the relevant documentation must be observed.

Trademarks
All names identified by ® are registered trademarks of Siemens AG. The remaining trademarks in this publication 
may be trademarks whose use by third parties for their own purposes could violate the rights of the owner.

Disclaimer of Liability
We have reviewed the contents of this publication to ensure consistency with the hardware and software described. 
Since variance cannot be precluded entirely, we cannot guarantee full consistency.  However, the information in this 
publication is reviewed regularly and any necessary corrections are included in subsequent editions.
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Preface

SINUMERIK documentation

The SINUMERIK documentation is organized in the following categories:

● General documentation

● User documentation

● Manufacturer and service documentation

This documentation belongs to the manufacturer and service documentation category.

Additional information
You can find information at www.siemens.com/motioncontrol/docu for the following topics:

● Ordering documentation / overview of documentation

● Additional links to download documents

● Using documentation online (find and search in manuals/information)

Please send any questions about the technical documentation (e.g. suggestions for
improvement, corrections) to the following address:

docu.motioncontrol@siemens.com

My Documentation Manager (MDM)
Under the following link you will find information to individually compile OEM-specific machine 
documentation based on the Siemens content:

www.siemens.com/mdm

Training
You can find information about the range of training courses under the following links:

● www.siemens.com/sitrain
SITRAIN - training courses from Siemens for products, systems and solutions in automation
technology

● www.siemens.com/sinutrain
SinuTrain - training software for SINUMERIK
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FAQs
You can find Frequently Asked Questions in the Service&Support pages under Product 
Support. http://support.automation.siemens.com

SINUMERIK
You can find information on SINUMERIK under the following link:

www.siemens.com/sinumerik

Technical Support
Country-specific telephone numbers for technical support are provided on the Internet at the 
following address (https://support.industry.siemens.com/sc/ww/en/sc/2090) in the "Contact" 
area.

If you have any technical questions, use the online form in the "Support Request" area. 

Target group
This document is intended for first-time users wanting to familiarize themselves with the 
product. 

Benefits
Getting Started provides information to the newcomer and brings about a sense of 
achievement to the first-time user in a very short time. First-time users learn the basic functions 
of the product or system and how to perform the essential activities and operations themselves.

Standard scope
This documentation only describes the functionality of the standard scope. Additions or 
revisions made by the machine manufacturer are documented by the machine manufacturer. 

Other functions not described in this documentation might be executable in the control. This 
does not, however, represent an obligation to supply such functions with a new control or when 
servicing.

For the sake of simplicity, this documentation does not contain all detailed information about all 
types of the product and cannot cover every conceivable case of installation, operation, or 
maintenance.

Note regarding the General Data Protection Regulation
Siemens observes standard data protection principles, in particular the principle of privacy by 
design. That means that
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this product does not process / store any personal data, only technical functional data (e.g. time 
stamps). If a user links this data with other data (e.g. a shift schedule) or stores personal data 
on the same storage medium (e.g. hard drive) and thus establishes a link to a person or 
persons, then the user is responsible for ensuring compliance with the relevant data protection 
regulations.

Conventions
The following terms/abbreviations are used synonymously in this document:

● "SINUMERIK 840D sl STEP 7 Toolbox <TIA Portal Version>" and "SINUMERIK Toolbox"

Preface

SINUMERIK 840D sl STEP 7 Toolbox V16
Configuration Manual, 12/2019, 6FC5397-0GP40-0BA1 5



Preface

SINUMERIK 840D sl STEP 7 Toolbox V16
6 Configuration Manual, 12/2019, 6FC5397-0GP40-0BA1



Table of contents

Preface .........................................................................................................................................................3

1 Fundamental safety instructions.................................................................................................................11

1.1 General safety instructions.....................................................................................................11

1.2 Equipment damage due to electric fields or electrostatic discharge ......................................15

1.3 Warranty and liability for application examples ......................................................................16

1.4 Industrial security ...................................................................................................................17

1.5 Residual risks of power drive systems ...................................................................................19

2 Product information ....................................................................................................................................21

2.1 Validity of the description .......................................................................................................21

2.2 Product features.....................................................................................................................22

2.3 Installation notes ....................................................................................................................23

2.4 Limitations for use ..................................................................................................................24

3 Configuring the NCU ..................................................................................................................................25

3.1 SINUMERIK NCU ..................................................................................................................25
3.1.1 Structure of SINUMERIK NCU...............................................................................................25
3.1.2 Insert NCU .............................................................................................................................26

3.2 Insert NX module ...................................................................................................................28

3.3 Replacing a device or upgrading firmware.............................................................................33
3.3.1 Replacing the NCU ................................................................................................................33
3.3.2 Replacing an NX ....................................................................................................................33
3.3.3 Basic procedure .....................................................................................................................34

3.4 Establish the communication connection ...............................................................................37

3.5 Load hardware configuration into the PLC.............................................................................39

3.6 Creating SINUMERIK PLC archives ......................................................................................44
3.6.1 Creating a SINUMERIK PLC archive .....................................................................................44
3.6.2 Available SINUMERIK archive types .....................................................................................47
3.6.3 External tools for SINUMERIK archives.................................................................................48
3.6.4 Creating a PLC hardware upgrade archive............................................................................48
3.6.5 Creating a PLC commissioning archive .................................................................................50
3.6.6 Creating a PLC reload archive ...............................................................................................52

4 Programming the PLC ................................................................................................................................55

4.1 General information about the PLC program .........................................................................55
4.1.1 Introduction ............................................................................................................................55
4.1.2 Execution structure ................................................................................................................55
4.1.3 Using copy templates.............................................................................................................58
4.1.4 Block listing as table...............................................................................................................61

SINUMERIK 840D sl STEP 7 Toolbox V16
Configuration Manual, 12/2019, 6FC5397-0GP40-0BA1 7



4.1.5 Blocks with user-specific adaptations ....................................................................................65
4.1.6 Assignment overview .............................................................................................................66
4.1.7 Generating blocks at runtime on the NCU .............................................................................67

4.2 Opening the PLC basic program system library.....................................................................69

4.3 Adding the PLC basic program ..............................................................................................70

4.4 Conflicts when copying blocks ...............................................................................................74

4.5 Correcting OB1 ......................................................................................................................76

4.6 Upgrading the PLC basic program.........................................................................................77

4.7 Copying blocks from one project into another........................................................................79

4.8 Use and handling of groups ...................................................................................................82

4.9 Create blocks from external sources......................................................................................84

4.10 Exporting PLC symbols for SINUMERIK Operate..................................................................85
4.10.1 Creating and loading PLC symbols........................................................................................85
4.10.2 Exporting PLC symbols..........................................................................................................86
4.10.3 Importing PLC symbols ..........................................................................................................89

4.11 Edit blocks..............................................................................................................................91

5 Configuring networks..................................................................................................................................93

5.1 Configuring an Ethernet Interface ..........................................................................................93

5.2 Configuring PROFIBUS DP ...................................................................................................94

5.3 Configuring Integrated PROFIBUS (DP Integrated)...............................................................95

5.4 Configuring PROFINET..........................................................................................................96

5.5 Configuring PROFINET IO with IRT.......................................................................................97
5.5.1 Overview ................................................................................................................................97
5.5.2 Rules and requirements .........................................................................................................97
5.5.3 Isochronous-capable modules identification ..........................................................................99
5.5.4 Configuring isochronous NC-controlled drives.....................................................................101
5.5.5 Configuring I/O used by NC isochronously ..........................................................................102
5.5.6 Configuring the NCU ............................................................................................................103
5.5.7 Configuring PROFINET IO IRT devices...............................................................................104
5.5.8 Configuring IO modules or drive telegrams..........................................................................106
5.5.9 Configuring the input delay for digital input modules ...........................................................109
5.5.10 Configuring sync domains....................................................................................................110
5.5.11 Match values between PROFINET IO and PROFIBUS Integrated......................................111
5.5.12 Assigning drive addresses to the NCU machine data..........................................................112
5.5.13 Assigning I/O addresses to the NCU machine data.............................................................113

6 Configuring telegrams and drive units ......................................................................................................115

6.1 Overview ..............................................................................................................................115

6.2 Standard telegram configuration ..........................................................................................116

6.3 Viewing I/O addresses in the TIA Portal ..............................................................................117

6.4 Changing the addressing schematic ....................................................................................118

6.5 Resetting telegrams .............................................................................................................120

Table of contents

SINUMERIK 840D sl STEP 7 Toolbox V16
8 Configuration Manual, 12/2019, 6FC5397-0GP40-0BA1



6.6 Displaying or adapting the telegram configuration ...............................................................121
6.6.1 Overview ..............................................................................................................................121
6.6.2 Calling the telegram configuration........................................................................................122
6.6.3 Structure of the "Telegram configuration" dialog..................................................................122
6.6.4 Changing the properties of send telegrams (actual value)...................................................123
6.6.5 Changing the properties of receive telegrams (setpoint) .....................................................126
6.6.6 Adapting the number of drives .............................................................................................129

6.7 Available telegram types ......................................................................................................130
6.7.1 Telegrams for the transfer of standard data (PROFIdrive)...................................................130
6.7.2 Telegrams in SINUMERIK Safety Integrated (SPL) mode...................................................131
6.7.3 Telegrams for PROFIsafe communication ...........................................................................131
6.7.4 Telegrams for SIC/SCC communication ..............................................................................132

6.8 Adapting I/O start addresses................................................................................................134
6.8.1 Introduction ..........................................................................................................................134
6.8.2 PROFIdrive telegrams for standard data .............................................................................135
6.8.3 PROFIdrive telegrams for Safety Integrated (SPL)..............................................................137
6.8.4 PROFIsafe/PROFIdrive telegrams for Safety Integrated plus (F-PLC)................................139

6.9 Deviations from the standard I/O addressing schematic......................................................143
6.9.1 Overview ..............................................................................................................................143
6.9.2 Matching of deviating I/O addresses....................................................................................143
6.9.2.1 Matching I/O addresses for use of the optimized I/O addressing schematic .......................143
6.9.2.2 Matching user-specific adaptations......................................................................................144
6.9.3 Viewing messages in the info area ......................................................................................145
6.9.4 Availability of suitable  I/O addresses ..................................................................................146

7 Configuring I/O .........................................................................................................................................149

7.1 Inserting ADI4 module (840 sl).............................................................................................149

7.2 Installing general station description files for SINUMERIK I/O.............................................152

7.3 Inserting the SINUMERIK I/O module PP72/48 ...................................................................154

7.4 Inserting SINUMERIK MCP/MPP.........................................................................................157

8 Tag selection with NC VAR selector.........................................................................................................159

8.1 NC VAR selector ..................................................................................................................159

8.2 Selecting tags and saving as STL file ..................................................................................160

8.3 Adding a tag file (STL) in the TIA Portal...............................................................................162

9 Importing user alarms...............................................................................................................................165

9.1 Overview ..............................................................................................................................165

9.2 Exporting TS files from SINUMERIK Operate......................................................................166

9.3 Language assignment in language-dependent texts ...........................................................167

9.4 Enable project languages.....................................................................................................169

9.5 Importing SINUMERIK PLC alarm texts...............................................................................170

10 Safety configuration..................................................................................................................................173

10.1 Introduction ..........................................................................................................................173

Table of contents

SINUMERIK 840D sl STEP 7 Toolbox V16
Configuration Manual, 12/2019, 6FC5397-0GP40-0BA1 9



10.2 Representation of safety-related resources in the TIA Portal ..............................................174

10.3 Changing the Safety Integrated mode .................................................................................177

10.4 Parameterization of relevant properties ...............................................................................179

10.5 Availability of I/O addresses at the mode change ................................................................183

10.6 Licensing ..............................................................................................................................186
10.6.1 Overview ..............................................................................................................................186
10.6.2 Software options for Safety Integrated (SPL).......................................................................186
10.6.3 Software options for Safety Integrated plus (F-PLC) ...........................................................187

10.7 Configuring Safety Integrated (SPL) ....................................................................................189
10.7.1 Introduction ..........................................................................................................................189
10.7.2 Configuring the F-peripherals...............................................................................................189
10.7.3 Parameterizing F-input modules ..........................................................................................191
10.7.4 Configuring drives with F-functions ......................................................................................192
10.7.5 Parameterizing F-output modules ........................................................................................194
10.7.6 Configuration of the PROFIsafe addresses (peripherals) ....................................................194
10.7.7 Configuration of the PROFIsafe addresses (drives) ............................................................198
10.7.8 Parameterizing PROFIsafe telegrams .................................................................................200

10.8 Configuring Safety Integrated plus (F-PLC) .........................................................................202
10.8.1 Introduction ..........................................................................................................................202
10.8.2 Configuring Safety Integrated plus (F-PLC) .........................................................................203
10.8.3 Creating a second F-runtime group for Safety Integrated plus (F-PLC) ..............................205
10.8.4 Configuring PROFIsafe ........................................................................................................207
10.8.5 Checking the PROFIsafe address........................................................................................209

Index.........................................................................................................................................................213

Table of contents

SINUMERIK 840D sl STEP 7 Toolbox V16
10 Configuration Manual, 12/2019, 6FC5397-0GP40-0BA1



Fundamental safety instructions 1
1.1 General safety instructions

WARNING

Electric shock and danger to life due to other energy sources

Touching live components can result in death or severe injury.
● Only work on electrical devices when you are qualified for this job. 
● Always observe the country-specific safety rules.

Generally, the following six steps apply when establishing safety: 
1. Prepare for disconnection. Notify all those who will be affected by the procedure.
2. Isolate the drive system from the power supply and take measures to prevent it being 

switched back on again.
3. Wait until the discharge time specified on the warning labels has elapsed. 
4. Check that there is no voltage between any of the power connections, and between any of 

the power connections and the protective conductor connection.
5. Check whether the existing auxiliary supply circuits are de-energized.
6. Ensure that the motors cannot move.
7. Identify all other dangerous energy sources, e.g. compressed air, hydraulic systems, or 

water. Switch the energy sources to a safe state.
8. Check that the correct drive system is completely locked.

After you have completed the work, restore the operational readiness in the inverse sequence. 

WARNING

Electric shock due to connection to an unsuitable power supply

When equipment is connected to an unsuitable power supply, exposed components may 
carry a hazardous voltage. Contact with hazardous voltage can result in severe injury or death.
● Only use power supplies that provide SELV (Safety Extra Low Voltage) or PELV- 

(Protective Extra Low Voltage) output voltages for all connections and terminals of the 
electronics modules.
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WARNING

Electric shock due to equipment damage

Improper handling may cause damage to equipment. For damaged devices, hazardous 
voltages can be present at the enclosure or at exposed components; if touched, this can result 
in death or severe injury. 
● Ensure compliance with the limit values specified in the technical data during transport, 

storage and operation. 
● Do not use any damaged devices.

WARNING

Electric shock due to unconnected cable shields 

Hazardous touch voltages can occur through capacitive cross-coupling due to unconnected 
cable shields.
● As a minimum, connect cable shields and the cores of cables that are not used at one end 

at the grounded housing potential.

WARNING

Electric shock if there is no ground connection 

For missing or incorrectly implemented protective conductor connection for devices with 
protection class I, high voltages can be present at open, exposed parts, which when touched, 
can result in death or severe injury.
● Ground the device in compliance with the applicable regulations.  

WARNING

Spread of fire from built-in devices

In the event of fire outbreak, the enclosures of built-in devices cannot prevent the escape of 
fire and smoke. This can result in serious personal injury or property damage. 
● Install built-in units in a suitable metal cabinet in such a way that personnel are protected 

against fire and smoke, or take other appropriate measures to protect personnel.
● Ensure that smoke can only escape via controlled and monitored paths.

Fundamental safety instructions
1.1 General safety instructions
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WARNING

Unexpected movement of machines caused by radio devices or mobile phones

When radio devices or mobile phones with a transmission power > 1 W are used in the 
immediate vicinity of components, they may cause the equipment to malfunction. 
Malfunctions may impair the functional safety of machines and can therefore put people in 
danger or lead to property damage.
● If you come closer than around 2 m to such components, switch off any radios or mobile 

phones.
● Use the "SIEMENS Industry Online Support app" only on equipment that has already been 

switched off.

WARNING

Fire due to inadequate ventilation clearances

Inadequate ventilation clearances can cause overheating of components with subsequent fire 
and smoke. This can cause severe injury or even death. This can also result in increased 
downtime and reduced service lives for devices/systems. 
● Ensure compliance with the specified minimum clearance as ventilation clearance for the 

respective component. 

NOTICE

Overheating due to inadmissible mounting position

The device may overheat and therefore be damaged if mounted in an inadmissible position.
● Only operate the device in admissible mounting positions.

WARNING

Unexpected movement of machines caused by inactive safety functions

Inactive or non-adapted safety functions can trigger unexpected machine movements that 
may result in serious injury or death. 
● Observe the information in the appropriate product documentation before commissioning.
● Carry out a safety inspection for functions relevant to safety on the entire system, including 

all safety-related components.
● Ensure that the safety functions used in your drives and automation tasks are adjusted and 

activated through appropriate parameterizing. 
● Perform a function test.
● Only put your plant into live operation once you have guaranteed that the functions relevant 

to safety are running correctly.

Fundamental safety instructions
1.1 General safety instructions
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Note
Important safety notices for Safety Integrated functions

If you want to use Safety Integrated functions, you must observe the safety notices in the Safety 
Integrated manuals.

WARNING

Malfunctions of the machine as a result of incorrect or changed parameter settings

As a result of incorrect or changed parameterization, machines can malfunction, which in turn 
can lead to injuries or death.
● Protect the parameterization against unauthorized access.
● Handle possible malfunctions by taking suitable measures, e.g. emergency stop or

emergency off.

Fundamental safety instructions
1.1 General safety instructions
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1.2 Equipment damage due to electric fields or electrostatic discharge
Electrostatic sensitive devices (ESD) are individual components, integrated circuits, modules 
or devices that may be damaged by either electric fields or electrostatic discharge.

NOTICE

Equipment damage due to electric fields or electrostatic discharge

Electric fields or electrostatic discharge can cause malfunctions through damaged individual 
components, integrated circuits, modules or devices.
● Only pack, store, transport and send electronic components, modules or devices in their 

original packaging or in other suitable materials, e.g conductive foam rubber of aluminum 
foil.

● Only touch components, modules and devices when you are grounded by one of the 
following methods:
– Wearing an ESD wrist strap
– Wearing ESD shoes or ESD grounding straps in ESD areas with conductive flooring

● Only place electronic components, modules or devices on conductive surfaces (table with 
ESD surface, conductive ESD foam, ESD packaging, ESD transport container).

Fundamental safety instructions
1.2 Equipment damage due to electric fields or electrostatic discharge
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1.3 Warranty and liability for application examples
Application examples are not binding and do not claim to be complete regarding configuration, 
equipment or any eventuality which may arise. Application examples do not represent specific 
customer solutions, but are only intended to provide support for typical tasks.

As the user you yourself are responsible for ensuring that the products described are operated 
correctly. Application examples do not relieve you of your responsibility for safe handling when 
using, installing, operating and maintaining the equipment.

Fundamental safety instructions
1.3 Warranty and liability for application examples
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1.4 Industrial security

Note
Industrial security

Siemens provides products and solutions with industrial security functions that support the 
secure operation of plants, systems, machines and networks.

In order to protect plants, systems, machines and networks against cyber threats, it is 
necessary to implement – and continuously maintain – a holistic, state-of-the-art industrial 
security concept. Products and solutions from Siemens constitute one element of such a 
concept.

Customers are responsible for preventing unauthorized access to their plants, systems, 
machines and networks. Such systems, machines and components should only be connected 
to an enterprise network or the Internet if and to the extent such a connection is necessary and 
only when appropriate security measures (e.g. using firewalls and/or network segmentation) 
are in place.

For additional information on industrial security measures that can be implemented, please 
visit:

Industrial security (https://www.siemens.com/industrialsecurity)

Siemens’ products and solutions undergo continuous development to make them more secure. 
Siemens strongly recommends that product updates are applied as soon as they become 
available, and that only the latest product versions are used. Use of product versions that are 
no longer supported, and failure to apply the latest updates may increase customer’s exposure 
to cyber threats. 

To stay informed about product updates, subscribe to the Siemens Industrial Security RSS 
Feed at:

Industrial security (https://www.siemens.com/industrialsecurity)

Further information is provided on the Internet:

Industrial Security Configuration Manual (https://support.industry.siemens.com/cs/ww/en/
view/108862708)

Fundamental safety instructions
1.4 Industrial security
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WARNING

Unsafe operating states resulting from software manipulation

Software manipulations, e.g. viruses, Trojans, or worms, can cause unsafe operating states 
in your system that may lead to death, serious injury, and property damage.
● Keep the software up to date.
● Incorporate the automation and drive components into a holistic, state-of-the-art industrial

security concept for the installation or machine.
● Make sure that you include all installed products into the holistic industrial security concept.
● Protect files stored on exchangeable storage media from malicious software by with

suitable protection measures, e.g. virus scanners.
● On completion of commissioning, check all security-related settings.
● Protect the drive against unauthorized changes by activating the "Know-how protection"

converter function.

Fundamental safety instructions
1.4 Industrial security
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1.5 Residual risks of power drive systems
When assessing the machine- or system-related risk in accordance with the respective local 
regulations (e.g., EC Machinery Directive), the machine manufacturer or system installer must 
take into account the following residual risks emanating from the control and drive components 
of a drive system:

1. Unintentional movements of driven machine or system components during commissioning, 
operation, maintenance, and repairs caused by, for example,

– Hardware and/or software errors in the sensors, control system, actuators, and cables 
and connections

– Response times of the control system and of the drive

– Operation and/or environmental conditions outside the specification

– Condensation/conductive contamination

– Parameterization, programming, cabling, and installation errors

– Use of wireless devices/mobile phones in the immediate vicinity of electronic 
components

– External influences/damage

– X-ray, ionizing radiation and cosmic radiation

2. Unusually high temperatures, including open flames, as well as emissions of light, noise, 
particles, gases, etc., can occur inside and outside the components under fault conditions 
caused by, for example:

– Component failure

– Software errors

– Operation and/or environmental conditions outside the specification

– External influences/damage

3. Hazardous shock voltages caused by, for example:

– Component failure

– Influence during electrostatic charging

– Induction of voltages in moving motors

– Operation and/or environmental conditions outside the specification

– Condensation/conductive contamination

– External influences/damage

4. Electrical, magnetic and electromagnetic fields generated in operation that can pose a risk 
to people with a pacemaker, implants or metal replacement joints, etc., if they are too close

5. Release of environmental pollutants or emissions as a result of improper operation of the 
system and/or failure to dispose of components safely and correctly

6. Influence of network-connected communication systems, e.g. ripple-control transmitters or 
data communication via the network

For more information about the residual risks of the drive system components, see the relevant 
sections in the technical user documentation.

Fundamental safety instructions
1.5 Residual risks of power drive systems
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Product information 2
2.1 Validity of the description

These notes take precedence over statements in other documents. 

Please read the notes carefully since important information for installation and use of the 
software is included for you.

Notes that were no longer able to be taken into account in the online help can be found under 
Limitations for use (Page 24).
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2.2 Product features
SINUMERIK 840D sl STEP 7 Toolbox V16 is an option package for SIMATIC STEP 7 
Professional V16 (TIA Portal) with additional setup.

Functional scope
SINUMERIK 840D sl STEP 7 Toolbox V16 contains the following tools and functions:

● Supplementation of the hardware catalog with the following modules of the SINUMERIK
840D sl (as of firmware V4.5 SP2 or higher):

– NCU 710.3

– NCU 720.3

– NCU 730.3

– NX10.3

– NX15.3

● Supplement of the hardware catalog to include the ADI4 module

● SINUMERIK PLC basic program
The SINUMERIK 840D sl STEP 7 Toolbox automatically installs the PLC basic program as
the "SINUMERIK 840D sl PLC Basic Program" system library. Matching the firmware
versions of the modules, there are different versions of the PLC basic program:

– SINUMERIK 840D sl PLC basic program V4.5.x.x

– SINUMERIK 840D sl PLC basic program V4.7.x.x

– SINUMERIK 840D sl PLC basic program V4.8.x.x

– SINUMERIK 840D sl PLC Basic Program V4.9.1.x

– SINUMERIK 840D sl PLC Basic Program V4.9.2.x

– SINUMERIK 840D sl PLC Basic Program V4.9.3.x

● Export of PLC symbols for SINUMERIK Operate

● Importing SINUMERIK user alarm texts

● Creating SINUMERIK PLC archives

● Support of PROFINET IO IRT for NCK

● Support of SINUMERIK Safety Integrated and Safety Integrated plus

● NC VAR selector (external tool)

Product information
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2.3 Installation notes

Software requirements
SINUMERIK 840D sl STEP 7 Toolbox V16 is a TIA Portal options package which requires 
installation of the following products:

● SIMATIC STEP 7 Professional V16

Hardware requirements and other system requirements
All of the hardware and system requirements of SIMATIC STEP 7 Professional apply.

You can find the system requirements of STEP 7 Professional in the following documentation:

● STEP 7 Professional System Manual (https://support.industry.siemens.com/cs/products?
search=STEP%207%20Professional&dtp=Manual)

● TIA Portal online help, search term "System requirements STEP 7 Professional"

Installation
Before installing, exit all of the applications (e.g. TIA Portal) and execute the "Start.exe" setup 
file in the master directory of the product DVD.

Uninstallation
Via the installation wizard of the TIA Portal, you can uninstall the software, which is entered in 
the Windows dialog "Uninstall or change program":

"Control Panel > Programs > Uninstall Program > Siemens Totally Integrated Automation 
Portal"

Note

The NC VAR selector must be uninstalled separately.
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2.4 Limitations for use
According to the state of the art, it can admittedly not be excluded - given the complexity of the 
software products - that sporadic functional restrictions can occur under the greatly differing 
system and application conditions.

In this context, please observe the current boundary conditions, functional restrictions and 
workarounds on the Internet:

Boundary conditions in Siemens Industry Online Support (https://
support.industry.siemens.com/cs/document/109751810)
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Configuring the NCU 3
3.1 SINUMERIK NCU

3.1.1 Structure of SINUMERIK NCU

Subcomponents of the NCU
A SINUMERIK NCU comprises the following integrated subcomponents:

● PLC

● NCK

● CP

● HMI (SINUMERIK Operate)

● SINAMICS Integrated (DRIVE)

These subcomponents are always a fixed component of an NCU and can only be handled in 
combination with the NCU. Subcomponents cannot be individually pasted, copied or moved in 
the project or across projects (e.g. in libraries).

Note
Copying and pasting the NCU or the DP master system

You can copy and insert NCUs within a project. For this purpose, switch to the network view or 
to the topology view of the project view.

The DP master system (PROFIBUS Integrated) cannot be individually copied, pasted or 
deleted. It is considered as an integral part of the NCU.

If you copy an NCU, all integrated subcomponents are also copied, e.g. SINAMICS Integrated 
or PROFIBUS Integrated.

Additional connectable components
Optionally, the following components can be connected to the NCU:

● NX10.3 and NX15.3 modules

These components are not inserted automatically when inserting an NCU, but must be 
integrated manually (Page 28).
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3.1.2 Insert NCU

Requirement
● A project is open in the TIA Portal.

Procedure
To insert a SINUMERIK NCU in the project view, proceed as follows:

1. Click "Add new device" in the project tree.

2. Click the "Controllers" button.

3. In the folder structure under "Controllers", expand the corresponding SINUMERIK device
family (e.g. SINUMERIK 840D sl) and required NCU and select these.

Figure 3-1 Selected NCU using the SINUMERIK 840D sl NCU 730.3 PN V4.8 as an example

Configuring the NCU
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4. Select the firmware version that matches the envisaged firmware version of the real NCU in
the "Version" drop-down list.

5. Confirm your selection with "OK".

Result
The SINUMERIK NCU is created as new device. 

See also
Replacing a device or upgrading firmware (Page 33)
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3.2 Insert NX module

Procedure
In order to insert an NX module into the project via the hardware catalog, proceed as follows:

1. In the network view, navigate in the hardware catalog to the folder "Controller > SINUMERIK 
840D sl > NX" and select, for example, NX15.3 .

2. You can select the firmware version of the NX module at "Information" in the hardware 
catalog. This must match the firmware version of the NCU. Firmware versions of the 
configured hardware and the real hardware must match.
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3. Use drag-and-drop to move the NX module from the hardware catalog to the network view.
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4. To connect the NX module with a master system, click "Not assigned" and select the master
system.

Note
Connection to DP Integrated

Note that the NX modules can only be connected to the DP Integrated of a SINUMERIK 
NCU, and not to external PROFIBUS interfaces!

The NX is connected with the NCU and the "Wiring between control and NX" dialog opens.

5. In the "Wiring between control and NX" dialog, select the DP address of the NX in the master
system that matches your real wiring. The DP addresses of the NX modules are
permanently assigned to the DRIVE-CLiQ sockets of the NCU.

DP address of the NX in the master system DRIVE-CLiQ socket on the NCU
10 X100
11 X101
12 X102
13 X103
14 X104
15 X105

Configuring the NCU
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Note
This setting cannot be undone

Please note that once set, the DP address of an NX cannot be subsequently changed. The 
NX modules must be connected to the DRIVE-CLiQ socket of the NCU in the real wiring that 
corresponds to the permanently assigned DP address.

If you have incorrectly set the DP address of an NX, delete this NX from the project and add 
a new one.

The DP address of the NX module is specified in accordance with your setting and the 
appropriate I/O addresses of the telegrams are set automatically.

Note
Default I/O addresses of the telegrams

Depending on the set DP address, the appropriate I/O addresses of the telegrams are set 
automatically.

Change this setting only when the I/O addresses of your telegrams differ from the default 
setting!

You can also find information on the wiring between NCU and NX in the properties of the DP 
Integrated interface on the NCU and NX under "PROFIBUS address".
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Result
The NX module has been inserted into the project and connected to an NCU.

Note
Handling the NX
● If NX modules were connected with the NCU and the NCU is subsequently deleted, the NX

modules are kept in the project as unconnected slave modules. They can be subsequently
assigned to another NCU. The parameter settings of the NX modules are retained.

● If the DP address of the NX is specified, then the I/O addresses matching the default setting
on the NCK side are entered.
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3.3 Replacing a device or upgrading firmware

3.3.1 Replacing the NCU
You can replace different NCUs. By replacing a device within the same device family, you can 
change to another NCU with a different expansion stage, with a different firmware version and 
other properties.

Rules for replacing an NCU
● It is not possible to replace an NCU with another controller of a different device family. 

(You may be able to perform a migration.)

● It is not possible to replace an NCU with an NCU of the same project stage with the same 
or previous firmware version.

● If you replace an NCU by another NCU, then automatically all of the integrated 
subcomponents of the NCU (SINAMICS Integrated, PLC, NCK, CP, HMI) are also replaced.

● If you have connected NX modules to an NCU and replace the NCU, the connection 
between the devices remains, provided the used interfaces exist on both NCUs. If the used 
interface on the replaced NCU does not exist, the connection will be separated.

3.3.2 Replacing an NX
You can replace a device with a different NX type. The version of an NX is determined by the 
version of the NCU. Correspondingly, for a connected NX, you can only replace the type: An 
NX10.3 can be replaced by an NX15.3 and vice versa.

Rules for replacing an NX
If you replace NX10.3 with NX15.3, please note that NX10.3 only supports a maximum of three 
servo axes, whereas NX15.3 supports up to six servo axes.

For more information about the configuration of the drive objects, see Adapting the number of 
drives (Page 129)
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3.3.3 Basic procedure

Note
Changing the firmware version of the configured NCU or NX

The firmware version of the configured hardware and the real hardware must match. Otherwise 
it is possible that you configure version-dependent non-detectable properties in the TIA Portal 
that the real hardware does not support.

To replace the firmware version for a group (NCU with NX), the replacement on the NCU must 
be initiated. Interconnected NXs are then also replaced automatically.

Procedure
To replace a device, proceed as follows:

1. Switch to the device view.

2. Select the device that you want to replace in the "<Select device>" drop-down list.

Configuring the NCU
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3. Right-click the device and then select "Replace device" in the shortcut menu.
The "Replace device" dialog opens.

4. Select the new device in the folder structure.
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5. Select the required firmware version in the "Version" drop-down list.

Note
Solving compatibility problems

If the two devices are not compatible or only have restricted compatibility, you can find 
further information in Section "Compatibility information".
If required, click "Cancel" and correct the problems before continuing.

6. Confirm the dialog with "OK".

Result
The device has been replaced.

If you uploaded the firmware version, your telegram configuration was retained. Note that the 
default telegram I/O addresses of telegram 701 have changed as of V4.7 SP2.

See also: Telegram configuration and I/O addressing schematics, Resetting telegrams

Further information
Further information on device replacement can be found in the information system of the TIA 
Portal, keyword "Replacing".
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3.4 Establish the communication connection

Procedure     
To establish a communication connection between two devices, proceed as follows:

1. In the "Online" menu, select the "Accessible devices" command.

2. In the drop-down lists "Type of PG/PC interface" and "PG/PC interface", search for the 
interface used.
If no devices are accessible at an interface, the connecting line between the PG/PC and the 
device is interrupted. If devices are accessible, the connecting line is shown and the devices 
accessible at the selected interface of the PG/PC are displayed in a list.
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3. If you have connected a new device in the meantime, click the "Refresh" button to refresh
the list of accessible devices.

4. Using "Display", transfer to the project navigator the device that has been found in the
"Online accesses" folder.
The subfolder of the interface to which the selected device is connected is selected in the
project tree.

Note
Several identical devices

If several identical devices can be accessed from the PG, by clicking on the "Flash LED" 
button you can then display which device corresponds to the entry in the list of accessible 
devices.
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3.5 Load hardware configuration into the PLC

Requirement
● The hardware configuration is compiled.

● A communication connection exists between the PG/PC (TIA Portal) and the NCU.

Note
Loading configurations to simulated environments

If you want to use the configuration in a simulated environment, you must activate the 
simulation capability in the project properties before you load the configuration into the 
simulated environment or compile the hardware/software.

Note
General reset before loading into a PLC with Safety Integrated plus (F-PLC)

If the actual hardware has been operated in Safety Integrated plus (F-PLC) mode and you now 
want to load a configured hardware configuration with changed Safety Integrated mode, you 
must perform a general reset of the PLC prior to the loading.
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Procedure
Proceed as follows to load the configured hardware configuration into the NCU:

1. In the project navigation, right-click the device name, e.g. "CNC_1", and select the 
"Hardware configuration" command in the "Download to device" shortcut menu.

Note
Scope of the data to be downloaded

Alternatively, you can select one of the other commands to start downloading additional 
data to the NCU in this step.

See TIA Portal help, keyword "General information on download".

The "Extended download" dialog opens.
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Figure 3-2 Dialog using the PLC of a SINUMERIK 840D sl as an example

2. Make the following settings in the "Extended download" dialog:

– PG/PC interface: Network card used, e.g. "Intel[R] Ethernet Connection I217-V"

– Connection with interface/subnet: Specific interface on the NCU or "Try all interfaces"

3. Click on "Start search" and then select the found PLC from "Compatible nodes in the target
subnet". Alternatively, you can specify an IP address directly in the "Compatible nodes in the
target subnet" list in the "Address" column.
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4. Confirm the download with "Load".
The "Download preview" dialog opens.

Figure 3-3 "Download preview" dialog

Note
Consistency check

Before the loading, the consistency of the download is checked. This means that a check is 
made as to whether the parameterized hardware of the TIA Portal project matches the 
hardware that has been actually installed.

Note
Adapt the IP address?

If the IP address of your PG/PC is located in a different subnet than the PLC, a dialog box 
is displayed as to whether the IP address in the PG/PC should be adapted.

5. In the "Download preview" dialog, check the settings and click "Load" to confirm the input.
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Result
The PLC is stopped and the hardware configuring is loaded into the PLC. The "Results of the 
loading action" dialog opens and displays the status of the loading action. The dialog restarts 
the PLC after completion, provided the "Start" checkbox has not been deactivated.
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3.6 Creating SINUMERIK PLC archives

3.6.1 Creating a SINUMERIK PLC archive

Introduction
Unlike TIA Portal project archives (*.zap*), SINUMERIK PLC archives (*.arc) contain 
precompiled commissioning data that you can import directly to the NCU (e.g. with SINUMERIK 
Operate).

A SINUMERIK archive offers the following possibilities:

● Direct image of the data of a PLC taken into operation in a file

● Simplification of the series commissioning

● Commissioning of the PLC with the SINUMERIK archive directly on the NCU without using
a PG/PC, TIA Portal or STEP 7

● Transfer of the data to the NCU without establishing an online connection to the actual
hardware

SINUMERIK archives (*.arc) have nothing in common with TIA Portal project archives (*.zap*). 
TIA Portal project archives are compressed files, each of which contains a complete project, 
including the complete folder structure of the project. (See: Online help, keyword "TIA Portal 
project archive").

You can create a PLC archive with the SINUMERIK Toolbox and load it to the NCU (e.g. with 
SINUMERIK Operate) in order to simplify the actual commissioning.

You can create the following SINUMERIK archives:

Archive type Command in the TIA 
Portal

Data included

PLC hardware upgrade ar‐
chive (Page 48)

Only hardware... ● Hardware data (SDB) of the PLC

PLC commissioning ar‐
chive (Page 50)

Hardware and all pro‐
gram blocks...

● Hardware data (SDB) of the PLC
● Program blocks of the PLC
● Hardware data (SDB) of the CP

PLC reload archive 
(Page 52)

Selected program 
blocks...

● Program blocks of the PLC

Note
Editing SINUMERIK archives (.arc)

After you have created a SINUMERIK archive, you can open and edit it with various tools.
See: External tools for SINUMERIK archives (Page 48)

Configuring the NCU
3.6 Creating SINUMERIK PLC archives

SINUMERIK 840D sl STEP 7 Toolbox V16
44 Configuration Manual, 12/2019, 6FC5397-0GP40-0BA1



Note
Handling of F-blocks for SINUMERIK archives

Because F-blocks must always be saved together with the associated hardware configuration, 
F-blocks cannot be saved in reload archives.

Further information
● General information on NCU series commissioning archives can be found in Section

"Saving and managing data" of the "SINUMERIK 840D sl, SINAMICS S120 Commissioning
CNC:NCK, PLC, Drive for TIA" Commissioning Manual.

● Information about the differences of the archives that were created with STEP 7 V5.x is
available at "Handling SINUMERIK archives".
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Overview
You can create SINUMERIK archives in various ways:

● In the menu bar at "Tools"

● In the shortcut menu of the NCU or PLC:

Figure 3-4 Creating a SINUMERIK archive
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3.6.2 Available SINUMERIK archive types

There are different types of archives which you can create in different ways. Essentially, you 
cannot use the TIA Portal to create archives that contain NC, drive or HMI data. However, you 
can save a finely granular selection of translated program blocks as an archive in the TIA Portal 
with the "PLC reload archive".

Archive type Command in the TIA 
Portal

Command in SINU‐
MERIK Operate

Data contained

NCU commissioning ar‐
chive

- Softkey "Commission‐
ing archive", option but‐
ton "Create commis‐
sioning archive"

The contained data can be configured as fol‐
lows in the dialog:
● NC data

– With or without compensation data
– With or without compile cycles

● PLC data (all or none)
● Drive data (ACX format or ASCII format)
● HMI data (all HMI data or a configurable

selection)
PLC commissioning ar‐
chive (Page 50)

Hardware and all pro‐
gram blocks...

Softkey "Commission‐
ing archive", option but‐
ton "Create commis‐
sioning archive"; only 
enable "PLC data" in 
the dialog

● Hardware data (SDB) of the PLC
● Program blocks of the PLC
● Hardware data (SDB) of the CP

PLC hardware upgrade 
archive (Page 48)

Only hardware... Softkey "Commission‐
ing archive", option but‐
ton "Create PLC hard‐
ware upgrade archive 
(only SDBs)"

● Hardware data (SDB) of the PLC
● Hardware data (SDB) of the CP

PLC reload archive 
(Page 52)

Selected program 
blocks...

- ● Program blocks of the PLC
(configurable in the dialog)

Complete archive - <Ctrl> + <Alt> + S All data (not configurable)

Original status archive - Softkey "Commission‐
ing archive", option but‐
ton "Create archive 
original status"

Original status (factory setting) of all subcom‐
ponents or a selection of specific subcompo‐
nents and data (configurable in the dialog)
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Note
Distinguishing between TIA Portal project archives and SINUMERIK archives

SINUMERIK archives (*.zap14) have nothing in common with TIA Portal project archives 
(*.arc):
● SINUMERIK archives contain precompiled commissioning data that you can import directly

to the NCU.
● TIA Portal project archives are compressed files, each of which contains a complete project,

including the complete folder structure of the project.

See: TIA Portal online help, search term "TIA Portal project archive".

3.6.3 External tools for SINUMERIK archives

Overview
Various tools are available to open and edit the created SINUMERIK archives:

Tool Purpose Available from
SinuCom ARC Editing of SINUMERIK archives SinuCom commissioning/service tools 

in the SIEMENS Industry Mall (https://
eb.automation.siemens.com/
mall/en/us/Catalog/Product/
6FC5250-7AY00-7AG0)

Create MyConfig Extensive software, including functions 
such as:
● Data comparison of SINUMERIK

archives
● Manipulation of SINAMICS data in

drive archives
● Creation of a SINAMICS archive

with defined topology

Create MyConfig in the SIEMENS In‐
dustry Mall (https://
eb.automation.siemens.com/
mall/en/us/Catalog/Products/
10167653)

3.6.4 Creating a PLC hardware upgrade archive

Requirement
● The data carrier to be used or storage location is available and has sufficient storage space.
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Procedure
To create a hardware upgrade archive, proceed as follows:

1. In the project tree, right-click the device name, e.g. "CNC_1", and select "Create
SINUMERIK archive > Hardware only" in the shortcut menu.
The "Create SINUMERIK archive" dialog opens.

Figure 3-5 "Create SINUMERIK archive" dialog with hardware

2. Make the required settings:

Element Purpose
File name Enter the desired file name of the SINUMERIK archive in the text field.

File extensions cannot be changed
The file extension (.arc) is not displayed and cannot be changed.

Path Click Browse and select a directory, or enter the directory directly.
Default storage location for data export
The used path is shown as the default setting the next time you export an archive.
To specify the default setting for the data export in the settings, switch to "General > 
General > Data exchange > Storage location for data export" in the settings.

Author Name of the author or a person responsible for the project.
The default setting corresponds to the setting of the user name in the TIA Portal 
under: "Extras > Settings > General > General settings > User name".

Comment Input of a comment for the SINUMERIK archive.
As default setting, the comment field contains an entry whether the archive contains 
only hardware or hardware and all program blocks.

3. Click "Create archive" to confirm your input.

Result
The SINUMERIK archive is created and stored in the path that you have specified.
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3.6.5 Creating a PLC commissioning archive

Requirement
● If possible, the "Program blocks" folder should not contain any program blocks of not

activated axes/spindles or the tool management.
You can also save unused program blocks in the archive, although this extends the time
required for creating and loading the archive.

● The data carrier to be used or storage location is available and has sufficient storage space.

Note
Handling of F-blocks for SINUMERIK archives

The handling of F-blocks depends on the used Safety Integrated mode:
● If Safety Integrated is inactive or Safety Integrated (SPL) is active, F-blocks are not stored

in the SINUMERIK archive.
● In Safety Integrated plus (F-PLC) mode, F-blocks are saved in PLC commissioning

archives.
Note the additional information in the Readme file for SINUMERIK Toolbox: "Start >
Siemens Automation > Documentation > Readmes > German".
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Procedure
To create a PLC commissioning archive, proceed as follows:

1. In the project tree, right-click the device name, e.g. "CNC_1", and select "Create
SINUMERIK archive > Hardware and all program blocks" in the shortcut menu.
The "Create SINUMERIK archive" dialog opens.

Figure 3-6 "Create SINUMERIK archive" dialog with hardware data and program blocks

2. Make the required settings:

Element Purpose
File name Enter the desired file name of the SINUMERIK archive in the text field.

File extensions cannot be changed
The file extension (.arc) is not displayed and cannot be changed.

Path Click Browse and select a directory, or enter the directory directly.
Default storage location for data export
The used path is shown as the default setting the next time you export an archive.
To specify the default setting for the data export in the settings, switch to "General > 
General > Data exchange > Storage location for data export" in the settings.

Author Name of the author or a person responsible for the project.
The default setting corresponds to the setting of the user name in the TIA Portal 
under: "Extras > Settings > General > General settings > User name".

Comment Input of a comment for the SINUMERIK archive.
As default setting, the comment field contains an entry whether the archive contains 
only hardware or hardware and all program blocks.

3. Click "Create archive" to confirm your input.

Result
The SINUMERIK archive is created and stored in the path that you have specified.
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3.6.6 Creating a PLC reload archive
You can save the program blocks of the PLC as reload archive in the TIA Portal.

Note
F-blocks are not saved in reload archives

The F-blocks used in the SINUMERIK Safety Integrated plus (F-PLC) mode are not saved in 
reload archives.

If you want to save F-blocks in a SINUMERIK archive, you can save them together with the 
associated hardware configuration in a PLC commissioning archive.

Note
In the PLC reload archive, existing data blocks overwrite any CPU DBs during reading in

If you import into a PLC reload archive a CPU DBs that already exists on the control system, the 
CPU DBs on the control system will always be overwritten. Therefore the option "Overwrite 
existing blocks with identical number on the PLC for import" does not affect CPU-DB.

Therefore, do not store data blocks that already exist on the NCU as CPU DB in the PLC reload 
archive.

If you have already overwritten CPU DBs, you can find further information in the information 
system, keyword "Inconsistency in data blocks".

Requirement
● If possible, the "Program blocks" folder should not contain any program blocks of not 

activated axes/spindles or the tool management.
Although you can save unused program blocks in the archive, this extends the time required 
for creating and loading the archive.

● The data carrier to be used or storage location is available and has sufficient storage space.
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Procedure
To create a reload archive, proceed as follows:

1. You have several ways of selecting the program blocks to be archived:

– Select the desired program blocks in the project tree or in the project tree overview. Then 
right-click one of the selected program blocks.
You can change the actual program blocks to be exported later in the "Create 
SINUMERIK archive" dialog.

– Right-click the program blocks folder of the PLC or a higher-level folder.
You can select the program blocks to be exported later in the "Create SINUMERIK 
archive" dialog.

2. Click "Selected program blocks" in the "Create SINUMERIK archive" in the shortcut menu.
The "Create SINUMERIK archive" dialog opens.

Figure 3-7 "Create SINUMERIK archive" dialog with expanded "Block selection" section
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3. Make the required settings:

Element Purpose
Block selection In the "Block selection" section, you can check your selection or select the 

program blocks to be saved.
If you have organized program blocks as groups, they are displayed as an 
expandable folder in the block selection.

File name Enter the desired file name of the SINUMERIK archive in the text field.
File extensions cannot be changed
The file extension (.arc) is not displayed and cannot be changed.

Path Click Browse and select a directory, or enter the directory directly.
Default storage location for data export
The used path is shown as the default setting the next time you export an 
archive.
To specify the default setting for the data export in the settings, switch to 
"General > General > Data exchange > Storage location for data export" in 
the settings.

Author Name of the author or a person responsible for the project.
The default setting corresponds to the setting of the user name in the TIA 
Portal under: "Extras > Settings > General > General settings > User name".

Comment Input of a comment for the SINUMERIK archive.
If the "Insert selected blocks as comment" checkbox is activated, all con‐
tained program blocks are entered automatically with symbolic name and 
block number.

Overwrite existing 
blocks with identical 
number on the PLC 
for import

If the checkbox is activated, existing program blocks with the same block 
number will be replaced on the NCU during the import of the archive.
If the checkbox is deactivated, any program blocks of the archive with the 
same block number will not be imported.

Restart the PLC af‐
ter import of the new 
program blocks

If the checkbox is activated, the PLC will be restarted automatically after 
importing the archive.
You can also deactivate the checkbox and, for example, make other instal‐
lation or commissioning work before you manually restart the PLC or the 
complete NCU.

4. Click "Create archive" to confirm your input.

Result
The SINUMERIK archive is created and stored in the path that you have specified.
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Programming the PLC 4
4.1 General information about the PLC program

4.1.1 Introduction
The PLC program is constructed modularly. It comprises the two parts:

● PLC basic program
The PLC basic program organizes the exchange of signals and data between the PLC user
program and the NCK, HMI, and machine control panel components.
Use the appropriate PLC basic program depending on the firmware version of an NCU.

– SINUMERIK 840D sl PLC basic program V4.5.x.x

– SINUMERIK 840D sl PLC basic program V4.7.x.x

– SINUMERIK 840D sl PLC basic program V4.8.x.x

– SINUMERIK 840D sl PLC Basic Program V4.9.2.x

● PLC user program
The PLC user program is the user-specific part of the PLC program by which the PLC basic
program has been augmented or extended.

4.1.2 Execution structure

Overview
The following organization blocks contain the entry points for the appropriate parts of the PLC 
basic program (and user program): 

● OB100 [OB100] (Cold restart)

● OB1 [OB1] (Cyclic execution)

● OB40 [OB40] (Process interrupt)

● Asynchronous errors

– OB82 [OB82] (Diagnostics alarm)

– OB86 [OB86] (Module failure)

The RUN_UP [FB1] function block is the startup block of the PLC basic program. The call of 
RUN_UP [FB1] in the OB100 [OB100] must be supplied with data.

The following figure illustrates the structure of the PLC program:
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Figure 4-1 Structure of the PLC program

Cyclic operation (OB1)
From a chronological viewpoint, the PLC basic program runs ahead of the PLC user program. 
The complete processing of the NCK-PLC interface is carried out in cyclic mode. A cyclic 
monitoring function is activated between PLC and NCK once boot-up and the first OB1 cycle 
have been completed. A PLC failure produces the "2000 Sign-of-life monitoring PLC" alarm in 
SINUMERIK Operate.

Programming the PLC
4.1 General information about the PLC program

SINUMERIK 840D sl STEP 7 Toolbox V16
56 Configuration Manual, 12/2019, 6FC5397-0GP40-0BA1



Start-up behavior of the PLC
The PLC always starts up in RESTART mode, i.e. the PLC operating system runs OB100 after 
initialization and starts cyclic operation at the beginning of OB1. No return is made to the 
interruption point (for example, in the event of a power failure).

There are both retentive and non-retentive areas for the markers, timers and counters. The 
areas are contiguous and are divided by a parameterizable limit, where the area with the higher-
value address range is defined as the non-retentive area. Data blocks are always retentive.

RESTART start type (OB100)
If the retentive area has no battery backup (backup battery is empty) start-up is prevented. The 
following operations are performed during a cold restart:

● UStack, BStack and non-retentive flags, timers and counters are deleted

● The process output image (POI) is deleted

● Process and diagnostics alarms are canceled

● The system status list is updated

● Parameterization objects of modules (from SDB100 onwards) are evaluated or default 
parameters are output to all modules in single-processor mode

● Cold restart (OB100) is executed

● The process input image (PII) is imported

● The command output inhibit (BASP) is canceled

Further information
The block descriptions and other information about the PLC basic program are contained in the 
P3 section of the SINUMERIK 840D sl Basic Functions Manual. Basic PLC program.
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4.1.3 Using copy templates

Introduction
The "Global libraries" folder of the "Libraries" TaskCard contains the system library of the 
SINUMERIK PLC program for your device version: "SINUMERIK 840D sl PLC basic program 
V4.x.x.x". 

Figure 4-2 Master copies of the SINUMERIK PLC program

Under the "Master copies" folder there are four subfolders with different contents. You can copy 
the contents of these subfolders in their entirety or you can copy the individual objects as 
needed.

● Using the Ctrl or shift key, you can select several objects of the same type and then copy
them.

● If you copy a master copies folder in its entirety (e.g. "840D sl PLC BP"), the folder structure
is imported, i.e. new groups (subfolders) are created (Page 82) in your "Program blocks"
folder.
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Table 4-1 Use and content of the master copies of the PLC basic program

Folder Purpose Contents
840D sl PLC Ba‐
sic Program

This master copy is intended 
to create a completely new 
project.

The master copy contains all the blocks that you require for the maximum 
configuration (31 axes, 10 channels).
Use of axis/channel DB
If your machine is using fewer axes or channels, you can either copy only 
the required blocks or you can delete the blocks that are not required in the 
project tree after copying.
If you have blocks in your project that are not required, this increases, 
for example, the time required for the loading or export of the PLC symbols.
Use of ALMSG_DB [DB2]
This master copy contains ALMSG_DB [DB2] in the variant Exten‐
dAlMsg=False.
The used DB2 variant must match in the startup for parameterization of the 
RUN_UP [FB1] in OB100 [OB100] (parameter ExtendAlMsg).

840D sl PLC Ba‐
sic Program 
(upgrade)

This master copy is used to 
upgrade blocks after the firm‐
ware version of an NCU is up‐
dated, i.e. if you have carried 
out a device replacement 
(Page 33) or a migration.

This master copy contains all the know-how-protected blocks that you re‐
quire for the maximum configuration (31 axes, 10 channels).
Blocks to be changed by the user are not included (no organization blocks 
and not FC12 [FC12], Diagnose [FB29], DB4 [DB4], DB5 [DB5]).
Use of axis/channel DB
If your machine is using fewer axes or channels, you can either copy only 
the required blocks or you can delete the blocks that are not required in the 
project tree after copying.
If you have blocks in your project that are not required, this increases, 
for example, the time required for the loading or export of the PLC symbols.
Use of ALMSG_DB [DB2]
This master copy contains ALMSG_DB [DB2] in the variant Exten‐
dAlMsg=False.
The used DB2 variant must match in the startup for parameterization of the 
RUN_UP [FB1] in OB100 [OB100] (parameter ExtendAlMsg).
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Folder Purpose Contents
ALMSG_DB_Ex
tendAlMsg

You need this master copy if 
you use the PLC alarm exten‐
sion via AL_MSG [FC10] (Ex‐
tendAlMsg=True).
Otherwise you use the DB2 
variant "Exten‐
dAlMsg=False", which is con‐
tained in the two above-
named master copies folders.

This master copy contains ALMSG_DB [DB2] in the variant Exten‐
dAlMsg=True (PLC alarm extension via AL_MSG [FC10]).
The used DB2 variant must match in the startup for parameterization of the 
RUN_UP [FB1] in OB100 [OB100] (parameter ExtendAlMsg).

External source 
files

Contains master copies for 
different external sources 
(STL). 
You can copy these sources 
into the folder "External sour‐
ces", e.g. under "CNC_1 > 
PLC_1 > External sources".
You edit objects in the "Exter‐
nal sources" folder using an 
external text editor, e.g. Mi‐
crosoft Editor.
See also: Create blocks from 
external sources (Page 84)

Contains the following master copies, from which you can generate the 
blocks named below:
● bhg_db_awl

– strdat [DB<xy>]
● diagnose.awl

– FB29 [FB29]
– DB80 [DB80]
– DB81 [DB81]
– FC99 [FC99]

● gpob840d.awl
– OB1 [OB1]
– OB100 [OB100]
– OB40 [OB40]
– OB82 [OB82]
– OB86 [OB86]

● mdeclist.awl
– DB75 [DB75]
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Note
Selecting the appropriate master copy for ALMSG_DB [DB2]

There are 2 different variants of the block ALMSG_DB [DB2]. The used DB2 variant 
(ALMSG_DB [DB2]) must match in the startup for parameterization of the RUN_UP [FB1] in 
OB100 [OB100] (parameter ExtendAlMsg).
● DB2 variant "ExtendAlMsg=False"

This variant is contained in the master copies folders "840D sl PLC Basic Program" and
"840D sl PLC Basic Program (upgrade)".
If you use the previous procedure (default value of the parameter ExtendAlMsg in RUN_UP
[FB1]), you do not need to explicitly copy the "ALMSG_DB_ExtendAlMsg" master copy.

● DB2 variant "ExtendAlMsg=True"
This variant is exclusively contained in the separate master copies folder
"ALMSG_DB_ExtendAlMsg".
If you use the extension of the PLC alarms via AL_MSG [FC10], you must use the right
master copy, i.e. copy it separately into your "Program blocks" folder.

Further information about the extension of the PLC alarms via AL_MSG [FC10] is available 
under the keyword "ExtendAlMsg" in the Basic Functions Manual, in particular, in the 
"Extensions of the PLC alarms via block FC 10" section.

Further information
● General information on handling libraries in the TIA Portal can be found in the TIA Portal

online help, Section "Using libraries".

● The block descriptions and other information about the PLC basic program is contained in
the SINUMERIK 840D sl Basic Functions Manual in the P3: Basic PLC program section.

4.1.4 Block listing as table
In the following, you will find a list of all of the blocks of the SINUMERIK PLC basic program that 
are included in the supplied master copy "840D sl PLC Basic Program".

The master copy "840D sl PLC Basic Program (upgrade)" contains the same blocks, except for 
blocks with user-specific adaptations.

Further information
● Information about other blocks of the basic program (e.g. blocks generated at runtime on the

NCU) or the operational principle of the basic program is contained in the SINUMERIK 840D
sl / 828D Basic Functions Manual.

● Information about the changed handling of specific blocks compared with STEP 7 V5.x is
available in the "Migrating SINUMERIK projects" help.
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Table 4-2 Organization blocks (OB)

Address Name Description Called PLC basic pro‐
gram block

OB1 OB1 Cycle OBs are higher-level logic blocks in the program which are cy‐
clically processed and in which you can program instructions or call 
additional blocks.

GP_HP [FC2]

OB40 OB40 Hardware interrupt OBs interrupt the cyclic program processing due to 
a hardware event.

GP_PRAL [FC3]

OB82 OB82 Diagnostic error interrupt OBs interrupt the cyclic execution of the pro‐
gram if the diagnostic-capable module for which the diagnostic inter‐
rupt was enabled detects an error.

GP_DIAG [FC5]

OB86 OB86 A rack or station failure OB is called, for example, in the event of failure 
of a rack or station in the distributed I/O.

GP_DIAG [FC5]

OB100 OB100 Startup OBs are processed once when the mode of the CPU switches 
from STOP to RUN. After execution of the startup OB, the execution of 
the cycle OB is started.

RUN_UP [FB1] with 
gp_par [DB7]

Table 4-3 Function blocks (FBs)

Address Icon Description
FB1 RUN_UP The block configures and initializes the basic program, starts synchroniza‐

tion between PLC and NCK, is called in OB100 with instance DB gp_par 
[DB7].

FB2 GET The block is used for reading NC tags.
FB3 PUT The block is used for writing NC tags.
FB4 PI_SERV The block is used for starting PI services.
FB5 GETGUD The block is used for reading global user data (GUD) from the NC and for 

determining the GUD tag address.
FB7 PI_SERV2 The block is used for starting PI services that are defined in PI [DB16].
FB9 M2N The block is used for switching over operating components (MCP/OP) 

which are connected with one or several control modules NCU; uses the 
signals from MMC [DB19].

FB10 SI_relay Safety Integrated (SPL) block: Safety relay
FB11 SI_BrakeTest Safety Integrated (SPL) block: Brake test
FB29 Diagnostics Diagnostic routines for the PLC user program with logging of signal states 

and signal changes.

Table 4-4 Functions (FCs)

Address Icon Description
FC2 GP_HP The block processes the cyclic part of the basic program, is called at 

the beginning of OB1.
FC3 GP_PRAL The block processes the block-synchronous part of the basic program, 

is called at the beginning of OB40.
FC5 GP_DIAG The block is used to record module disruptions and failures, is called 

at the beginning of the following OBs: OB82, OB83, OB86.
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Address Icon Description
FC6 TM_TRANS2 The block transfers position and status information of the tools to the 

tool management interface in connection with Multitool.
FC7 TM_REV The block acknowledges an implemented tool change of a turret to the 

tool management interface.
FC8 TM_TRANS The block transfers position and status information of the tools to the 

tool management interface.
FC9 ASUB The block starts asynchronous subprograms, the prerequisite is that it 

must be selected and parameterized by an NC program or by the PI 
service ASUP.

FC10 AL_MSG The block evaluates the signals entered in DB2, generates incoming 
and outgoing error and operating messages of the operating software 
and acknowledges error messages. Optionally, influencing of the 
block and stop signals can commence.

FC12 FC12 Call interface for users for auxiliary functions, the block is called on an 
event-driven basis in the basic program when new auxiliary functions 
are available.

FC13 BHGDisp The block handles the display control for the handheld unit (HHU or 
HT 2).

FC17 Ydelta The block is used for star-delta changeover for digital main spindle 
drives.

FC18 SpinCtrl The block controls axes and spindles from the user program.
FC19 MCP_IFM The block is used for transferring data from the machine control panel 

(MCP milling version) to the NC/PLC interface.
FC21 Transfer The block is used for high-speed data exchange between PLC and 

NCK.
FC22 TM_DIR The blocks provides the shortest path and direction of motion for po‐

sitioning a tool magazine or turret (indexing axis).
FC24 MCP_IFM2 The block is used for transferring data from the machine control panel 

(MCP milling version compact) to the NC/PLC interface.
FC25 MCP_IFT The block is used for transferring data from the machine control panel 

(MCP turning version) to the NC/PLC interface.
FC26 HPU_MCP The block is used for transferring data of the HT 8 to the NC/PLC 

interface.
FC1005 FC1005 Block transfers data to Ethernet CP.
FC1006 FC1006 Block receives data from Ethernet CP.

Programming the PLC
4.1 General information about the PLC program

SINUMERIK 840D sl STEP 7 Toolbox V16
Configuration Manual, 12/2019, 6FC5397-0GP40-0BA1 63



Table 4-5 Data blocks (DBs)

Address Icon Description
DB2 ALMSG_DB Interface between user program and AL_MSG [FC10], contains bit 

arrays for blocking and stop signals as well as fault and status mes‐
sages.
Comment: If you use the DB2 variant "ExtendAlMsg = True", you 
must copy it from the separate master copies folder 
"ALMSG_DB_ExtendAlMsg". The other folders contain the variant 
"ExtendAlMsg = False".

DB4 DB4 Block contains configuration data for tool management and the pa‐
rameterization of the alarms for the bit fields in the ALMSG_DB 
[DB2] as fault or status message for the DB2 variant "ExtendAlMsg 
= False".

DB5 DB5 Interface between user program and AL_MSG [FC10], contains the 
parameterization of the alarms for the bit fields in the ALMSG_DB 
[DB2] as fault or status message for the DB2 variant "ExtendAlMsg 
= True".

DB7 gp_par Instance DB from RUN_UP [FB1]. Contains parameters for config‐
uring operating components and other parameters of the basic pro‐
gram.

DB8 DB8 DB only for internal use in the basic program.
DB10 NC Interface between user program and NC, contains signals from/to 

the NC, PLC and operating software.
DB11 Mode group Interface between user program and mode groups, contains signals 

from/to the NC, PLC and operating software.
DB15 DB15 General communication 
DB16 PI Interface for PI_SERV2 [FB7], contains definitions for all available PI 

services.
DB18 SPL Safety Integrated data (SPL)
DB19 MMC Interface for PI_SERV2 [FB7], contains definitions for all available PI 

services.
DB21...DB30 Chan1...Chan10 Interface between user program and channel, contains signals from/

to channel 1...10.
DB31...DB61 Axis1...Axis31 Interface between user program and axis/spindle, contains signals 

from/to axis/spindle 1...31.
DB71 TMLoadIF Interface between user program and tool management, contains 

signals from/to Load/Unload magazine
DB72 TMSpindleIF Interface between user program and tool management, contains 

signals for spindle as change position.
DB73 TMRevIF Interface between user program and tool management, contains 

signals for turret.
DB77 DB77 MCP/BHG (SDB210)
DB1000 CtrlE Interface between user program and operating software, contains 

energy saving profiles for Ctrl-Energy.
DB1001 SentronPac Interface between user program and operating software, contains 

signals for SENTRON PAC energy monitoring devices.
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Address Icon Description
DB1002 ISM_TS Interface between user program and operating software, contains 

signals for spindle temperature sensors.
DB1071 TMLoadIF_MT Interface between user program and tool management, contains 

signals from/to Load/Unload magazine (multitool).
DB1072 TMSpindleIF_MT Interface between user program and tool management, contains 

signals for spindle as change position (multitool).
DB1073 TMRevIF_MT Interface between user program and tool management, contains 

signals for turret (multitool).

4.1.5 Blocks with user-specific adaptations
In the following, you will find a list of all of the blocks of the SINUMERIK PLC basic program 
which always require user-specific adaptations and therefore cannot be automatically 
upgraded. These blocks are therefore not contained in the master copy "840D sl PLC Basic 
Program (upgrade)".

Table 4-6 Blocks with user-specific adaptations

Block type Address Icon Remark
Organization block OB1 OB1 Organization blocks are not available in the "840D sl PLC 

Basic Program (upgrade)" master copy due to the necessa‐
ry user-specific calls.
You can copy these blocks individually as needed from the 
"840D sl PLC Basic Program" master copy and then import 
your adaptations into the newly copied blocks.
 
 
 
 

OB40 OB40
OB82 OB82
OB86 OB86
OB100 OB100

Function block FB29 Diagnostics ...
Function FC12 FC12 ...
Data block DB2 ALMSG_DB Comment: The master copy "840D sl PLC Basic Program 

(upgrade)" contains the version "ExtendAlMsg = False", not 
the version "ExtendAlMsg = True".

DB4 DB4 ...
DB5 DB5 ...
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4.1.6 Assignment overview
From the following block number assignment overview, you can find out whether a specific 
block number (or block address) can be used for the PLC user program, or whether it is 
assigned or reserved by Siemens or the PLC basic program.

Table 4-7 Assignment of FB numbers

FB number Availability Occupied by
0 Reserved Siemens
1 Occupied Siemens (PLC basic program)
2...14 Reserved Siemens
15 Occupied Siemens (PLC basic program)
16...29 Reserved Siemens
30...999 Freely available (user 

program)
-

1000...1009 Reserved Siemens
1010...1019 Reserved or available Exclusively available for F blocks of Safety Integra‐

ted plus (F-PLC)
1020...1023 Reserved Siemens
1024...7999 Freely available (user 

program)
-

Table 4-8 Assignment of FC numbers

FC number Availability Occupied by
0...1 Reserved Siemens
2...3 Occupied Siemens (PLC basic program)
4 Reserved Siemens
5 Occupied Siemens (PLC basic program)
6...29 Reserved Siemens
30...999 Freely available (user 

program)
-

1000...1023 Reserved Siemens
1024...7999 Freely available (user 

program)
-

Table 4-9 Assignment of DB numbers

DB number Availability Occupied by
1 Reserved Siemens
2...11 Occupied Siemens (PLC basic program)
12 Occupied Siemens (computer link and 

transport system interface)
13...14 Reserved Siemens (PLC basic program)
15...16 Occupied Siemens (PLC basic program)
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DB number Availability Occupied by
17 Occupied Siemens
18 Occupied Siemens (PLC basic program: 

Safety Integrated (SPL))
19 Occupied Siemens (PLC basic program)
20 Occupied Siemens (SINUMERIK CPU-DB)
21...30 Occupied1 Siemens (PLC basic program: 

Channel DB)
31...61 Occupied1 Siemens (PLC basic program: 

Axis DB)
62...70 Freely available (user program) -
71...73 Occupied1 Siemens (PLC basic program: 

tool management)
74...77 Occupied Siemens (PLC basic program)
78...80 Reserved Siemens
81...999 Occupied1 Siemens (ShopMill, ManualTurn)
1000...1002 Occupied Siemens (PLC basic program)
1003...1008 Reserved Siemens
1009 Occupied Siemens (Safety Integrated plus 

(F-PLC))
SI_DiagDB [DB1009] (automati‐
cally generated)

1010...1019 Reserved or available Exclusively available for F blocks 
of Safety Integrated plus (F-PLC)

1020...1070 Reserved Siemens
1071...1073 Occupied Siemens (PLC basic program)
1074...1099 Reserved Siemens
1100...16000 Freely available (user program) -

1Not recommended for use, but possible with limitations. Data blocks of channels, axes/
spindles and tool management functions that have not been activated can be used by the user, 
but this can result in conflicts when upgrading or migrating the PLC basic program.

Further information
Information about the PLC basic program of the SINUMERIK 840D sl is contained in the P3 
section of the SINUMERIK 840D sl Basic Functions Manual: PLC basic program for 
SINUMERIK 840D sl.

4.1.7 Generating blocks at runtime on the NCU
In specific circumstances, some of the basic PLC program blocks are generated by the NCU at 
runtime:

● If you do not load them explicitly onto the NCU

● If you load blocks with an unexpected size onto the NCU, for example because blocks do not
match the machine configuration (e.g. DB20 [DB20] or AL_MSG [DB2]) or because of a
different runtime version.
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This concerns the following blocks:

● All axis/channel DBs actually used

● ALMSG_DB [DB2]

● DB3 [DB3]

● DB9 [DB9]

● BAG [DB11]

● DB17 [DB17]

● MMC [DB19]

The configuring of these blocks is optional and required only when, for example, you 
symbolically address them. Although warnings are issued when the configuration is compiled, 
the program can be executed because of the blocks generated at runtime.

If this involves one of the blocks of the basic program that you do not require (e.g. unused axis 
DB, channel DB, FB or FC), you can delete it. This reduces, for example, the time required for 
loading or exporting the PLC symbols and for working with SINUMERIK archives.
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4.2 Opening the PLC basic program system library

Procedure
Proceed as follows to open and display the system library of the PLC basic program:

1. Switch to the "Libraries" task card.

2. Select the PLC basic program that matches the firmware version of the inserted NCU:

– SINUMERIK 840D sl PLC basic program V4.5.x.x

– SINUMERIK 840D sl PLC basic program V4.7.x.x

– SINUMERIK 840D sl PLC basic program V4.8.x.x

– SINUMERIK 840D sl PLC Basic Program V4.9.2.x

Result
The system library of the PLC basic program has been opened. Information on handling can be 
found under Using copy templates (Page 58) and Adding the PLC basic program (Page 70).

Further information
The block descriptions and other information about the PLC basic program are contained in the 
P3 section of the SINUMERIK 840D sl Basic Functions Manual. PLC basic program.
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4.3 Adding the PLC basic program
You can copy blocks of the PLC basic program from the respective system library. The "840D 
sl PLC Basic Program" folder that it contains is meant for creating a completely new project. 
You can copy the PLC basic program blocks in their entirety or individually.

Requirement
● A SINUMERIK 840D sl NCU is inserted.

● In the project, there are no blocks from other creators in the range of numbers of the PLC
basic program (Page 66).

Procedure
To copy program blocks of the basic program from a master copy to the program blocks folder 
of the project tree, proceed as follows:

1. Switch to the "Libraries" task card and open the PLC basic program that matches the
firmware version of the inserted NCU:

– SINUMERIK 840D sl PLC basic program V4.5.x.x

– SINUMERIK 840D sl PLC basic program V4.7.x.x

– SINUMERIK 840D sl PLC basic program V4.8.x.x

– SINUMERIK 840D sl PLC Basic Program V4.9.2.x

See also: Replacing a device or upgrading firmware (Page 33), Using copy templates 
(Page 58)

2. Open the folder "Master copies > 840D sl PLC Basic Program"
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3. You have several options for copying the PLC basic program blocks to your project:

– Copying the PLC basic program including folder structure as a whole
Drag and drop the master copies folder "840D sl PLC BP" into the folder Program blocks,
e.g. under "CNC_1 > PLC_1 > Program blocks".
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– Copying specific PLC basic program blocks
Open the master copies folder and, if applicable, other lower-level folders and manually
define the blocks which you would like to copy by selecting them and then dragging and
dropping them into the program blocks folder.
To select successive objects, click on the first object, press and hold the Shift key and
then click on the last object.
To select non-successive objects, press and hold the Ctrl key and click on the objects
one-by-one.

Strg

Strg

The blocks are copied to your project. If applicable, the "Conflicts during copying" 
(Page 74) dialog is displayed.

Note
Copy further required blocks separately (e.g. DB2 variant "ExtendAlMsg=True")

If you are using PLC basic program blocks that are not contained in the master copies folder 
"840D sl Basic Program > 840D sl PLC BP", you must copy them separately:
● DB2 variant "ExtendAlMsg=True" from the master copies folder

"ALMSG_DB_ExtendAlMsg"
● Different external STL sources from the master copies folder "External source files"

See: Using copy templates (Page 58), Create blocks from external sources (Page 84)

4. In the project tree, right-click "Program blocks" and select the "Software (compile all blocks)"
command in the "Compile" shortcut menu.
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Result
The blocks of the SINUMERIK PLC basic program have been copied to your project. Any 
copied folder structure (Page 82) has been imported.

Figure 4-3 Program blocks folder

Now you can check the copied blocks and, if applicable, manually delete the PLC basic 
program blocks that you do not require (e.g. unused axis DB, channel DB, FB or FC).
If you have unused blocks in your project, some tasks take unnecessarily long, e.g. the loading 
or the creation and import of SINUMERIK archives.
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4.4 Conflicts when copying blocks
Two different conflict types can occur during the copy and insert of program blocks:

● If several blocks with the same block numbers exist in the program blocks folder, a message
is not displayed immediately. Because duplicate block numbers are flagged only during the
compilation,
compile your project after performing a copy in order to detect any conflicts early.

Figure 4-4 Error message when block numbers or addresses are used multiple times

If duplicate block numbers exist, proceed as follows:

– If this involves one of the blocks of the basic program that you do not require (e.g. unused
axis DB, channel DB, FB or FC), you can delete it.

– If a user block has the same block number as a required basic program block, you must
change the number of the user block.

● The presence of duplicate symbolic block names is checked already during the copy action.
A message is issued if conflicts result because of existing symbolic names.

The dialog offers you the following ways of rectifying the conflict:

– You can cancel the copy process, search for the duplicate blocks in the project tree and
delete them before you initiate the copy process again. In this case, click in the "Cancel"
dialog box.
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– You can copy the master copy to the project and overwrite duplicate blocks without 
knowing which blocks have caused the conflict. In this case, select in the dialog box 
"Replace existing objects and move to this location" and confirm with "OK".

The other possibility mentioned in the dialog, "Rename and add objects", does not resolve 
the conflict in this case.

Programming the PLC
4.4 Conflicts when copying blocks

SINUMERIK 840D sl STEP 7 Toolbox V16
Configuration Manual, 12/2019, 6FC5397-0GP40-0BA1 75



4.5 Correcting OB1
When inserting the blocks from a master copy of the library, the existing organization block OB1 
is duplicated because it has a different name in the library than in the newly created PLC.

● Block in project tree: Main [OB1] or the name of your migrated block.

● Block in library: OB1 [OB1]

When the project is compiled, a message is displayed that there may only be one object of the 
type "OB1".

Procedure
To identify the not required version of the OB1 and to rectify the problem, proceed as follows:

1. Delete one of the duplicated OB1 blocks in the "program blocks" folder:

– If the "program blocks" folder prior to the insertion contained only the empty Main [OB1]
standard block, you can delete it.

– If you have already programmed your own instructions in the OB1, this block normally
already contains the call for the basic program and you can delete the newly added "OB1
[OB1]" block.
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4.6 Upgrading the PLC basic program
If you upgraded the firmware of an NCU or carried out a project migration, you should then also 
upgrade the PLC basic program to the current version.

However, it is essential that you check beforehand whether you would inadvertently overwrite 
your own blocks (see requirement).

Requirement
● Block number ranges of the SINUMERIK PLC basic program in the project are not occupied

by blocks of other creators or you have checked which blocks of other creators are located
in the SINUMERIK number range (Page 66).

Procedure
To upgrade the PLC basic program, proceed as follows:

1. Switch to the "Libraries" task card and open the PLC basic program that matches the
firmware version of the inserted NCU:

– SINUMERIK 840D sl PLC basic program V4.5.x.x

– SINUMERIK 840D sl PLC basic program V4.7.x.x

– SINUMERIK 840D sl PLC basic program V4.8.x.x

See also: Replacing a device or upgrading firmware (Page 33), Using copy templates 
(Page 58)

2. Open the folder "Master copies > 840D sl PLC Basic Program (upgrade)"
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3. Depending on the block number assignment in your project, select one of the following
options:

Assignment of the PLC 
GP No. range

Possible procedure

Through blocks of other 
creators

or

Exclusively through PLC 
basic program blocks

Overwriting specific PLC basic program blocks
1. Open the lower-level master copies folders and select only those

PLC basic program blocks that you use in your project.
– To select successive objects, click on the first object, press and

hold the Shift key and then click on the last object.
– To select non-successive objects, press and hold the Ctrl key

and click on the objects one-by-one.
2. Drag and drop the selected blocks into your "Program blocks"

folder, e.g. under "CNC_1 > PLC_1 > Program blocks".

Exclusively through PLC 
basic program blocks

Overwriting the PLC basic program including folder structure as a whole
Drag and drop the entire master copies folder "840D sl PLC BP" into 
your "Program blocks" folder, e.g. under "CNC_1 > PLC_1 > Program 
blocks".

The blocks are copied to your project. A check is made for duplicate block names and 
the "Conflicts during copying" dialog (Page 74) is displayed.

Note
Copy further required blocks separately (e.g. DB2 variant "ExtendAlMsg=True")

If you are using PLC basic program blocks that are not contained in the master copies folder 
"840D sl Basic Program > 840D sl PLC BP", you must copy them separately:
● DB2 variant "ExtendAlMsg=True" from the master copies folder

"ALMSG_DB_ExtendAlMsg"
● Different external STL sources from the master copies folder "External source files"

See: Using copy templates (Page 58)Create blocks from external sources (Page 84)

4. Select the option "Replace existing objects and move to this location" and confirm with "OK".

5. In the project tree, right-click "Program blocks" and select the "Software (compile all blocks)"
command in the "Compile" shortcut menu.

Result
The PLC basic program has been upgraded and is currently compiled.

Now you can check the copied blocks and, if applicable, manually delete the PLC basic 
program blocks that you do not require (e.g. unused axis DB, channel DB, FB or FC).
If you have unused blocks in your project, some tasks take unnecessarily long, e.g. the loading 
or the creation and import of SINUMERIK archives.
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4.7 Copying blocks from one project into another

Procedure
Proceed as follows to import blocks from an existing project:

1. From the "View" menu, choose the command "Reference projects". 
The "Reference projects" palette is displayed under the project tree.

2. Click the "Open reference project" icon in the "Reference projects" palette, select the 
project, and confirm with "Open".
The project is opened (write-protected) and the associated project structure is displayed in 
the "Reference projects" palette.
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3. Navigate in the reference project to the "Program blocks" folder and select the blocks that
you want to copy.

4. Drag-and-drop the blocks from the reference project to the "Program blocks" folder of your
current project.

Note
Copy additional objects separately (e.g. tags or PLC data types)

When you copy the program blocks, objects that belong together, such as tags, PLC data 
types or technology objects, are not automatically included in the copy. This applies both to 
copying from reference projects and to copying to another PLC.

Error messages are issued during the compilation, e.g. if the tags used in the copied 
program block are not defined in the tag table.

Therefore, additionally copy the objects used by the copied blocks.
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Note
Conflicts due to names, addresses or numbers that are used multiple times

When you paste objects from a reference project whose names have already been used in 
the project, these are automatically renamed under certain circumstances:
● If you copy objects with the same name into the same folder or the same group, the 

"Conflicts when copying" dialog is displayed.
● If you copy objects with assigned names to a different folder (or group), the newly pasted 

objects are renamed without asking.

A check for duplicate block numbers or addresses is only done during the conversion, 
however.
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4.8 Use and handling of groups
In the project navigation, you can create optional groups in the "program blocks" folder in order 
to organize your program blocks.

Figure 4-5 Adding a group
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For example, this function is useful in the following situations:

● Creation of a dedicated group for the blocks of the basic program and of the user program.
This allows you to display individually the editable blocks of the user program.

● Organize specific related program blocks (e.g. axis DBs).

● Organize specific program blocks in a group in order to save them quickly and easily in
a reload archive (Page 52).

To maximize the overview window, select the "program blocks" folder and click the "Maximize/
minimize the view" icon in the project navigation toolbar.

Information about the overview window can be found in the information system of the TIA 
Portal, keyword "overview window".
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4.9 Create blocks from external sources
You do not manage external source files (e.g. *.STL or *.SCL) in TIA Portal in the "Program 
blocks" folder, but in the "External sources" folder, e.g. under "CNC_1 > PLC_1 > External 
sources". You can then generate blocks from the sources maintained there. These are saved 
in the "Program blocks" folder.

You do not edit the files in the "External sources" folder using a TIA Portal editor, but with any 
external editor, which you define under Windows.

Requirement
● An external source is available in STL or SCL format.

● The mnemonic set in the TIA Portal corresponds to the setting used in the external source.
These settings are found in the menu bar of the TIA Portal as follows: "Extras > Settings >
General > General settings > Mnemonic".

Note
Use of German mnemonics in external source files of the PLC basic program

The mnemonic setting "German" is required in all external source files contained in the copy 
templates of the PLC basic program. This affects the files "bhg_db_awl", "diagnose.awl", 
"gpob840d.awl" and "mdeclist.awl".

The process fails if the setting does not correspond to the setting of the source file when the 
block is generated.

Procedure
1. In the project tree, select the "Add new external file" command in the "CNC_1 > PLC_1 >

External sources" folder.

2. Select the external file (*.STL or *.SCL) that you want to add in the "Open" dialog.
The external file is copied to the "External sources" folder in the project tree.

Note
Displaying external sources (e.g. STL files) using an external editor

The internal editor of the TIA Portal does not display external sources.

If you add and open an external source in the TIA Portal, the file will be opened with the 
application linked with the associated file type (e.g. STL) in Windows (e.g. Microsoft Editor).

See also: TIA Portal online help, search term "Using external source files"

3. Right-click the external source, then select the "Generate blocks from source" command in
the shortcut menu.

Result
You have successfully generated blocks from an external source.

Further information about external sources of the PLC basic program system library can be 
found in the SINUMERIK 840D sl Basic Functions Manual.
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4.10 Exporting PLC symbols for SINUMERIK Operate

4.10.1 Creating and loading PLC symbols
You can make PLC symbols defined in the TIA Portal available for SINUMERIK Operate in able 
to use them for various functions there. You must export the symbols of the associated PLC in 
the TIA Portal and then import into SINUMERIK Operate.

Note
Deleting unwanted blocks before exporting PLC symbols

If you have saved unwanted blocks in your project, this lengthens the time required for 
exporting and importing PLC symbols.

Consequently, delete unwanted blocks that you copied previously from the basic program 
library prior to the export.

See: General information about the PLC program (Page 55)

Requirement
● The software has been compiled completely.

● The associated languages are activated as project languages in the TIA Portal.
See: Information system, "Activate project languages" section

Note
Comments only in German or English

Because SINUMERIK Operate can manage only German and English comments, you can 
export only German and English comments from the TIA Portal.

● The PLC symbols to be exported are valid.

Note
Only valid PLC symbols are exported

The following PLC symbols are not taken into account during the export:
● PLC symbols of know-how-protected blocks
● PLC symbols of F-blocks
● Internal PLC symbols
● Invalid/faulty PLC symbols
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Procedure overview

Table 4-10 Example procedure for creating and loading PLC symbols

Step Description
1 If necessary, check or edit symbols in the TIA Portal

● You can change the symbolic names of blocks by right-clicking the block and selecting 
"Rename" from the shortcut menu.

● You can change symbols of the individual elements in the block editor.
● PLC variables for Flags, Times, Input, Output, Timer and Counter can be changed in the 

associated table field (e.g. under "CNC_1 > PLC 1 > PLC variables > Display all variables")
2 Exporting PLC symbols with the TIA Portal (Page 86)
3 If necessary, make export files available on the NCU or PCU, e.g. using a USB FlashDrive
4 Importing PLC symbols in SINUMERIK Operate (Page 89)

4.10.2 Exporting PLC symbols

Note
Deleting unwanted blocks before exporting PLC symbols

If you have saved unwanted blocks in your project, this lengthens the time required for 
exporting and importing PLC symbols.

Consequently, delete unwanted blocks that you copied previously from the basic program 
library prior to the export.

See: General information about the PLC program (Page 55)
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Requirement
● The software has been compiled completely.

● The associated languages are activated as project languages in the TIA Portal.
See: Information system, "Activate project languages" section

Note
Comments only in German or English

Because SINUMERIK Operate can manage only German and English comments, you can 
export only German and English comments from the TIA Portal.

● The PLC symbols to be exported are valid.

Note
Only valid PLC symbols are exported

The following PLC symbols are not taken into account during the export:
● PLC symbols of know-how-protected blocks
● PLC symbols of F-blocks
● Internal PLC symbols
● Invalid/faulty PLC symbols
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Procedure
To export PLC symbols for SINUMERIK Operate, proceed as follows:

1. In the project tree, right-click on the PLC or NCU and select the "Export  PLC symbols for 
SINUMERIK Operate " in the shortcut menu.
The "Export PLC symbols for SINUMERIK Operate" dialog opens.

2. Enter the settings:

– Select the languages whose PLC symbols you want to export. Only those languages that 
you previously selected under "Project languages" are actively displayed.

Note
Comments only in German or English

Because SINUMERIK Operate can manage only German and English comments, you 
can export only German and English comments from the TIA Portal.
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– Select the storage location in which the exported PLC symbols are to be saved. Use, for
example, a USB FlashDrive to subsequently copy the files to the NCU.

3. Click "Export" to start the export operation.

Result
The PLC symbols will be copied to the chosen storage location. The "PlcSym.snh" file is 
created. Depending on your settings, the files are also created with German or English 
comments: "PlcSym_GR.snt" and "PlcSym_UK.snt".

Note
Notation

The notation (upper and lower case) of the file names created by the program is mandatory and 
must not be changed. 

4.10.3 Importing PLC symbols

Requirement
● The symbol export files are available on the NCU or PCU, e.g. using a USB FlashDrive

Note
Notation

The notation (upper and lower case) of the file names created by the program is mandatory 
and must not be changed. 

● The current PLC symbols in SINUMERIK Operate have been saved

Note
Saving or deleting old symbol tables

Note that already existing files are overwritten during the export if you confirm that this 
should be done. Furthermore, it can lead to inconsistencies if not all files are exported. 

We recommend that the old files are backed up or deleted before a new export, or the files 
are exported to an empty directory.

Procedure
To use PLC symbols exported from the TIA Portal in SINUMERIK Operate, proceed as follows:

1. Copy the symbol export files in the following directory on the CF card of the NCU or PCU:
/oem/sinumerik/plc/symbols

2. Restart SINUMERIK Operate.
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3. After the startup, confirm the "Diagnosis", ">>" and "NC/PLC variables" horizontal softkeys.

4. Select the "Insert variables" softkey.
The imported symbols are displayed in the "NC/PLC variables" table and can be imported.

Further information
Detailed information on how you can load the PLC symbols to the control system are contained 
in the SINUMERIK 840D sl Universal Operator Manual under the "Loading PLC symbols" 
keyword.
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4.11 Edit blocks
The individual blocks of the PLC basic program or the user program can be edited directly in the 
TIA Portal using the STEP 7 editors.

Information about these functions and editors is available in the higher-level help 
"Programming the PLC" and in the STEP 7 Professional System Manual. (Sometimes functions 
for specific PLCs are discussed there. Information that also concerns the SINUMERIK 840D sl 
PLCs is marked with "S7-300".)

If you are converting from the STEP 7 V5.x toolbox, you also find special information about 
programming a PLC in the sections of the "Migrating SINUMERIK projects" help.
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Configuring networks 5
5.1 Configuring an Ethernet Interface

Procedure
In order to set the Ethernet interface, proceed as follows:

1. In the network view, click the CP in the basic rack of the NCU. 

2. Under the "Properties" tab in the inspector window, select the "PN/IE interface > Ethernet 
addresses" entry.

3. Set the IP address matching your real configuration. If the PG/PC is connected to X127, the 
following IP address applies:
Hardware factory setting on the NCU for socket X127
IP address: 192.168.215.1
Subnet mask: 255.255.255.0
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5.2 Configuring PROFIBUS DP

Procedure
   

Configuring the PROFIBUS DP address on the PLC
1. In the network view, click the PLC in the basic rack of the NCU.

2. In the "Properties" tab, in the inspector window, select the entry "DP Interface > PROFIBUS 
address".
The settings of the PROFIBUS address are displayed.

3. In the Parameters area, set the DP address of the interface on the PLC under "Address". 
This is transferred from the configuration to the PLC during the load action.

Configuring the PROFIBUS DP address for the ADI4 module
1. In the network view, click the "DP" interface of the ADI4.

2. In the inspector window "Properties", select the entry "PROFIBUS address".

3. Under "Address" set the DP address that matches the hardware. The configured address 
must match the hardware address. It is not accepted automatically.
Information about setting the DP address on the hardware is contained in the "ADI4 - Analog 
drive interface for 4 axes" Device Manual.

Checking the transmission speed of the ADI4
Although you can view the "Transmission speed" parameter in the DP interface properties, you 
must select the bus system to change it:

1. Click the bus system.

2. In the "Properties" inspector window, check under "Network settings" the "Transmission 
speed" entry. The ADI4 module can be operated only with the transmission speed 12 Mbit/
s.
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5.3 Configuring Integrated PROFIBUS (DP Integrated)

Procedure
To check the PROFIBUS addresses, proceed as follows:

1. In the network view, click the DP Integrated interface of the PLC or select the interface in the
device overview.

2. In the "Properties" tab, in the inspector window, select the entry "PROFIBUS address".

Result
The DRIVE-CLiQ sockets of the real hardware are displayed to which the NX modules must be 
connected. 

Note
Cycle clock settings

You can only make the cycle clock settings on the PROFIBUS Integrated subnet and not 
directly on the interface: For the selected subnet, you find the cycle clock settings under 
"Equidistance" in the inspector window.

Observe the rules for setting the clock cycle at the field buses (see Commissioning Manual, 
"Commissioning CNC: NCK, PLC, drive").
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5.4 Configuring PROFINET

Procedure
In order to set the PROFINET interface, proceed as follows:

1. In the network view, click the PLC in the basic rack of the NCU.

2. Under the "Properties" tab in the inspector window, select the "PROFINET interface >
Ethernet addresses" entry.

3. Check under "IP protocol" whether the correct IP address is set ("192.168.0.1" in the
example).
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5.5 Configuring PROFINET IO with IRT

5.5.1 Overview
IRT (Isochronous Realtime Ethernet) is a transmission method in which the PROFINET 
devices are synchronized very precisely.

The following example configuring sequences serve as an aid for the configuring and provide 
an overview of this chapter content.

● Configuring NC-controlled drives isochronously (handling overview) (Page 101)

● Configuring I/O used by NC isochronously (handling overview) (Page 102)

You can, however, make most settings for the clock synchronization in TIA Portal in any order. 
You can orient yourself on the following notes:

● Isochronous modules identification in the hardware catalog (Page 99)

● Rules and requirements for clock synchronization (Page 97)

● Match values between PROFINET IO and PROFIBUS Integrated (Page 111)

● General information concerning isochronous mode is also contained in the TIA Portal online 
help in Section "Configuring IRT communication".

If, instead, you want to operate drives or I/O isochronously via the PLC, proceed as for a CPU 
S7-300. (Use the OB61 as isochronous alarm OB or the TPA1 as process image, and do not 
enter the drive or I/O addresses in the machine data.)

5.5.2 Rules and requirements
Irrespective whether you configure isochronous I/O used by NC or isochronous NC-controlled 
drives, the value of the TDP send clock must be identical in the complete system (all devices, 
modules, submodules and bus systems):

● You can find these settings in the TIA Portal at the following locations:

– Properties of the PROFINET IO system under "Domain management > Sync domains > 
Sync-Domain_x > Send clock".

– Properties of the PROFIBUS Integrated bus system under "Equidistance > DP cycle".

This applies, e.g. even when you connect drives via PROFINET as well as PROFIBUS 
Integrated. The default setting of the PROFIBUS DP cycle (send clock) at the integrated 
PROFIBUS is 2 ms.

During the configuring of drives, the values of the TI and TO times must also be identical in the 
complete system:

● Properties of the IO device under "PROFINET interface > Extended options > Isochronous 
mode".

● Properties of the bus system (e.g. PROFIBUS Integrated_1) under "Equidistance".
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You can obtain these values automatically from the "NCK" isochronous OB or set them 
manually.

Note
Restriction on the use of NCU Link

The combination of isochronous PROFINET NC peripherals (drives, inputs/outputs) and NCU-
Link is not supported.
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5.5.3 Isochronous-capable modules identification
Whether a module supports isochronous mode can be determined in the hardware catalog in 
the following manner:

● When you select a device in the hardware catalog, you can see from the description in the 
"Information" section whether this device supports isochronous mode or IRT.

Figure 5-1 Description of a device in the hardware catalog

● All peripheral modules that have the "HF" name suffix can be operated isochronously (e.g. 
DI 16x 24 VDC HF - 6ES7 521-1BH00).
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Figure 5-2 Hardware catalog - "HF" (High Feature) name suffix

● The "Information" section does not explicitly list whether drive telegrams (e.g. SIEMENS
telegram 136) support isochronous mode. The compiler will issue an error message if you
use an isochronous telegram without activating isochronous mode for the associated
header module.

● A listing of isochronous-conform PROFINET controllers and PROFINET devices is
contained in the Service & Support portal:

– Which IO controllers and IO devices support the IRT [...] functions and isochronous
operation? (http://support.automation.siemens.com/WW/view/en/44383954)

– Which SIMATIC S7 components and which drives support isochronous mode? (http://
support.automation.siemens.com/WW/view/en/14747677)

The associated hardware documentation specifies whether a PROFIBUS controller or 
device is isochronous-conform.
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Note
Differences for devices based on device description files (DDF)

A description of the functionality is also contained in the "Information" section for DDF devices. 
The following differences, however, exist for the configuring:
● GSD devices are not contained in the same folder as standard devices in the hardware 

catalog. The SINAMICS S120/S150 CU320-2, for example, are not found under "Field 
devices", but rather under "Further field devices > PROFINET IO > Drives > Siemens AG > 
SINAMICS".

● To insert modules or submodules for a GSD device, you must use the device overview 
rather than the device view.

5.5.4 Configuring isochronous NC-controlled drives
The procedure for configuring isochronous NC-controlled drives is described below.

If, instead, you want to operate drives isochronously via the PLC, proceed as for a CPU S7-300. 
(Use the OB61 as isochronous alarm OB or the TPA1 as process image, and do not enter the 
drive addresses in the machine data.)

If, rather than NC-controlled drives, you want to configure I/O used by NC isochronously, 
proceed as described in the associated section (Page 102).

Requirement
● The devices to be configured have been inserted (at least one NCU and one PROFINET IO 

IRT-conform device).

● The isochronous-conform modules and submodules to be configured have been inserted in 
the PROFINET IO IRT-conform device.
See also: Isochronous-capable modules identification (Page 99)

● The PROFINET IO IRT-conform devices are interconnected to the NCU with X150.

Note
Concurrent operation of devices with and without clock synchronization

When you configure devices that do not participate on the IRT communication, observe 
the rules for sync domains for PROFINET IO IRT (Page 110).

Procedure overview

Step Description
1 Configuring the NCU (Page 103)
2 Configuring PROFINET IO IRT devices (Page 104)
3 Configuring IO modules or drive telegrams (Page 106)
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Step Description
4 Configuring sync domains (Page 110)
5 Compile the configuration and load into the actual hardware (Page 39)

The compiler issues error messages if you use different values for bus cycles. In this case, match the values 
(Page 111).

6 Assigning drive addresses to the NCU machine data (Page 112)

Note
Reusing configured drives or devices in other projects

You can copy preconfigured and configured drives or devices with drag-and-drop into a global 
library. In this manner, you can insert them later together with the made settings into another 
project and so save configuration effort.

Further information on handling libraries in the TIA Portal can be found in the online help under 
"Library > Fundamentals".

Further information
Further information on the configuration of IRT can be found in the TIA Portal online help under 
"Configuring IRT communication".

5.5.5 Configuring I/O used by NC isochronously
The procedure for configuring isochronous NC I/O is described below.

If, instead, you want to operate I/O isochronously via the PLC, proceed as for a CPU S7-300. 
(Use the OB61 as isochronous alarm OB or the TPA1 as process image, and do not enter the 
I/O addresses in the machine data.)

If, rather than non-NC I/O, you want to configure NC drives isochronously, proceed as 
described in the associated section (Page 101).

Requirement
● The devices to be configured have been inserted (at least one NCU and one PROFINET IO 

IRT-conform device).

● The modules to be configured have been inserted in the PROFINET IO IRT-conform device.
See also Isochronous-capable modules identification (Page 99)

● The PROFINET IO IRT-conform devices are interconnected to the NCU with X150.

Note
Concurrent operation of devices with and without clock synchronization

When you configure devices that do not participate on the IRT communication, observe 
the rules for sync domains for PROFINET IO IRT (Page 110).
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Procedure overview

Step Description
1 Configuring the NCU (Page 103)
2 Configuring PROFINET IO IRT devices (Page 104)
3 Configuring IO modules or drive telegrams (Page 106)
4 Configuring the input delay for digital input modules (Page 109)
5 Configuring sync domains (Page 110)
6 Compile the configuration and load into the actual hardware (Page 39)

The compiler issues error messages if you use different values for bus cycles. In this case, match the values 
(Page 111).

7 Assigning I/O addresses to the NCU machine data (Page 113)

Note
Reusing configured drives or devices in other projects

You can copy preconfigured and configured drives or devices with drag-and-drop into a global 
library. In this manner, you can insert them later together with the made settings into another 
project and so save configuration effort.

Further information for handling libraries in the TIA Portal can be found in the information 
system under the keyword "Library > Fundamentals".

Further information
Further information on the configuration of IRT can be found in the information system of the 
TIA Portal at "Configuring IRT communication".

5.5.6 Configuring the NCU
When you operate drives or IO isochronously using NC, make the following SINUMERIK-
specific settings.

If, however, you operate the drives or I/O via the PLC, make the settings as for an S7-300-CPU. 
(See online help, keyword "Isochronous mode, configure".)

Requirement
● The devices to be configured have been inserted (at least one NCU and one PROFINET IO 

IRT-conform device).

● The isochronous-conform modules and submodules to be configured have been inserted in 
the PROFINET IO IRT-conform device.
See also: Isochronous-capable modules identification (Page 99)

● The PROFINET IO IRT-conform devices are interconnected to the NCU with X150.
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Note
Concurrent operation of devices with and without clock synchronization

When you configure devices that do not participate on the IRT communication, observe 
the rules for sync domains for PROFINET IO IRT (Page 110).

Procedure
To configure the NC of the NCU to use isochronous mode, proceed as follows:

1. Select the PLC of the NCU.

2. Select the "Alarms > Isochronous alarms > NCK" entry in the "Properties > General"
inspector window.

3. In the "Distributed I/O" dropdown list, select the PROFINET IO system with which you have
interconnected the PROFINET IO IRT devices (e.g. "PROFINET IO system (100)").

Note
Changing the name and number of the PROFINET IO system

You can specify the name and number of the PROFINET IO system in the settings of the IO 
system (bus system on X150). You find the setting under "General" provided IO system is 
highlighted in the network view.

If, however, the sync domain or nothing is highlighted, the setting is not available.

To highlight the IO system, position the mouse cursor over the IO system in the network view 
and activate the appropriate option box in the displayed tooltip.

4. In the "Application cycle (ms)" dropdown list, select the value that you defined as send clock
of the sync domain and the DP cycle of SINAMICS Integrated, e.g. 2000.

5. Enter "2" in the "TPA" (subprocess image) text field. The setting must match the "process
image" setting on the IO modules.

5.5.7 Configuring PROFINET IO IRT devices

Requirement
● The devices to be configured have been inserted (at least one NCU and one PROFINET IO

IRT-conform device).

● The isochronous-conform modules and submodules to be configured have been inserted in
the PROFINET IO IRT-conform device.
See also Isochronous-capable modules identification (Page 99)

● The PROFINET IO IRT-conform devices are interconnected to the NCU with X150.

● The NCU is configured.
See also Configuring the NCU (Page 103)
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Procedure
To configure devices for isochronous operation, proceed as follows:

1. Switch to the device view of the PROFINET IO IRT device and select it.

2. Select in the "Properties > General" inspector window under "PROFINET interface > 
Extended options" the port (e.g. Port [X1 P1]).

3. Select a specific port on the PLC in the "Partner port" dropdown list in the "Port 
interconnection" section: "Port_1" (X150 P1) or "Port_2" (X150 P2).

Figure 5-3 Example port interconnection

The selected port of the device is interconnected with the appropriate port of the PLC.
(Alternatively, you can make the port interconnection between devices graphically in the 
topology view.)

4. In the "Cable length" dropdown list, enter the length of the actual cable in order to minimize 
the signal run time.

5. Switch in the sector tree of the inspector window to the "PROFINET interface > Extended 
options > Isochronous mode" entry.

6. Activate the "Isochronous operation" checkbox.
The isochronous operation of the device is activated and concurrently the synchronization 
role of the device set to "sync slave" and the RT class set to "IRT" in the sync domain.
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7. In the "Ti/To values" dropdown list, select "From the OB".
This causes the value to be taken automatically from the setting of the isochronous alarm 
OB "NCK".

8. Activate the isochronous mode individually for the desired modules of the device in the 
"Detail overview" table.

Figure 5-4 Settings for the isochronous mode using the example of a SINAMICS S120/S150 CU320-2

5.5.8 Configuring IO modules or drive telegrams
The isochronous-conform modules (e.g. input/output modules, DO or telegrams) to be 
configured must be selected individually in order to make the desired settings in the 
"Properties" inspector window. You can select these modules in the device view or device 
overview (in the case of GSD-based devices, only in the device overview).

Requirement
● The devices to be configured have been inserted (at least one NCU and one PROFINET IO 

IRT-conform device).

● The isochronous-conform modules and submodules to be configured have been inserted in 
the PROFINET IO IRT-conform device.
See also Isochronous-capable modules identification (Page 99)

● The PROFINET IO IRT-conform devices are interconnected to the NCU with X150.

● The NCU is configured.
See also Configuring the NCU (Page 103)

● The device or the rack is configured.
See also Configuring PROFINET IO IRT devices (Page 104)
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Procedure
To configure the inserted IO modules, select them successively and make the settings 
individually for each module in the inspector window. Proceed as follows:

1. In the device view, select the rack and open the device overview.

Figure 5-5 Device overview example of a GSD drive device with modules

2. In the device overview, select on the rack of the PROFINET unit one of the inserted modules 
to be configured.
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3. In the "Properties > General" inspector window, select the "I/O addresses" entry.

Figure 5-6 Settings for I/O addresses
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4. Select the TPA2" as "Process image" in each of the "Input addresses" and "Output 
addresses" sections.

Figure 5-7 TPA2 process image setting using a telegram 136 as example

5. Enter the desired address in the associated "Start address" text field. Note the following:

– The I/O addresses must lie within the process image of the PLC (default setting: 1024 
bytes; can be configured under "Cycle" in the PLC properties).

– Do not use any I/O addresses that are used for some other purpose, e.g. by the machine 
control panel.

– The I/O addresses must match the setting in the NC (SINUMERIK Operate).
The machine data in which this is entered depends on whether drives or I/Os are to be 
configured:
Assigning drive addresses to the NCU machine data (Page 112)
Assigning I/O addresses to the NCU machine data (Page 113)

5.5.9 Configuring the input delay for digital input modules
If you configure isochronous NC IO, you must correctly set the "input delay" value on the used 
digital input modules. A small input delay shortens the response time, although a larger input 
delay can possibly suppress longer interference pulses.

● You find the setting for the input delay for a selected digital input module under "Inputs" in 
the "Properties" inspector window.

Configure the input delay appropriate for the send clock of the sync domain. The send clock of 
the sync domain cannot be set smaller than the input delay of the digital input modules. The 
default setting of the input delay is 3 ms.
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5.5.10 Configuring sync domains
All PROFINET devices that participate on the IRT communication are synchronized to a 
common clock. The devices must belong to a sync domain. Just one device has the role of the 
sync master (clock generator) in a sync domain; all other devices have the role of a sync slave. 
For SINUMERIK, the PROFINET IO controller serves as sync master in the PLC.

Rules
● The configured PROFINET topology must match the actual wiring of the hardware.

● PROFINET devices that do not participate on the IRT communication, namely not 
synchronized, are also not part of a sync domain.

● Devices that do not belong to the sync domain may not be contained in the PROFINET 
topology between a node of a sync domain and its sync master.
How to remove or add nodes from or to a sync domain is described under "Specifying nodes 
of a sync domain" in the TIA Portal online help.

Procedure
To configure the sync domain in the properties of the PROFINET IO system, proceed as follows:

1. In the network view, select the PROFINET IO system.

Figure 5-8 Selecting the PROFINET IO system

2. Select the "PROFINET > Domain management > Sync-Domain_1" entry in the "Properties 
> General" inspector window.
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3. In the "IO devices" table, define the synchronization roles and RT classes of all devices of 
the sync domain:

– Define the role of the PLC by opening the dropdown list in the "Synchronization role" 
column and selecting "Sync master".

Figure 5-9 Selecting the sync master

– Check whether the synchronization role is set to "Sync slave" for all desired devices.
See also: Configuring PROFINET IO IRT devices (Page 104)

4. In the "Sync-Domain_1" section, enter a value in the "send clock" dropdown list appropriate 
for the "Equidistant DP cycle" setting.

Note
The send clock of the sync domain and the DP cycle for SINAMICS Integrated must match!

If you have not set the same values for these settings, an error message will be issued when 
the configuration is compiled. In this case, match the values and compile the project again.

The "Equidistance DP cycle" setting is contained under "Equidistance" in the properties of 
the PROFIBUS Integrated subsystem. (default setting: 2 ms; minimum value: Version-
dependent)

5.5.11 Match values between PROFINET IO and PROFIBUS Integrated
In case you have used different values, an error message will be issued in the "Info > Compile" 
inspector window during the compilation.

The following values must agree:

Isochronous mode values:

● "PLC > Alarms > Isochronous alarms > NCK > Application cycle"

● "PROFINET IO system > Domain management > Sync domains > Sync-Domain_1 > Send 
clock"

● "PROFIBUS Integrated_1 > Equidistance > DP cycle > Equidistant DP cycle"
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Ti/To values:

● "PROFIBUS Integrated_1 > Equidistance > Ti/To values of the PROFIBUS"

● "I/O device > PROFINET interface [x1] > Extended options > Isochronous mode"

Match the values and compile the project again.

5.5.12 Assigning drive addresses to the NCU machine data

Procedure
To enter configured addresses in the machine data in the TIA Portal, proceed as follows:

1. Check in the TIA Portal which addresses you have assigned to the drives (see Configuring
IO modules or drive telegrams (Page 106)).

2. Transfer the addresses to the machine data (e.g. via SINUMERIK Operate).
See Adapting I/O start addresses (Page 134).

Further information
● General information concerning this machine data is available in Chapter A4 of the

SINUMERIK 840D sl Supplementary Functions Manual: Digital and analog NCK I/Os for
SINUMERIK 840D sl.

● Specific information on the individual machine data can be found in the online help of
SINUMERIK Operate.
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5.5.13 Assigning I/O addresses to the NCU machine data

Procedure
To enter addresses which have been configured in the TIA Portal in the machine data, proceed 
as follows:

1. Check in the TIA Portal which addresses you have assigned to the I/O modules 
(see Configuring IO modules or drive telegrams (Page 106)).

2. Transfer the addresses to the following machine data (e.g. via SINUMERIK Operate):

MD Identifier Description Concerns the mod‐
ule type

105
00

$MN_DPIO_LOGIC_AD‐
DRESS_IN

Logical slot address of the PROFIBUS/
PROFINET I/O

Input module

105
01

$MN_DPIO_RANGE_LENG
TH_IN

Length of the PROFIBUS/PROFINET I/
O range

Input module

105
10

$MN_DPIO_LOGIC_AD‐
DRESS_OUT

Logical slot address of the PROFIBUS/
PROFINET I/O

Output module

105
11

$MN_DPIO_RANGE_LENG
TH_OUT

Length of the PROFIBUS/PROFINET I/
O range

Output module

Use machine data with the same index in order to enter the address and the associated 
address length of a module. Use, for example, for the address of an input module, 
MD10500[1] and for the address length of the same module MD10501[1].

Example
The following example compares the configuration in the TIA Portal and the compared values 
in the machine data:

Table 5-1 Configuring in the TIA Portal with five IO modules

Module Address
2AI U HS 1020…1023
2AO U HS 1020…1023
4DI 24 VDC HF 1016.0…1016.3
4DI 24 VDC HF 1018.0…1018.7
8DO 24 VDC / 0.5 A HF 1018.0…1018.7
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Assignment of the IO modules to the NCK machine data
MD10500 $MN_DPIO_LOGIC_ADDRESS_IN[0]=1016
MD10500 $MN_DPIO_LOGIC_ADDRESS_IN[1]=1018
MD10500 $MN_DPIO_LOGIC_ADDRESS_IN[2]=1020
MD10501 $MN_DPIO_RANGE_LENGTH_IN[0]=1
MD10501 $MN_DPIO_RANGE_LENGTH_IN[1]=1
MD10501 $MN_DPIO_RANGE_LENGTH_IN[2]=4
MD10510 $MN_DPIO_LOGIC_ADDRESS_OUT[0]=1018
MD10510 $MN_DPIO_LOGIC_ADDRESS_OUT[1]=1020
MD10511 $MN_DPIO_RANGE_LENGTH_OUT[0]=1
MD10511 $MN_DPIO_RANGE_LENGTH_OUT[1]=4

Further information
● General information concerning this machine data is available in Chapter A4 of the 

SINUMERIK 840D sl Supplementary Functions Manual: Digital and analog NCK I/Os for 
SINUMERIK 840D sl.

● Specific information on the individual machine data can be found in the online help of 
SINUMERIK Operate.
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Configuring telegrams and drive units 6
6.1 Overview

The drive communication of a SINUMERIK NCU takes place via the SINAMICS Integrated 
subcomponent and, if applicable, via additional connected NX modules. The scope of 
functionality of the SINAMICS Integrated (or of an NX module) includes the functionality of a 
SINAMICS S120 of the corresponding firmware version:

NCU firmware SINAMICS firmware used
V4.5 V4.5
V4.7 V4.7
V4.8 V4.9
V4.91 V5.2
V4.92

You can find detailed information about drive communication, e.g. function charts, in the 
SINAMICS S120 List Manual for the corresponding SINAMICS version (https://
support.industry.siemens.com/cs/document/109739998/).

The standard telegram configuration of a SINUMERIK NCU (Page 116) is redundantly preset 
in the TIA Portal and in the machine data and usually does not have to be modified. 
Alternatively, you can switch over to a user-defined telegram configuration (Page 121).

You can also use various standard functionalities of STEP 7 (TIA Portal) in combination with 
telegrams, e.g.:

● In the properties of the PLC, you can see a complete overview of the assigned I/O 
addresses (Page 117).

● In the PLC tag editor, you can define telegram I/O addresses as PLC tags to access them 
symbolically in the PLC program.
See: TIA Portal online help; keyword "Declaring PLC tags"
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6.2 Standard telegram configuration
The standard telegram configuration of a SINUMERIK NCU can have different versions. This 
depends on the safety mode and I/O addressing schematic used:

● Depending on the safety mode used, different telegram types are used for safety-relevant
communication. Telegram types for standard communication do not differ.

● The optimized I/O addressing scheme (Page 118) provides a larger coherent address area
for other purposes and therefore uses different telegram I/O addresses (except for
PROFIsafe telegrams).
A telegram configuration with an optimized I/O addressing scheme is considered the
standard telegram configuration in this sense, but nevertheless requires additional
adaptations of the machine data (via SINUMERIK Operate) (Page 143).

See also
Viewing I/O addresses in the TIA Portal (Page 117)

Calling the telegram configuration (Page 122)

PROFIsafe/PROFIdrive telegrams for Safety Integrated plus (F-PLC) (Page 139)

Matching user-specific adaptations (Page 144)
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6.3 Viewing I/O addresses in the TIA Portal

Requirement
● An NCU has been inserted

● The project view is active

Procedure
To display a complete overview of the assigned I/O addresses, proceed as follows:

1. Click the PLC subcomponent on the NCU.

2. Click "Properties > General" in the inspector window and then click "Address overview" in
the sector tree.

Result
The Address overview is displayed:

You can view all I/O addresses in the address overview and filter them with the checkboxes to 
display Inputs, Outputs, Address gaps and Slots.

Note
I/O addresses cannot be changed in the address overview

If you want to change I/O addresses assigned in the TIA Portal, e.g. because insufficient 
suitable address space is available, you must switch to the properties of the peer (e.g. 
SINAMICS Integrated). There are several ways of switching to these properties:
● To jump directly to the configuration of a specific I/O address, right-click the appropriate line

in the Address overview and then select "Go to..." in the shortcut menu.
● Alternatively, click the appropriate component (SINAMICS Integrated or NX) for example in

the network view, then switch to "Properties > General > Telegram configuration" in the
inspector window.

Further information
Commissioning Manual, CNC Commissioning: NC, PLC, Drive, Section Communication 
between NC and drive.
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6.4 Changing the addressing schematic
The selected addressing schematic determines the principle according to which the I/O 
addresses of the telegrams are assigned by drive objects and influences the address range that 
is available for other purposes.

This addressing schematic is thus valid for the SINAMICS Integrated of the NCU as well as all 
NX modules. The addressing schematic is also assigned to NX modules that were connected 
retrospectively.

You can choose between two different I/O addressing schematics:

● Standard I/O addressing schematic

– Addressing schematic as familiar from SINUMERIK Toolbox for STEP 7 V5.x

– The available address range for diagnostic addresses or additional peripherals is divided 
up and available at the start and at the end of the overall address range.

– The I/O addresses of the telegrams are assigned in the middle of the address range and 
correspond to the presetting in the machine data.

● I/O addressing schematic optimized for I/O address extension

– Larger, coherent address range for diagnostic addresses or additional peripherals at the 
start of the overall address range.

– The telegram I/O addresses are assigned in descending order from the end of the overall 
address range and must be entered in the machine data (Page 143).
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Procedure
In order to change the schematic for the assignment of telegram I/O addresses of SINAMICS 
Integrated (and of all connected NX modules), proceed as follows:

1. Click the NCU in the network or device view and select the "Addressing schematic" entry in 
the "Properties" inspector window under "General".

2. Click the "Change addressing schematic" button.
The "Change I/O addressing schematic" dialog opens. If you select an option, the effects of 
the change are listed here.

3. Select the required I/O addressing schematic and confirm the reconfiguration with "Yes".

Result
The I/O addressing schematic was changed.

If you use the optimized I/O addressing schematic, you must additionally enter the I/O 
addresses in the machine data (Page 143) e.g. via SINUMERIK Operate.

If problems occur during the changeover, you can find further information in the "Info" inspector 
window at "General".
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6.5 Resetting telegrams
With the command "Reset telegrams" in the properties of SINAMICS Integrated (or an NX 
module), you can reset the telegram configuration of a device in the TIA Portal to the standard 
telegram configuration (Page 116).

When doing this, all telegrams in this device are deleted.

Note
Settings that deviate from the standard telegram configuration (e.g. additional telegrams) are 
deleted

If you reset the telegram configuration, settings that have been added retrospectively or user-
specific settings are lost (e.g. added drive objects, telegrams, or changed I/O addresses).

After resetting you can, of course, customize (Page 121) the telegram configuration again.

As long as the project has not been saved, you can undo the resetting of the telegrams together 
with the changed settings: Click "Undo" in the toolbar.

Procedure
In order to reset the telegram configuration of SINAMICS Integrated or an NX module, proceed 
as follows:

1. Select the device in the device view:

– To reset the telegrams of SINAMICS Integrated, select SINAMICS Integrated.

– To reset the telegrams of an NX, select the NX.

2. In the inspector window, click "Reset telegrams" under "Properties > General".

3. Click the "Reset telegrams" button and confirm the confirmation message with "Yes".

Result
The existing telegrams were deleted and the standard telegram configuration (Page 116) 
inserted.

As many drive objects (including appropriately configured telegrams) were automatically 
inserted as are supported by the corresponding SINAMICS Integrated or the NX module drives.
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6.6 Displaying or adapting the telegram configuration

6.6.1 Overview
You can call (Page 122) the telegram configuration in the properties of the specific device 
(SINAMICS Integrated or NX), and when required adapt to address the specific user 
requirements.

Features of a user-defined telegram configuration
A telegram configuration which differs from a standard telegram configuration (Page 116) due 
to adaptations of any kind is called a user-defined telegram configuration:

● Adapting the configured number of drives (Page 129)

● Other changes in the overview for telegram configuration (Page 122) or in the properties for
the send telegram (actual value) (Page 123) or receive telegram (setpoint value)
(Page 126):

– Adding or removing telegrams

– Adding telegram extensions

– Changing I/O start addresses

– Changing the telegram types used

Special issues to observe when configuring
If you wish to use a user-defined telegram configuration, you must ensure that the user-defined 
adaptations are consistent at two positions:

● TIA Portal project

● Machine data (via SINUMERIK Operate)

The user-defined telegram configuration is kept if you upgrade the firmware version of an NCU, 
or you replace either the NCU or the NX in the TIA Portal.

Reset to the standard telegram configuration
You can reset the telegram configuration in the TIA Portal back to the standard telegram 
configuration in the properties of the individual devices. 

A telegram configuration is only reset for the device involved, and must be separately carried 
out at the SINAMICS Integrated and connected NX modules.

A reset in the TIA Portal does not affect the machine data (in SINUMERIK Operate).

See also
Resetting telegrams (Page 120)
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6.6.2 Calling the telegram configuration
The telegram configuration is part of the device properties (SINAMICS Integrated or NX).

Procedure
Proceed as follows to display an overview of all configured telegrams:

1. Select the device in the device view:

– To display the telegram configuration of the SINAMICS Integrated of an NCU, select 
SINAMICS Integrated.

– To display the telegram configuration of an NX, select the NX.

2. In the inspector window, click "Telegram configuration" under "Properties > General".

Result
An overview of all of the telegrams configured on the device is displayed.

● Structure of the "Telegram configuration" dialog (Page 122)

When you click on one of the lower-level elements (e.g. "Send (actual value)"), you switch to the 
complete properties of the drive object or telegram.

● Changing the properties of receive telegrams (setpoint) (Page 126)

● Changing the properties of send telegrams (actual value) (Page 123)

See also
Adapting the number of drives (Page 129)

6.6.3 Structure of the "Telegram configuration" dialog
You can find an overview of all of the telegrams that are configured for the SINAMICS 
Integrated or an NX in the properties of the corresponding device under "Telegram 
configuration".

Figure 6-1 Telegram configuration based on the example of Drive_Axis_1 of a SINUMERIK 840D sl with Safety Integrated 
plus and standard I/O addressing scheme
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Column Description
 If applicable, yellow marking for identifying safety-oriented resources (Page 174).
Name Name of the drive object or telegram channel. Display of communication direction (send/

receive) and, if applicable, purpose, actual value/setpoint value.
Element Positioning the element in the telegram configuration.
Telegram Display or setting of the telegram type used. The standard setting (Page 116) depends 

on the NCU/NX device version and the Safety Integrated mode (Page 177) that is set.
The selectable telegram types depend on the purpose of the telegram (Page 130).

Length Length of the telegram in bytes or words. The telegram length depends on the telegram 
type used.

Extension Display of the extension of the relevant telegram in words or setting, if supported by the 
telegram type.

Direction Communication direction (setpoint/actual value direction)
Type Type of communication:

MS = Master-slave communication for PROFIBUS DP
F-MS = PROFIsafe-specific master-slave communication

Partner Name of the PLC assigned as communication partner.
Partner data 
area

I/O address range of the communication partner (PLC).
The Partner data area of a telegram (one each for actual value and setpoint) results from 
the I/O start address and the telegram length in bytes (1 word = 2 bytes).

6.6.4 Changing the properties of send telegrams (actual value)
In the telegram properties "Send (actual value)" or "Send safety telegram (actual value)", all 
configurable properties of the corresponding object are displayed.

You can edit the parameters for the actual values of the communication between the drive and 
the controller. The communication direction is from the drive to the partner.

The settings relevant for PROFIsafe are marked in yellow and are only displayed if SINUMERIK 
Safety Integrated plus is active and a PROFIsafe telegram has been selected. 

WARNING

Checking the PROFIsafe telegrams

The setting of the PROFIsafe telegrams under "Telegram configuration" is not password-
protected. If you are working with PROFIsafe telegrams, re-check the setting of the 
PROFIsafe telegrams over the course of the safety acceptance inspection to be sure that the 
selected PROFIsafe telegram corresponds to the requirements of your application.
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Figure 6-2 Telegram properties - Send (actual value) based on the example of SIEMENS telegram 136

Table 6-1 Parameters of the properties "Send (actual value)" or "Send safety telegram (actual value)"

Parameter Drive Control system
Name Name of the drive in the project Name of the assigned PLC.
Role Slave Master
PROFIBUS address PROFIBUS address of the slave PROFIBUS address of the master
Telegram Display or setting of the telegram type used. The standard setting (Page 116) 

depends on the NCU/NX device version and the Safety Integrated mode 
(Page 177) that is set. The selectable telegram types depend on the purpose of the 
telegram.
● Telegrams for PROFIdrive communication (Page 130)
● PROFIsafe telegrams (Page 131)
● Additional PROFIdrive telegrams for Safety Integrated plus (F-PLC) (Page 132)
● Additional PROFIdrive telegrams for Safety Integrated (SPL) (Page 131)

Telegram (PROFIsafe)

F address
(only PROFIsafe)

PROFIsafe address of the destina‐
tion (F_Dest_Add). The address is 
used for clear identification of the 
destination.

PROFIsafe address of the source 
(F_Source_Add). The address is used for 
clear identification of the source.

Slot Slot in the device -
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Parameter Drive Control system
Start address Display of the process data word 

(PZD)
Currently set start address for the configured 
module. You can accept or change the ad‐
dress.
If you change the start address for an actual 
value, the start address is also adapted for the 
setpoint.
Only PROFIsafe: The start address is part of 
the F-I/O DB-name of this telegram. If you 
change the start address, the F-I/O DB-num‐
ber will also be changed.

Length Length of the telegram in bytes or words. The telegram length depends on the 
telegram type used.

Extension Display of the extension of the relevant telegram in words or setting, if supported by 
the telegram type.

Consistency The use of various consistency areas is useful to optimize the performance of an 
S7-CPU. Consistency areas that are longer than two words must be edited with 
system functions. You can use the effective Load/Transfer commands for consis‐
tency areas up to two words.
Total length: 
The consistency applies for all data of this slot. This default entry should usually be 
sufficient.
Unit: 
The consistency applies for one process data word.
You must configure at least a "2" word "Total length" for the transfer of a double 
word.

Process image Display of the process image (partition), which is used to consistently transfer the 
data.

Interrupt OB number Specification of the interrupt OB number for the output of diagnostic information.
Manual assignment of the F-Watchdog 
time
(only PROFIsafe)

If this option is activated, you have the capability of assigning the F-monitoring time 
manually. Otherwise the F-monitoring time will be assigned according to the global 
parameterization at the interface (DP interface > F-parameters).

F-monitoring time
(only PROFIsafe)

Monitoring time in the fail-safe DP standard slave/IO standard device/PA field de‐
vice.
A valid, current safety telegram must arrive from the F-CPU within the monitoring 
time. This ensures that failures and errors are detected and the appropriate reac‐
tions triggered to keep the safety system in a safe state or to transfer it to a safe 
state.

Manual assignment of the F-I/O DB 
number
(only PROFIsafe)

If this option is activated, you have the capability of assigning the F-I/O DB-number 
manually. Otherwise it is assigned by the F system.
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Parameter Drive Control system
F-I/O DB number
(only PROFIsafe)

Here you assign a number for the F-I/O DB.
The adjustable value range depends upon the value range for DBs set in the Safety 
Administration Editor (area "Settings > Assign numbers for F-system blocks"), or is 
automatically managed by the F-system.

F-I/O DB name
(only PROFIsafe)

The name of the F-I/O DB is displayed here.
The start address is part of the F-I/O DB-name of this telegram. If you change the 
start address, the F-I/O DB-number will also be changed.
The F-I/O DBs are located at the following point in the project navigation: "Con‐
troller (e.g. CNC_1 > PLC 1) > Program blocks > System blocks > STEP 7 Safety 
> F-I/O DBs"

6.6.5 Changing the properties of receive telegrams (setpoint)
In the telegram properties "Receive (setpoint)" or "Receive safety telegram (setpoint)", all 
configurable properties of the corresponding object are displayed.

You can edit the parameters for the setpoints of the communication between the drive and the 
controller. The communication direction is from the partner to the drive.

The settings relevant for PROFIsafe are marked in yellow and are only displayed if SINUMERIK 
Safety Integrated plus is active and a PROFIsafe telegram has been selected. 

WARNING

Checking the PROFIsafe telegrams

The setting of the PROFIsafe telegrams under "Telegram configuration" is not password-
protected. If you are working with PROFIsafe telegrams, re-check the setting of the 
PROFIsafe telegrams over the course of the safety acceptance inspection to be sure that the 
selected PROFIsafe telegram corresponds to the requirements of your application.
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Figure 6-3 Telegram properties - Receive (setpoint value) based on the example of SIEMENS telegram 136

Table 6-2 Parameters of the properties "Receive (setpoint value)" or "Receive safety telegram (setpoint value)"

Parameter Drive Control system
Name Name of the drive in the project Name of the assigned PLC.
Role Slave Master
PROFIBUS address PROFIBUS address of the slave PROFIBUS address of the master (can‐

not be changed).
Telegram Display or setting of the telegram type used. The standard setting (Page 116) 

depends on the NCU/NX device version and the Safety Integrated mode 
(Page 177) that is set. The selectable telegram types depend on the purpose of the 
telegram.
● Telegrams for PROFIdrive communication (Page 130)
● PROFIsafe telegrams (Page 131)
● Additional PROFIdrive telegrams for Safety Integrated plus (F-PLC) (Page 132)
● Additional PROFIdrive telegrams for Safety Integrated (SPL) (Page 131)

Telegram (PROFIsafe)

F address
(only PROFIsafe)

PROFIsafe address of the destination 
(F_Dest_Add)

PROFIsafe address of the source 
(F_Source_Add)

Slot Slot in the device -
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Parameter Drive Control system
Start address Display of the process data word (PZD) The currently set start address for the 

configured module that you can accept 
or change.
If you change the start address for a set‐
point value, the start address is also 
adapted for the actual value.
Only PROFIsafe: The start address is 
part of the F-I/O DB-name of this tele‐
gram. If you change the start address, 
the F-I/O DB-number will also be 
changed.

Length Length of the telegram in bytes or words. The telegram length depends on the 
telegram type used.

Extension Display of the extension of the relevant telegram in words or setting, if supported by 
the telegram type.

Consistency The use of various consistency areas is useful to optimize the performance of an 
S7-CPU. Consistency areas that are longer than two words must be edited with 
system functions. You can use the effective Load/Transfer commands for consis‐
tency areas up to two words.
Total length: 
The consistency applies for all data of this slot. This default entry should usually be 
sufficient.
Unit: 
The consistency applies for one process data word.
You must configure at least a "2" word "Total length" for the transfer of a double 
word.

Process image Display of the process image (partition), which is used to consistently transfer the 
data.

Interrupt OB number Specification of the interrupt OB number for the output of diagnostic information.
Manual assignment of the F-Watchdog 
time
(only PROFIsafe)

If this option is activated, you have the capability of assigning the F-monitoring time 
manually. Otherwise the F-monitoring time will be assigned according to the global 
parameterization at the interface (DP interface > F-parameters).

F-monitoring time
(only PROFIsafe)

Monitoring time in the fail-safe DP standard slave/IO standard device/PA field de‐
vice.
A valid, current safety telegram must arrive from the F-CPU within the monitoring 
time. This ensures that failures and errors are detected and the appropriate reac‐
tions triggered to keep the safety system in a safe state or to transfer it to a safe 
state.

Manual assignment of the F-I/O DB 
number
(only PROFIsafe)

If this option is activated, you have the capability of assigning the F-I/O DB-number 
manually. Otherwise it is assigned by the F system.
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Parameter Drive Control system
F-I/O DB number
(only PROFIsafe)

Here you assign a number for the F-I/O DB.
The adjustable value range depends upon the value range for DBs set in the Safety 
Administration Editor (area "Settings > Assign numbers for F-system blocks"), or is 
automatically managed by the F-system.

F-I/O DB name
(only PROFIsafe)

The name of the F-I/O DB is displayed here.
The start address is part of the F-I/O DB-name of this telegram. If you change the 
start address, the F-I/O DB-number will also be changed.
The F-I/O DBs are located at the following point in the project navigation: "Con‐
troller (e.g. CNC_1 > PLC 1) > Program blocks > System blocks > STEP 7 Safety 
> F-I/O DBs"

6.6.6 Adapting the number of drives
When an NCU or NX module is inserted, the appropriate number of drive objects (incl. 
appropriate configured telegrams) that the associated NCU or NX module supports are 
inserted automatically. These standard settings correspond to the standard settings in the NCK 
(e.g. configurable via SINUMERIK Operate).

Even if you use fewer than the maximum number of drives of an appropriate NCU or NX 
module, you do not need to make any changes here.

If, however, for specific reasons, you make adaptations, you must make them both in the TIA 
Portal for the PLC and for the NCK (e.g. via SINUMERIK Operate).

Information concerning the commissioning of SINUMERIK Operate is contained in the Base 
Software and Operating Software Commissioning Manual.

Procedure
Proceed as follows to adapt the number of drives:

1. Select the device in the device view:

– To configure the drive objects of the SINAMICS Integrated of an NCU, select SINAMICS
Integrated.

– To configure the drive objects of an NX, select the NX.

2. In the inspector window, click "Telegram configuration" under "Properties > General".

3. You can delete and add drive objects or add individual telegrams under "Telegram
configuration".

– To delete a drive object, right-click the drive object and select "Delete" in the shortcut
menu.

– To add a drive object, click the "<Add new drive object>" command in the "Name"
column.

– To add a user-defined telegram, click the "<Add new telegram>" command in the "Name"
column of the associated drive object.
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6.7 Available telegram types

6.7.1 Telegrams for the transfer of standard data (PROFIdrive)
The standard telegram configuration (Page 116) of a SINUMERIK NCU uses the following 
telegram types for PROFIdrive communication (standard data):

Table 6-3 Telegrams for PROFIdrive communication

Compatible 
drive objects

Designation Purpose

DriveAxis‐
XY (in SI‐
NAMICS In‐
tegrated)
DO SERVO 
(in ext. drive 
unit)

SIEMENS telegram 136 Manufacturer-specific telegram.
Permits the use of the following data:
● Dynamic Servo Control (DSC)
● Torque feedforward control
● 2 position encoders (encoder 1 and encoder 2)
● 4 trace signals
Process image: PIP NCK
Isochronous mode: Activated

DriveCU01 
(in SINAM‐
ICS Integra‐
ted)
DO Control 
Unit (in ext. 
drive unit)

SIEMENS telegram 390 Manufacturer-specific telegram for PROFIdrive communication.
Permits the use of the following data:
● Access to onboard I/O of the CU
● Use of the control and status word of the CU (CU_STW, CU_ZSW)
This telegram is used by NX modules for PROFIdrive communication.
Process image: PIP NCK
Isochronous mode: Activated

SIEMENS telegram 391 Manufacturer-specific telegram for PROFIdrive communication.
Permits the use of the following data:
● Access to onboard I/O of the CU
● Use of the control and status word of the CU (CU_STW, CU_ZSW)
● Central measuring probe evaluation of up to 2 probes
This telegram is used by the NCU for PROFIdrive communication between NC
and DRIVE.
Process image: PIP NCK
Isochronous mode: Activated

Infeed01 (in 
SINAMICS 
Integrated)
DO infeed 
(in ext. drive 
unit)

SIEMENS telegram 370 Manufacturer-specific telegram for communication of the infeed (Infeed / Active 
Infeed (A_INF)).
Process image: Automatic update
Isochronous mode: cannot be set

For the purpose of implementing a user-defined telegram configuration (Page 121), you can 
also configure other telegram types for transferring standard data.
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Further information
You will find a brief description of all configurable telegram types in the TIA Portal in the tooltip 
for the telegram. Detailed information can be found in the respective function block diagrams 
in the SINAMICS S120/S150 List Manual (https://support.industry.siemens.com/cs/document/
109739998/).

Telegram Function diagram
1…9 2415
20…83 2416
102…116 2419
118…166 2420
220…371 2421
390…396 2422

6.7.2 Telegrams in SINUMERIK Safety Integrated (SPL) mode
The standard telegram configuration (Page 116) of a SINUMERIK NCU with Safety Integrated 
plus (SPL) uses the "SI Motion Monitoring" telegram for safety-oriented communication. This 
telegram is also available with inactive safety mode in the configuration, but is then not used.

Table 6-4 Telegrams for SINUMERIK Safety Integrated (SPL)

Profile Designation Purpose
PROFIdrive SI Motion Monitoring Safety-related communication (SPL) in SINUMERIK Safety 

Integrated (SPL) mode.

See also
SINAMICS S120/S150 List Manual (https://support.industry.siemens.com/cs/document/
109739998/)

6.7.3 Telegrams for PROFIsafe communication
The standard telegram configuration (Page 116) of a SINUMERIK NCU with Safety Integrated 
plus (F-PLC) uses the following telegram types for PROFIsafe communication:
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Table 6-5 Telegrams for controlling via PROFIdrive/PROFIsafe

Compatible drive objects Designation Purpose
DriveAxisXY (in SINAM‐
ICS Integrated)
DO SERVO (in ext. drive 
unit)

SIEMENS telegram 902 Extended manufacturer-specific telegram with 32-bit position 
value.
Process image: none
Isochronous mode: cannot be set

SIEMENS telegram 903 Extended manufacturer-specific telegram with 32-bit Safe 
Cam (S_ZSW_CAM1).
Default setting for internal NC drives.
Process image: none
Isochronous mode: cannot be set

For the purpose of implementing a user-defined telegram configuration (Page 121), you can 
also configure other telegram types for PROFIsafe communication.

Further information
You will find a brief description of all configurable telegram types in the TIA Portal in the tooltip 
for the telegram. Detailed information can be found in the respective function block diagrams 
in the SINAMICS S120/S150 List Manual (https://support.industry.siemens.com/cs/document/
109739998/).

Telegram Function diagram
30…31 2915
901…903 2916

6.7.4 Telegrams for SIC/SCC communication
The standard telegram configuration (Page 116) of a SINUMERIK NCU with Safety Integrated 
plus (F-PLC) uses the following telegram types for SIC/SCC communication:

Table 6-6 Telegrams for controlling via SIC/SCC (PROFIdrive)

Compatible drive objects Designation Purpose
DriveAxisXY (in SINAM‐
ICS Integrated)
DO SERVO (in ext. drive 
unit)

SIEMENS telegram 701 Manufacturer-specific telegram for SIC/SCC communication.
With SINUMERIK, SIC/SCC communication only takes place 
via telegram 701.
Process image: PIP NCK
Isochronous mode: Activated

For the purpose of implementing a user-defined telegram configuration (Page 121), you can 
also configure telegram 700.

Further information
You will find a brief description of all configurable telegram types in the TIA Portal in the tooltip 
for the telegram. Detailed information can be found in the respective function block diagrams 
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in the SINAMICS S120/S150 List Manual (https://support.industry.siemens.com/cs/document/
109739998/).

Telegram Function diagram
700…701 2423
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6.8 Adapting I/O start addresses

6.8.1 Introduction

Telegram configuration and I/O addressing schematics
The I/O addresses of the NX and SINAMICS Integrated components for communication 
between the NCU and the drive are entered in the TIA Portal and in the machine data of the 
NCU.

In order that the I/O addresses match in the TIA Portal and in the machine data of the NCU, they 
are identical by default and correspond to the standard I/O addressing schematic.

If you use the expanded I/O addressing schematic or have made user-specific adjustments to 
the telegram configuration, you must synchronize these I/O addresses between TIA Portal and 
machine data.

Telegrams used by default
● Which telegrams are used by default depends on the SINUMERIK Safety Integrated mode.

● Which I/O start addresses are assigned to the telegrams by default depends on the I/O
addressing schematic used.

● The Partner data area of a telegram (one each for actual value and setpoint) results from the
I/O start address and the telegram length in bytes (1 WORD = 2 bytes). The telegram length
depends on the telegram type used.

Table 6-7 Telegrams used by default in the safety modes

Designation Partner data area Used in mode
Actual val‐
ue

Setpoint

SIEMENS Telegramm 136 19 Words 15 Words These telegrams transfer standard data 
and are used in all safety modes:
● Inactive safety functionality
● Safety Integrated (SPL)
● Safety Integrated plus (F-PLC)

SIEMENS Telegramm 390 2 Words 2 Words
SIEMENS Telegramm 391 7 Words 3 Words
SIEMENS Telegramm 370 1 Words 1 Words

SI Motion Monitoring 12 Words 12 Words ● Safety Integrated (SPL)
Comment: This telegram is also available 
with inactive safety mode in the telegram 
configuration, but is then not used.

SIEMENS Telegramm 903 14 Bytes 14 Bytes ● Safety Integrated plus (F-PLC)

SIEMENS Telegramm 701 5 Words 2 Words ● Safety Integrated plus (F-PLC)
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machine data to be configured
You must adapt the following machine data if you do not use the default I/O addressing 
schematic:

● MD10393 $MN_SAFE_DRIVE_LOGIC_ADDRESS

● MD13050 $MN_DRIVE_LOGIC_ADDRESS

Specific information on the individual machine data can be found in the online help of 
SINUMERIK Operate.

The following tables show the machine data (MD) of the NCU in which a specific I/O start 
address is entered.

See also
Viewing I/O addresses in the TIA Portal (Page 117)

Calling the telegram configuration (Page 122)

PROFIsafe/PROFIdrive telegrams for Safety Integrated plus (F-PLC) (Page 139)

Matching user-specific adaptations (Page 144)

6.8.2 PROFIdrive telegrams for standard data

Table 6-8 SINAMICS Integrated: I/O addresses of PROFIdrive telegrams

Drive Telegram type I/O address Machine data
Standard addressing 
schematic

Optimized addressing 
schematic

Drive_Axis_1 SIEMENS telegram 136 4100 15700 13050[0]
Drive_Axis_2 SIEMENS telegram 136 4140 15620 13050[1]
Drive_Axis_3 SIEMENS telegram 136 4180 15540 13050[2]
Drive_Axis_4 SIEMENS telegram 136 4220 15460 13050[3]
Drive_Axis_5 SIEMENS telegram 136 4260 15380 13050[4]
Drive_Axis_6 SIEMENS telegram 136 4300 15300 13050[5]
Drive_CU_1 SIEMENS telegram 391 6500 15780  
Infeed_1 SIEMENS telegram 370 6514 15830  

Table 6-9 NX on DRIVE-CLiQ socket X105; DP address 15: I/O addresses of PROFIdrive telegrams

Drive Telegram type I/O address Machine data
Standard addressing 
schematic

Optimized addressing 
schematic

Drive_Axis_1 SIEMENS telegram 136 4340 15150 13050[6]
Drive_Axis_2 SIEMENS telegram 136 4380 15070 13050[7]
Drive_Axis_3 SIEMENS telegram 136 4420 14990 13050[8]
Drive_Axis_4 SIEMENS telegram 136 4460 14910 13050[9]
Drive_Axis_5 SIEMENS telegram 136 4500 14830 13050[10]
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Drive Telegram type I/O address Machine data
Standard addressing 
schematic

Optimized addressing 
schematic

Drive_Axis_6 SIEMENS telegram 136 4540 14750 13050[11]
Drive_CU_1 SIEMENS telegram 390 6530 15230  
Infeed_1 SIEMENS telegram 370 6534 15280  

Table 6-10 NX on DRIVE-CLiQ socket X104; DP address 14: I/O addresses of PROFIdrive telegrams

Drive Telegram type I/O address Machine data
Standard addressing 
schematic

Optimized addressing 
schematic

Drive_Axis_1 SIEMENS telegram 136 4580 14600 13050[12]
Drive_Axis_2 SIEMENS telegram 136 4620 14520 13050[13]
Drive_Axis_3 SIEMENS telegram 136 4660 14440 13050[14]
Drive_Axis_4 SIEMENS telegram 136 4700 14360 13050[15]
Drive_Axis_5 SIEMENS telegram 136 4740 14280 13050[16]
Drive_Axis_6 SIEMENS telegram 136 4780 14200 13050[17]
Drive_CU_1 SIEMENS telegram 390 6560 14680  
Infeed_1 SIEMENS telegram 370 6554 14730  

Table 6-11 NX on DRIVE-CLiQ socket X103; DP address 13: I/O addresses of PROFIdrive telegrams

Drive Telegram type I/O address Machine data
Standard addressing 
schematic

Optimized addressing 
schematic

Drive_Axis_1 SIEMENS telegram 136 4820 14050 13050[18]
Drive_Axis_2 SIEMENS telegram 136 4860 13970 13050[19]
Drive_Axis_3 SIEMENS telegram 136 4900 13890 13050[20]
Drive_Axis_4 SIEMENS telegram 136 4940 13810 13050[21]
Drive_Axis_5 SIEMENS telegram 136 4980 13730 13050[22]
Drive_Axis_6 SIEMENS telegram 136 5020 13650 13050[23]
Drive_CU_1 SIEMENS telegram 390 6590 14130  
Infeed_1 SIEMENS telegram 370 6574 14180  

Table 6-12 NX on DRIVE-CLiQ socket X102; DP address 12: I/O addresses of PROFIdrive telegrams

Drive Telegram type I/O address Machine data
Standard addressing 
schematic

Optimized addressing 
schematic

Drive_Axis_1 SIEMENS telegram 136 5060 13500 13050[24]
Drive_Axis_2 SIEMENS telegram 136 5100 13420 13050[25]
Drive_Axis_3 SIEMENS telegram 136 5140 13340 13050[26]
Drive_Axis_4 SIEMENS telegram 136 5180 13260 13050[27]
Drive_Axis_5 SIEMENS telegram 136 5220 13180 13050[28]
Drive_Axis_6 SIEMENS telegram 136 5260 13100 13050[29]
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Drive Telegram type I/O address Machine data
Standard addressing 
schematic

Optimized addressing 
schematic

Drive_CU_1 SIEMENS telegram 390 6620 13580  
Infeed_1 SIEMENS telegram 370 6594 13630  

Table 6-13 NX on DRIVE-CLiQ socket X101; DP address 11: I/O addresses of PROFIdrive telegrams

Drive Telegram type I/O address Machine data
Standard addressing 
schematic

Optimized addressing 
schematic

Drive_Axis_1 SIEMENS telegram 136 5300 12950 13050[30]
Drive_Axis_2 SIEMENS telegram 136 5340 12870 13050[31]
Drive_Axis_3 SIEMENS telegram 136 5380 12790 13050[32]
Drive_Axis_4 SIEMENS telegram 136 5420 12710 13050[33]
Drive_Axis_5 SIEMENS telegram 136 5460 12630 13050[34]
Drive_Axis_6 SIEMENS telegram 136 5500 12550 13050[35]
Drive_CU_1 SIEMENS telegram 390 6650 13030  
Infeed_1 SIEMENS telegram 370 6614 13080  

Table 6-14 NX on DRIVE-CLiQ socket X100; DP address 10: I/O addresses of PROFIdrive telegrams

Drive Telegram type I/O address Machine data
Standard addressing 
schematic

Optimized addressing 
schematic

Drive_Axis_1 SIEMENS telegram 136 5540 12400 13050[36]
Drive_Axis_2 SIEMENS telegram 136 5580 12320 13050[37]
Drive_Axis_3 SIEMENS telegram 136 5620 12240 13050[38]
Drive_Axis_4 SIEMENS telegram 136 5660 12160 13050[39]
Drive_Axis_5 SIEMENS telegram 136 5700 12080 13050[40]
Drive_Axis_6 SIEMENS telegram 136 5740 12000 13050[41]
Drive_CU_1 SIEMENS telegram 390 6680 12480  
Infeed_1 SIEMENS telegram 370 6634 12530  

6.8.3 PROFIdrive telegrams for Safety Integrated (SPL)

Table 6-15 SINAMICS Integrated: I/O addresses of telegram SI Motion Monitoring

Drive Telegram type I/O address Machine data
Standard addressing sche‐
matic

Optimized address‐
ing schematic

Drive_Axis_1 SI Motion Monitoring 6700 15756 10393[0]
Drive_Axis_2 SI Motion Monitoring 6724 15676 10393[1]
Drive_Axis_3 SI Motion Monitoring 6748 15596 10393[2]
Drive_Axis_4 SI Motion Monitoring 6772 15516 10393[3]
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Drive Telegram type I/O address Machine data
Standard addressing sche‐
matic

Optimized address‐
ing schematic

Drive_Axis_5 SI Motion Monitoring 6796 15436 10393[4]
Drive_Axis_6 SI Motion Monitoring 6820 15356 10393[5]

Table 6-16 NX on DRIVE-CLiQ socket X105; DP address 15: I/O addresses of telegram SI Motion Monitoring

Drive Telegram type I/O address Machine data
Standard addressing sche‐
matic

Optimized address‐
ing schematic

Drive_Axis_1 SI Motion Monitoring 6844 15206 10393[6]
Drive_Axis_2 SI Motion Monitoring 6868 15126 10393[7]
Drive_Axis_3 SI Motion Monitoring 6892 15046 10393[8]
Drive_Axis_4 SI Motion Monitoring 6916 14966 10393[9]
Drive_Axis_5 SI Motion Monitoring 6940 14886 10393[10]
Drive_Axis_6 SI Motion Monitoring 6964 14806 10393[11]

Table 6-17 NX on DRIVE-CLiQ socket X104; DP address 14: I/O addresses of telegram SI Motion Monitoring

Drive Telegram type I/O address Machine data
Standard addressing sche‐
matic

Optimized address‐
ing schematic

Drive_Axis_1 SI Motion Monitoring 6988 14656 10393[12]
Drive_Axis_2 SI Motion Monitoring 7012 14576 10393[13]
Drive_Axis_3 SI Motion Monitoring 7036 14496 10393[14]
Drive_Axis_4 SI Motion Monitoring 7060 14416 10393[15]
Drive_Axis_5 SI Motion Monitoring 7084 14336 10393[16]
Drive_Axis_6 SI Motion Monitoring 7108 14256 10393[17]

Table 6-18 NX on DRIVE-CLiQ socket X103; DP address 13: I/O addresses of telegram SI Motion Monitoring

Drive Telegram type I/O address Machine data
Standard addressing sche‐
matic

Optimized address‐
ing schematic

Drive_Axis_1 SI Motion Monitoring 7132 14106 10393[18]
Drive_Axis_2 SI Motion Monitoring 7156 14026 10393[19]
Drive_Axis_3 SI Motion Monitoring 7180 13946 10393[20]
Drive_Axis_4 SI Motion Monitoring 7204 13866 10393[21]
Drive_Axis_5 SI Motion Monitoring 7228 13786 10393[22]
Drive_Axis_6 SI Motion Monitoring 7252 13706 10393[23]
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Table 6-19 NX on DRIVE-CLiQ socket X102; DP address 12: I/O addresses of telegram SI Motion Monitoring

Drive Telegram type I/O address Machine data
Standard addressing sche‐
matic

Optimized address‐
ing schematic

Drive_Axis_1 SI Motion Monitoring 7276 13556 10393[24]
Drive_Axis_2 SI Motion Monitoring 7300 13476 10393[25]
Drive_Axis_3 SI Motion Monitoring 7324 13396 10393[26]
Drive_Axis_4 SI Motion Monitoring 7348 13316 10393[27]
Drive_Axis_5 SI Motion Monitoring 7372 13236 10393[28]
Drive_Axis_6 SI Motion Monitoring 7396 13156 10393[29]

Table 6-20 NX on DRIVE-CLiQ socket X101; DP address 11: I/O addresses of telegram SI Motion Monitoring

Drive Telegram type I/O address Machine data
Standard addressing sche‐
matic

Optimized address‐
ing schematic

Drive_Axis_1 SI Motion Monitoring 7420 13006 10393[30]
Drive_Axis_2 SI Motion Monitoring 7444 12926 10393[31]
Drive_Axis_3 SI Motion Monitoring 7468 12846 10393[32]
Drive_Axis_4 SI Motion Monitoring 7492 12766 10393[33]
Drive_Axis_5 SI Motion Monitoring 7516 12686 10393[34]
Drive_Axis_6 SI Motion Monitoring 7540 12606 10393[35]

Table 6-21 NX on DRIVE-CLiQ socket X100; DP address 10: I/O addresses of telegram SI Motion Monitoring

Drive Telegram type I/O address Machine data
Standard addressing sche‐
matic

Optimized address‐
ing schematic

Drive_Axis_1 SI Motion Monitoring 7564 12456 10393[36]
Drive_Axis_2 SI Motion Monitoring 7588 12376 10393[37]
Drive_Axis_3 SI Motion Monitoring 7612 12296 10393[38]
Drive_Axis_4 SI Motion Monitoring 7636 12216 10393[39]
Drive_Axis_5 SI Motion Monitoring 7660 12136 10393[40]
Drive_Axis_6 SI Motion Monitoring 7684 12056 10393[41]

6.8.4 PROFIsafe/PROFIdrive telegrams for Safety Integrated plus (F-PLC)

Table 6-22 SINAMICS Integrated: I/O addresses of PROFIsafe/PROFIdrive telegrams

Drive Telegram type I/O start address Machine data
Standard addressing 
schematic

Optimized address‐
ing schematic

Drive_Axis_1 SIEMENS telegram 701 5800 15756 13374[0]
SIEMENS telegram 903 1008 13372[0]
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Drive Telegram type I/O start address Machine data
Standard addressing 
schematic

Optimized address‐
ing schematic

Drive_Axis_2 SIEMENS telegram 701 5816 15676 13374[1]
SIEMENS telegram 903 992 13372[1]

Drive_Axis_3 SIEMENS telegram 701 5832 15596 13374[2]
SIEMENS telegram 903 976 13372[2]

Drive_Axis_4 SIEMENS telegram 701 5848 15516 13374[3]
SIEMENS telegram 903 960 13372[3]

Drive_Axis_5 SIEMENS telegram 701 5864 15436 13374[4]
SIEMENS telegram 903 944 13372[4]

Drive_Axis_6 SIEMENS telegram 701 5880 15356 13374[5]
SIEMENS telegram 903 928 13372[5]

Table 6-23 NX on DRIVE-CLiQ socket X105; DP address 15: I/O addresses of PROFIsafe/PROFIdrive telegrams

Drive Telegram type I/O start address Machine data
Standard addressing 
schematic

Optimized address‐
ing schematic

Drive_Axis_1 SIEMENS telegram 701 5896 15206 13374[6]
SIEMENS telegram 903 912 13372[6]

Drive_Axis_2 SIEMENS telegram 701 5912 15126 13374[7]
SIEMENS telegram 903 896 13372[7]

Drive_Axis_3 SIEMENS telegram 701 5928 15046 13374[8]
SIEMENS telegram 903 880 13372[8]

Drive_Axis_4 SIEMENS telegram 701 5944 14966 13374[9]
SIEMENS telegram 903 864 13372[9]

Drive_Axis_5 SIEMENS telegram 701 5960 14886 13374[10]
SIEMENS telegram 903 848 13372[10]

Drive_Axis_6 SIEMENS telegram 701 5976 14806 13374[11]
SIEMENS telegram 903 832 13372[11]

Table 6-24 NX on DRIVE-CLiQ socket X104; DP address 14: I/O addresses of PROFIsafe/PROFIdrive telegrams

Drive Telegram type I/O start address Machine data
Standard addressing 
schematic

Optimized address‐
ing schematic

Drive_Axis_1 SIEMENS telegram 701 5992 14656 13374[12]
SIEMENS telegram 903 816 13372[12]

Drive_Axis_2 SIEMENS telegram 701 6008 14576 13374[13]
SIEMENS telegram 903 800 13372[13]

Drive_Axis_3 SIEMENS telegram 701 6024 14496 13374[14]
SIEMENS telegram 903 784 13372[14]

Drive_Axis_4 SIEMENS telegram 701 6040 14416 13374[15]
SIEMENS telegram 903 768 13372[15]
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Drive Telegram type I/O start address Machine data
Standard addressing 
schematic

Optimized address‐
ing schematic

Drive_Axis_5 SIEMENS telegram 701 6056 14336 13374[16]
SIEMENS telegram 903 752 13372[16]

Drive_Axis_6 SIEMENS telegram 701 6072 14256 13374[17]
SIEMENS telegram 903 736 13372[17]

Table 6-25 NX on DRIVE-CLiQ socket X103; DP address 13: I/O addresses of PROFIsafe/PROFIdrive telegrams

Drive Telegram type I/O start address Machine data
Standard addressing 
schematic

Optimized address‐
ing schematic

Drive_Axis_1 SIEMENS telegram 701 6088 14106 13374[18]
SIEMENS telegram 903 720 13372[18]

Drive_Axis_2 SIEMENS telegram 701 6104 14026 13374[19]
SIEMENS telegram 903 704 13372[19]

Drive_Axis_3 SIEMENS telegram 701 6120 13946 13374[20]
SIEMENS telegram 903 688 13372[20]

Drive_Axis_4 SIEMENS telegram 701 6136 13866 13374[21]
SIEMENS telegram 903 672 13372[21]

Drive_Axis_5 SIEMENS telegram 701 6152 13786 13374[22]
SIEMENS telegram 903 656 13372[22]

Drive_Axis_6 SIEMENS telegram 701 6168 13706 13374[23]
SIEMENS telegram 903 640 13372[23]

Table 6-26 NX on DRIVE-CLiQ socket X102; DP address 12: I/O addresses of PROFIsafe/PROFIdrive telegrams

Drive Telegram type I/O start address Machine data
Standard addressing 
schematic

Optimized address‐
ing schematic

Drive_Axis_1 SIEMENS telegram 701 6184 13556 13374[24]
SIEMENS telegram 903 624 13372[24]

Drive_Axis_2 SIEMENS telegram 701 6200 13476 13374[25]
SIEMENS telegram 903 608 13372[25]

Drive_Axis_3 SIEMENS telegram 701 6216 13396 13374[26]
SIEMENS telegram 903 592 13372[26]

Drive_Axis_4 SIEMENS telegram 701 6232 13316 13374[27]
SIEMENS telegram 903 576 13372[27]

Drive_Axis_5 SIEMENS telegram 701 6248 13236 13374[28]
SIEMENS telegram 903 560 13372[28]

Drive_Axis_6 SIEMENS telegram 701 6264 13156 13374[29]
SIEMENS telegram 903 544 13372[29]
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Table 6-27 NX on DRIVE-CLiQ socket X101; DP address 11: I/O addresses of PROFIsafe/PROFIdrive telegrams

Drive Telegram type I/O start address Machine data
Standard addressing 
schematic

Optimized address‐
ing schematic

Drive_Axis_1 SIEMENS telegram 701 6280 13006 13374[30]
SIEMENS telegram 903 528 13372[30]

Drive_Axis_2 SIEMENS telegram 701 6296 12926 13374[31]
SIEMENS telegram 903 512 13372[31]

Drive_Axis_3 SIEMENS telegram 701 6312 12846 13374[32]
SIEMENS telegram 903 496 13372[32]

Drive_Axis_4 SIEMENS telegram 701 6328 12766 13374[33]
SIEMENS telegram 903 480 13372[33]

Drive_Axis_5 SIEMENS telegram 701 6344 12686 13374[34]
SIEMENS telegram 903 464 13372[34]

Drive_Axis_6 SIEMENS telegram 701 6360 12606 13374[35]
SIEMENS telegram 903 448 13372[35]

Table 6-28 NX on DRIVE-CLiQ socket X100; DP address 10: I/O addresses of PROFIsafe/PROFIdrive telegrams

Drive Telegram type I/O start address Machine data
Standard addressing 
schematic

Optimized address‐
ing schematic

Drive_Axis_1 SIEMENS telegram 701 6376 12456 13374[36]
SIEMENS telegram 903 432 13372[36]

Drive_Axis_2 SIEMENS telegram 701 6392 12376 13374[37]
SIEMENS telegram 903 416 13372[37]

Drive_Axis_3 SIEMENS telegram 701 6408 12296 13374[38]
SIEMENS telegram 903 400 13372[38]

Drive_Axis_4 SIEMENS telegram 701 6424 12216 13374[39]
SIEMENS telegram 903 384 13372[39]

Drive_Axis_5 SIEMENS telegram 701 6440 12136 13374[40]
SIEMENS telegram 903 368 13372[40]

Drive_Axis_6 SIEMENS telegram 701 6456 12056 13374[41]
SIEMENS telegram 903 352 13372[41]
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6.9 Deviations from the standard I/O addressing schematic

6.9.1 Overview

Use of user-specific adaptations of an addressing schematic
In some cases when configuring in the TIA Portal, the preset default I/O addresses for the 
communication with the drive have already been assigned, e.g.:

● If you added telegrams that are not part of the default telegram configuration.

● If you have subsequently changed the size of the process image.

● If you have subsequently changed the Safety Integrated mode.

● If you have subsequently added NX modules.

A message is then displayed in the TIA Portal, indicating that you must check the telegram 
configuration. The actual procedure depends on whether suitable alternative I/O addresses 
could be assigned:

● Suitable alternative I/O addresses have been assigned in the TIA Portal that do not match 
the standard I/O addresses in the machine data of the NCU. In this case, the I/O addresses 
in the TIA Portal must be aligned with the I/O addresses in the machine data of the NCU 
(Page 144).

● There are not enough suitable I/O addresses available in the TIA Portal. In this case, you 
must release suitable I/O addresses in the TIA Portal, re-assign them and then align them 
with the I/O addresses in the machine data of the NCU. See: Availability of suitable  I/O 
addresses (Page 146).

If you do not want to make these settings at this time, and have not saved the project, you can 
undo the changes: Click "Undo" in the toolbar.

See also
Matching I/O addresses for use of the optimized I/O addressing schematic (Page 143)

Changing the addressing schematic (Page 118)

6.9.2 Matching of deviating I/O addresses

6.9.2.1 Matching I/O addresses for use of the optimized I/O addressing schematic
If you use the optimized I/O addressing schematic, you must activate it in TIA Portal and you 
must enter the I/O addresses in the machine data, e.g. via SINUMERIK Operate.
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Requirement
● I/O addressing schematic optimized for I/O address extension has been selected.

See also: Changing the addressing schematic (Page 118)

● No user-specific adaptations to I/O addresses exist.
If you have made user-specific adaptations, refer to Chapter Matching user-specific 
adaptations (Page 144).

Procedure
To enter the I/O addresses of the optimized addressing schematic in the machine data, 
proceed as follows:

1. Call or print out the tabular overview for the addressing schematic:

– Adapting I/O start addresses (Page 134)

2. In SINUMERIK Operate, enter the I/O addresses of all related drives into the corresponding 
machine datum (MD). 
For how to change to the machine data in SINUMERIK Operate, refer to the Commissioning 
Manual, "CNC Commissioning: NCK, PLC, Drive for TIA", Section "Communication 
between NC and drive".

6.9.2.2 Matching user-specific adaptations
Default I/O addresses are preset in the machine data of the NCU during the first commissioning 
that match the default I/O addresses in the TIA Portal.
If these default I/O addresses were already assigned during a configuration change (e.g. 
change of the Safety Integrated mode), proceed as follows:

Step Description
1 Check which I/O addresses in the TIA Portal differ from the standard I/O addressing schematic. There are several 

ways to find differing I/O addresses:
● Check the messages in the inspector window, "Info > General" (Page 145)
● Check the address overview in the PLC properties (Page 146)

2 Check in which machine data (MD) of the NCU the differing I/O address is entered. To do this, use the tabular 
overview (Page 134) corresponding to the Safety Integrated mode.

3 Enter the differing I/O addresses in the associated machine data (MD) in SINUMERIK Operate.
For how to change to the machine data in SINUMERIK Operate, refer to the Commissioning Manual, "CNC Com‐
missioning: NCK, PLC, Drive for TIA", Section "Communication between NC and drive".
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6.9.3 Viewing messages in the info area
If, after a configuration change, e.g. deviations from the default scheme, the I/O addresses 
cause conflicts, this information can be viewed in the message log until the TIA Portal is 
restarted. This message log is displayed in various inspector windows depending on the 
message type:

● For example, messages displayed when the device configuration is changed are listed 
under "Info > General". 

● Some conflicts are checked only during the compilation. Such messages are not displayed 
under "Info > General", but rather under "Info > Compile".

Check these messages in order to be able to align the I/O address entries in the TIA Portal with 
the NCU machine data.

The most recent message is always displayed in the status bar of the TIA Portal (lower right). 
This shows at any time whether conflicts have occurred.

The message log is deleted when the TIA Portal is closed or restarted. Therefore rectify or note 
any conflicts before exiting the TIA Portal. If this is not possible, you can discard the changes 
that caused the conflicts or display the information in some other way (e.g. in the address 
overview (Page 117)) before exiting.

Requirement
The default I/O addresses were already assigned at a configuration change (or during the 
compilation) so that alternative valid I/O addresses were assigned.
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Procedure
To directly view after a configuration change (or after the compile) which I/O addresses differ 
from the standard schema, proceed as follows:

1. Click "General" or "Compile" in the "Info" inspector window.
The message log is displayed.

Figure 6-4 The "Info > General" inspector window shows which default I/O addresses were already 
assigned for each individual telegram.

The inspector window has the following options:

– All components and telegrams that differ from the default scheme are listed in the
"Message" column.

– To switch directly to the detail view of the respective component or I/O address, click the
symbol in the "Go to" column.

– To call the associated help entry in the information system of the TIA Portal, click the
symbol in the "?" column.

2. Note the required information.

6.9.4 Availability of suitable  I/O addresses
If the message is displayed that insufficient suitable I/O addresses are available, you must 
release suitable I/O addresses.

Configuring telegrams and drive units
6.9 Deviations from the standard I/O addressing schematic

SINUMERIK 840D sl STEP 7 Toolbox V16
146 Configuration Manual, 12/2019, 6FC5397-0GP40-0BA1



Basic procedure

Release suitable I/O addresses
Check whether you can release suitable address space with one of the following procedures:

● If the associated addresses are PROFIsafe addresses, zoom the process image of the OB1 
in the PLC properties under "Cycle".

● Check which device is occupying the required address range. You may be able to assign a 
different address space to this device in order to release the required I/O addresses.

● Release address space directly by removing empty space that is not required between 
different I/O addresses and adapting the I/O addresses of the relevant device.

Assign suitable I/O addresses
You must then assign suitable I/O addresses to the relevant devices in the TIA Portal.
Devices without suitable I/O addresses are displayed as follows:

● Select the appropriate component (SINAMICS Integrated or NX), then click "Telegram 
configuration" in the "Properties" inspector window.
Cells with unsuitable I/O addresses are highlighted in red.

● If a message showing which I/O addresses were not available has already been displayed, 
you can view these in the "Info" inspector window at "General".

Align the I/O addresses with the machine data of the NCU
Finally, enter the assignment of the I/O address different to the default scheme in the machine 
data of the NCU. Refer to Adapting I/O start addresses (Page 134) to find the machine data in 
which you must align the corresponding I/O address. 

See also:

● Online help of SINUMERIK Operate

● Commissioning Manual, "Commissioning CNC: NCK, PLC, Drive", Section Communication 
between NC and drive
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Configuring I/O 7
7.1 Inserting ADI4 module (840 sl)

Procedure
In order to insert an ADI4 module into the project via the hardware catalog, proceed as 
follows:         

1. In the hardware catalog, navigate to the folder "Distributed I/O > Drive Interfaces > ADI4" 
and select the ADI4 module.

2. Use drag-and-drop to move the ADI4 module from the hardware catalog and place it in the 
network view.
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3. To connect the module to the master system, click "Not assigned" and select the DP
interface.

4. Click the "PROFIBUS_1" bus system and at "General > Network settings" in the "Properties"
tab in the inspector window, change the "Transmission rate" entry from 1.5 Mbit/s to 12 Mbit/
s. The ADI4 module can only be operated with 12 Mbit/s.

Reference
You can find additional information on the precise parameter assignment of the ADI4 module 
in the "ADI4 - analog drive interface for four axes" manual.
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Result
The ADI4 module has been created as new device and connected to the NCU.
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7.2 Installing general station description files for SINUMERIK I/O

Requirement
The current version of the general station description (GSD/GSDML) files to be installed is 
stored on your PG/PC.

Note
General station description files on the Service&Support pages

You can find the current versions of the general station description files in the Siemens Industry 
Online Support:

SINUMERIK I/O: GSD/GSDML files (SIOS) (http://support.automation.siemens.com/WW/
view/en/62332440)

Procedure
To install SINUMERIK I/O via general station description files, proceed as follows:

1. In the "Options" menu, select the command "Manage general station description files
(GSD)".

2. In the "Manage general station description files" dialog, select the folder that contains the
GSD/GSDML files.
The device description files saved in the source path are listed.

3. Select the checkboxes of the files that you want to install.

4. Confirm your entry with "Install".
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Result
The general station description files are installed, and then the SINUMERIK I/O in the hardware 
catalog displayed in the appropriate folders:

● SINUMERIK I/O for PROFINET IO: "Further field devices > PROFINET IO > I/O > SIEMENS
AG > SINUMERIK"

● SINUMERIK I/O for PROFIBUS DP: "Further field devices > PROFIBUS DP > NC/RC >
SIEMENS AG > MOTION CONTROL"

Figure 7-1 Installed SINUMERIK I/O in the hardware catalog
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7.3 Inserting the SINUMERIK I/O module PP72/48

Requirement
● The respective PROFIBUS GSD file or PROFINET GSDML file is installed.

See: Installing general station description files for SINUMERIK I/O (Page 152)

● The network view is active.
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Procedure
Proceed as follows to insert a PP72/48 I/O module:

1. In the hardware catalog, navigate to the respective device:

– PP72/48 (PROFIBUS): "Further field devices > PROFIBUS DP > NC/RC > SIEMENS 
AG > MOTION CONTROL"

– PP72/48 (PROFINET): "Further field devices > PROFINET IO > I/O > SIEMENS AG > 
SINUMERIK > PP72/48"

2. Use drag-and-drop to move the PP72/48 from the hardware catalog to the network view.

3. Interconnect the inserted SINUMERIK I/O with the NCU.
See TIA Portal online help, search term "Interconnect devices in the network view"

Configuring I/O
7.3 Inserting the SINUMERIK I/O module PP72/48

SINUMERIK 840D sl STEP 7 Toolbox V16
Configuration Manual, 12/2019, 6FC5397-0GP40-0BA1 155



Result
The SINUMERIK I/O modules were created as new devices and connected to the NCU.

Additional information
You can find general information about the device in the SINUMERIK I/O module PP72/48D 
2/2A PN manual
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7.4 Inserting SINUMERIK MCP/MPP

Requirement
● The respective PROFIBUS GSD file or PROFINET GSDML file is installed.

See: Installing general station description files for SINUMERIK I/O (Page 152)

● The network view is active.

Procedure
Proceed as follows to insert a SINUMERIK MCP/MPP:

1. In the hardware catalog, navigate to the respective device:

– MCP/MPP (PROFIBUS): "Further field devices > PROFIBUS DP > NC/RC > SIEMENS
AG > MOTION CONTROL"

– MCP/MPP (PROFINET): "Further field devices > PROFINET IO > I/O > SIEMENS AG >
SINUMERIK"

2. Use drag-and-drop to move the corresponding MCP/MPP from the hardware catalog to the
network view.

3. Interconnect the inserted SINUMERIK I/O with the NCU.
See TIA Portal online help, search term "Interconnect devices in the network view"
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Result
The SINUMERIK MCP/MPP has been created as new device and connected to the NCU.

Additional information
General information on the device can be found in the respective manual.

Configuring I/O
7.4 Inserting SINUMERIK MCP/MPP

SINUMERIK 840D sl STEP 7 Toolbox V16
158 Configuration Manual, 12/2019, 6FC5397-0GP40-0BA1



Tag selection with NC VAR selector 8
8.1 NC VAR selector

Introduction
The external tool "NC VAR Selector" obtains addresses of the required NC tags and processes 
them for access in the PLC program (PUT [FB3] and GET [FB2]).

● In the NC VAR Selector, you can select the required NC and drive tag addresses and save
them as ASCII file (*.STL) (Page 160).

● In the TIA Portal, you can import this STL file (Page 162), use it to create data blocks and
so make program access to the tags.

Further information
● A detailed description for the NC VAR Selector is contained in the P3 section of the

SINUMERIK 840D sl Basic Functions Manual: PLC basic program for SINUMERIK 840D sl.

● The block descriptions and other information about the PLC basic program are contained in
the P3 section of the SINUMERIK 840D sl Basic Functions Manual. Basic PLC program.
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8.2 Selecting tags and saving as STL file

Requirement
● The "NC-VAR-Selector" program is installed.

The program is installed automatically when installing the SINUMERIK Toolbox if you have 
selected the program during installation.

Procedure
To select the NC tags to be configured and save them as an STL file, proceed as follows:

1. In the Start menu, click on "All Programs > NC Tag Selector 32 Bit > NCVar Selector".
NC-VAR Selector opens.

2. Select the firmware version of the configured NCU in the "Software version" drop-down list.

3. Select "New" from the "Project" menu.

4. Add all of the necessary tags from the "NcData" and "Sinamics" tag lists into your project list 
in the bottom section. The following options are available:

– You can sort the tags in ascending or descending order by column captions.

– The command "Find, Filter" gives you various filter criteria.

– If you double-click on a tag name, a configuration dialog with a help entry for this tag is 
displayed.

– To add a tag to your project list, double-click on the tag name, adapt the values "Area 
No.", "Row" and "Column" if applicable and confirm with "OK".
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5. Save your project data (*.var).

6. In the "Code" menu, click on "Generate", select a save location for your NC tag file (*.stl) and
confirm with "Save".

Result
The selected tag addresses were saved in an STL file, which you can use in the TIA Portal.
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8.3 Adding a tag file (STL) in the TIA Portal

Procedure
To add the STL file with the selected tags in the TIA Portal as an external source, proceed as 
follows:

1. In the project tree, select "CNC > PLC > External source files > Add new external file".

Note
Displaying external sources (e.g. STL files) using an external editor

The internal editor of the TIA Portal does not display external sources.

If you add and open an external source in the TIA Portal, the file will be opened with the 
application linked with the associated file type (e.g. STL) in Windows (e.g. Microsoft Editor).

In order to be able to open external sources directly from the TIA Portal with any external 
editor, define this once in Windows.

2. Then generate the data block via the shortcut menu "Generate blocks from source".
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Result
You can now address the selected variables in your PLC program and use the PUT [FB3] and 
GET [FB2] blocks to write and read the variables.
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Importing user alarms 9
9.1 Overview

The procedure overview below describes how to copy the SINUMERIK user alarm files directly 
from an NCU and import them into TIA Portal.

Alternatively, the import of alarm files in CSV format is also supported. This can, for example, 
be created if you manage your language-dependent text files with SINUMERIK Integrate 
Access My Machine /P2P.

Requirement
● The user alarms are available in SINUMERIK Operate (or AMM/P2P).

● A SINUMERIK NCU or device proxy (PLC 300) is inserted in the TIA Portal project.

Procedure overview
To use SINUMERIK user alarms in the TIA Portal, proceed as follows:

Ste
p

Description

1 Make the user alarm files available in the required languages. You can copy the files via the SINUMERIK Operate user 
interface, for example to a USB flash drive (Page 166).

2 Check whether all languages or language variants in which you want to import SINUMERIK user alarms are enabled 
as project languages in the TIA Portal.
● To check which exported alarm files correspond to which project languages in the TIA Portal, refer to

Section Language assignment in language-dependent texts (Page 167).
● How to activate the project languages is described in Section Enable project languages (Page 169).

3 Import the SINUMERIK user alarms into the TIA Portal (Page 170).
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9.2 Exporting TS files from SINUMERIK Operate
This section describes how the DB2 alarm texts are exported from the user interface of 
SINUMERIK Operate.

If you have installed SINUMERIK Operate on a Siemens PC system, you can alternatively copy 
the files via the Windows Explorer.

Requirement
● A USB flash drive is inserted into a PC system with SINUMERIK Operate.

● In SINUMERIK Operate, the USB port is activated under "Commissioning > HMI > Log.
Drive"

● Access rights of access level 3 (user) are available in SINUMERIK Operate.

Procedure
To copy TS files from SINUMERIK Operate, proceed as follows:

1. In SINUMERIK Operate select the screen "Commissioning > System data" – and in the
folder structure, navigate in the "HMI data/Texts/Manufacturer/" directory.

2. Select the required TS files and actuate the "Copy" softkey.

3. Select the directory structure of your USB flash drive and press the "Paste" softkey.

Result
The DB2 alarm texts were copied from SINUMERIK Operate as TS files.

You can then subsequently import these files into the TIA Portal.
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9.3 Language assignment in language-dependent texts

Language ID in the file name of language-dependent texts
Language-dependent texts are saved in TS files in SINUMERIK Operate. There is a separate 
file for each language which is assigned via the language ID in the file name.

● <Name><LanguageID>.ts

● E. g.: oem_alarms_plc_eng.ts

Assignment of the DB2 alarm texts to project languages

In the TIA Portal (in contrast to SINUMERIK Operate), language variants of different countries 
are regarded as separate project languages, this means that there are separate entries for e.g. 
English (Great Britain), English (Ireland) and English (USA). If you import an alarm file into the 
TIA Portal, this will be assigned to all of the relevant activated project languages (or language 
variants), depending on the language ID in the file name. For example, if you have activated the 
project languages "English (USA)" and "English (Great Britain)" and imported an 
oem_alarms_plc_eng.ts file, these alarm texts are mapped to the two project languages.

Availability of languages in SINUMERIK Operate
SINUMERIK Operate has 6 languages (standard languages) installed in the factory state. If you 
need additional languages, you can order them separately:

● DVD "Language extension": 6FC5860-0YC40-0YA8

● Software option "Additional languages": 6FC5800-0AN00-0YB0

Storing the active language in the NC block [DB10]
The language that is presently active in SINUMERIK Operate is saved in communication block 
NC [DB10] in address DB10.DBB96 as value.

Table 9-1 Language IDs of language-dependent texts and language values in the block NC [DB10]

Value in DB10.DBB96 Language in SINUMERIK Operate Language code Default language

1 German deu x
2 French fra x
3 English eng x
4 Spanish esp x
6 Italian ita x
7 Dutch nld  
8 Simplified Chinese chs x
9 Swedish sve  
18 Hungarian hun  
19 Finnish fin  
28 Czech csy  
50 Portuguese ptb  
53 Polish plk  
55 Danish dan  
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Value in DB10.DBB96 Language in SINUMERIK Operate Language code Default language

57 Russian rus  
68 Slovakian sky  
69 Slovenian slv  
72 Rumanian rom  
80 Traditional Chinese cht  
85 Korean kor  
87 Japanese jap  
89 Turkish trk  
122 Indonesian ind  
212 Thai tha  
230 Malay msl  
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9.4 Enable project languages
If a multilingual project is created, all project languages, the editing language and reference 
language must be specified in the settings under "Languages and Resources". 

These settings should be made at an early stage because, for example, when copying or 
inserting multilingual objects, only those languages defined as project languages are included.

If a project language is disabled, all text and graphic objects previously created in this language 
are deleted from the current project.

Procedure
1. Double click "Project languages" below "Languages & Resources" in the project navigation.

All selectable project languages are displayed in the working area.

2. Activate the check boxes of all languages and language variants that are to be available as
project languages.

3. Specify the reference and editing languages in the relevant drop-down lists.
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9.5 Importing SINUMERIK PLC alarm texts

Note
System-specific differences

Importing and saving alarm texts can differ in the TIA Portal depending on the specific system. 
Note the corresponding subsection applicable for the system being used, 
e.g. SINUMERIK 840D sl.

Requirement
● A SINUMERIK controller or a device proxy (PLC 300) is inserted.

● The languages in which the TS files are available are activated as project languages 
(Page 169) in the TIA Portal.
If you would like to assign a TS file that is to be imported to several language variants, enable 
all of the desired language variants.

● The TS files of the corresponding language are available on the configuration computer.

Note
Check TS files

Before importing, it should be ensured that all TS files have been fully translated and match 
each other, this means that the same number of alarms are imported and the same alarm 
numbers are used for each of the various languages.
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Procedure
To import SINUMERIK user alarm texts into the TIA Portal, proceed as follows:

1. In the Project tree, right-click the controller or the device proxy, then select "Import 
SINUMERIK PLC alarm texts" in the shortcut menu.
The "Import SINUMERIK PLC alarm texts" dialog opens.

2. Enter the path in which you have saved the user alarm files.

3. Select the file formats which you would like to import in the "File type" drop-down list.

– TS and CSV files

– TS files: Importing DB2 alarm texts that were copied directly from the controller.

– CSV file: Importing of DB2 alarm texts that were converted beforehand into the CSV 
format, for example with AMM /P2P.

4. Check the checkboxes of the desired files individually or activate the higher-level 
checkboxes to import all of the displayed files.

5. Confirm the selection with "Import".

Result
The SINUMERIK user alarm texts have been imported.

Only the alarm texts of the alarm numbers 5xx.xxx … 9xx.xxx relevant in the TIA Portal are 
taken into account here.

Note that the imported texts are only visible in the TIA Portal if one of the languages is selected 
as the editing language for which the texts were imported.

If the SINUMERIK PLC alarm texts are re-imported, the texts in the TIA Portal are deleted or 
overwritten.
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See also
Exporting TS files from SINUMERIK Operate (Page 166)
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Safety configuration 10
10.1 Introduction

The integrated safety functions of SINUMERIK Safety Integrated are used in the machine tools 
sector. In the TIA Portal, you can select one of two Safety Integrated modes in conjunction with 
the SINUMERIK Toolbox:

● Safety Integrated (SPL) (general) (Page 189)

● Safety Integrated plus (F-PLC) (general) (Page 202)

Because the Safety Integrated modes must be licensed (Page 186) and configured differently, 
Safety Integrated is not active as default setting. You should activate the desired Safety 
Integrated mode directly at the start of the configuring work so that the system can assign the 
affected parameters automatically where possible.

The following sample configuring sequences serve as an aid for the configuring and provide an 
overview of this chapter content.

● Configuring Safety Integrated (SPL) (handling overview) (Page 189)

● Configuring Safety Integrated plus (F-PLC) (handling overview) (Page 203)

You can, however, make most settings for Safety Integrated in TIA Portal in any order. If you 
already have experience with configuring SINUMERIK Safety Integrated, you can orient 
yourself on the overview of the Safety Integrated relevant parameters (Page 179).
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10.2 Representation of safety-related resources in the TIA Portal

Overview
Yellow markings identify all safety-related resources in the views of the TIA Portal:

● Network view, device view, topology view

● Project tree

● Hardware catalog

● Inspector window

This also applies to the SINUMERIK components:

● NCU
Because the PLC and SINAMICS Integrated Safety subcomponents support integrated 
functions, the higher-level NCU is marked as safety-oriented resource.

● Integrated PLC

● Integrated SINAMICS Integrated

● NX
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Figure 10-1 Marking of safety-related resources in the TIA Portal

No. Description

1 The project tree shows which components of your project are F-components.
2 In the network view, device view or topology view, the Safety Integrated marking is on the NCU, representative for the integrated 

components. External devices, e.g. NX, may have their own Safety Integrated marking.
3 Safety-related settings are marked in the "Properties" inspector window.
4 Folders and the devices themselves are marked in the hardware catalog. You can therefore see whether SINUMERIK Safety Integrated 

is supported before inserting the device.
5 Fail-safe devices are also marked in the information area of the hardware catalog.

EMERGENCY STOP button symbol when using Safety Integrated plus (F-PLC)
If you activate the "Safety Integrated plus (F-PLC)" mode and therefore use PROFIsafe 
telegrams, all devices with fail-safe modules (PROFIsafe telegrams) have an EMERGENCY 
STOP button symbol in the network and topology view:
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Figure 10-2 NCU with EMERGENCY STOP button symbol
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10.3 Changing the Safety Integrated mode

Procedure
To change the Safety Integrated mode, proceed as follows:

1. Click the NCU in the network or device view and select the "Safety Integrated" entry in the
"Properties" inspector window at "General".

Figure 10-3 Properties inspector window - Safety Integrated when using NCU V4.8

2. Click the "Change Safety Integrated mode" button.
The "Change Safety Integrated mode" dialog opens. If you select an option, the effects of
the mode change are performed here.

Figure 10-4 "Change Safety Integrated mode" dialog when using NCU V4.8

3. Select the required Safety Integrated mode and confirm the reconfiguration with "Yes".
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Result
The Safety Integrated mode has been changed. The precise effects depend on the selected 
mode and can be seen in the "Change Safety Integrated mode" dialog (step 2).

If you are using the Safety Integrated (SPL) mode, configure next the PROFIsafe addresses 
(peripherals (Page 194) or drives (Page 198)).

If problems occur during the changeover, you can find further information in the "Info" inspector 
window at "General".

Note
Effects on telegram configuration

The Safety Integrated mode affects the telegram configuration because, in the Safety 
Integrated plus (F-PLC) mode, different telegrams are used than in the inactivated Safety 
Integrated or the Safety Integrated (SPL) modes.

Telegrams that are added or changed are kept, however, as long as they are compatible with 
the newly selected Safety Integrated mode.

Make sure, if applicable, that any modifications are still present following the change of mode 
in the telegram configuration.

As long as you have not saved the project, you can completely undo the change of the Safety 
Integrated mode by clicking "Undo" in the toolbar.

Further information
General information on the Safety Integrated modes can be found in the following sections:

● Safety Integrated (SPL) (Page 189)

● Safety Integrated plus (F-PLC) (Page 202)

Note also the following documents with information on Safety Integrated:

● Function Manual, SINUMERIK Safety Integrated

● Function Manual, SINUMERIK Safety Integrated plus

● SIMATIC Safety Integrated System Manual
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10.4 Parameterization of relevant properties
The Safety Integrated modes of the NCU control the safety behavior of the NCU together with 
the integrated subcomponents, such as the PLC, SINAMICS Integrated and possibly 
connected NX modules. Depending on the used mode and communications standard 
(PROFINET or PROFIBUS), you must configure further relevant properties and F-parameters 
for various modules. Sample configuring sequences can be found in Sections Configuring 
Safety Integrated (SPL) (Page 189) and Configuring Safety Integrated plus (F-PLC) 
(Page 202).

You can, however, also parameterize the appropriate properties in a different order.

Overview
The following table shows in which device properties and in which section you find a specific 
configuration-relevant setting:

Note that not all parameters are relevant in both Safety Integrated modes. In addition, some 
parameters are displayed only in a specific Safety Integrated mode for the SINAMICS 
Integrated and NX components and the associated telegrams.

Table 10-1 Configuration-relevant properties

Setting Can be found at Further information
Safety Integrated mode (op‐
erating mode)

NCU > Safety Integrated ● This chapter, "NCU properties"
section.

● Changing the Safety
Integrated mode (Page 177)

● Safety Integrated mode (SPL)
● Safety Integrated plus mode (F-

PLC)
Basis for PROFIsafe ad‐
dresses

PLC > Fail-safe > F-parameters ● Information system, keyword
"Basis for PROFIsafe
addresses".

F-source address
(F_Source_Add)

PLC > Fail-safe > F-source ad‐
dresses
(only for Safety Integrated mode 
(SPL))

(for a GSD module, also under 
"Module > PROFIsafe")

● Configuration of the
PROFIsafe addresses
(peripherals)

● Configuration of the
PROFIsafe addresses (drives)

● Information system, keyword
"Special considerations when
configuring the F-system"

F-destination address
(F_Dest_Add)

Module/submodule > F-parame‐
ters

● Information system, keyword
"Special considerations when
configuring the F-system"

DIL switching setting Module/submodule > F-parame‐
ters

● Configuring Safety Integrated
plus (F-PLC) (handling
overview)

● Configuring Safety Integrated
(SPL) (handling overview)
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Setting Can be found at Further information
Default F-monitoring time for 
F-peripherals of this interface

Interface > F-parameters ● Information system, keyword 
"Monitoring and response 
times"

F-monitoring time Module/submodule > F-parame‐
ters

● Information system, keyword 
"Configuring the F-peripherals"

● Information system, keyword 
"Monitoring and response 
times"

I/O address Module/submodule > I/O address‐
es

● Information system, keyword 
"Addressing modules (S7-300, 
S7-400)"

Size of the PLC process im‐
age

PLC > Cycle ● Information system, keyword 
"Settings for the cycle behavior 
(S7-300, S7-400)"

● Information system, keyword 
"S7-300 memory areas"

Name of an I/O system node Device / header module > General ● Information system, keyword 
"Assign device name and IP 
address"

IP address of an I/O system 
node

Device / header module > PROFI‐
NET interface > Ethernet address‐
es

● Information system, keyword 
"Assign device name and IP 
address"

NCU properties
The Safety Integrated mode of the NCU affects not only the configuration of the integrated PLC, 
but rather also that of the integrated drives. 

SINAMICS Integrated and NX modules always use automatically the same Safety Integrated 
mode as the associated NCU. 

Therefore, set this mode in the NCU properties and not in the PLC properties:
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Figure 10-5 Changing the Safety Integrated mode

With the activation of a Safety Integrated mode, the F-capability of the PLC is set appropriate 
for the Safety Integrated mode of the NCU.
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PLC properties
Safety Integrated settings are available in the PLC properties if the NCU uses a safety mode.

Figure 10-6 Fail-safety in the PLC properties - the "F-activation" section is inactive (grayed-out) because the F-activation is 
controlled via the selection of the Safety Integrated mode in the NCU properties.

Loading the changed Safety Integrated mode into the hardware
If the actual hardware has been operated in Safety Integrated plus (F-PLC) mode and you now 
want to load a configured hardware configuration with changed Safety Integrated mode, you 
must perform a general reset of the PLC prior to the loading.

Further information
General information on the Safety Integrated modes can be found in the following sections:

● Safety Integrated (SPL)

● Safety Integrated (F-PLC)

Note also the following documents with information on Safety Integrated:

● Function Manual, SINUMERIK Safety Integrated

● Function Manual, SINUMERIK Safety Integrated plus
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10.5 Availability of I/O addresses at the mode change
If the default I/O addresses for communication with the drive are already assigned when 
changing the Safety Integrated mode, you must configure the telegrams and I/O addresses.

Note
Undoing changes

As long as the project has not been saved, you can undo the change of the Safety Integrated 
mode together with the changed drive telegram and address settings. Click "Undo" in the 
toolbar.
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Refer to the "Change Safety Integrated mode" dialog or the "Info" inspector window to see 
which I/O addresses are effected.

● The "Change Safety Integrated mode" dialog shows the components for which the default
I/O addresses are assigned.

Figure 10-7 "Change Safety Integrated mode" dialog: Default I/O addresses are not available

● The "Info" inspector window shows which default I/O addresses were already assigned for
each individual telegram.

Figure 10-8 You can click the symbol in the "Go to" column in the "Info > General" inspector window 
to display the relevant I/O address.

● You can also display an overview of the telegram settings by clicking "Address overview" in
the PLC properties.
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Figure 10-9 Address overview in the "Properties" inspector window of the PLC

Further information
Detailed information on aligning and configuring I/O addresses can be found in 
Section Configuring telegrams and drive units (Page 115).
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10.6 Licensing

10.6.1 Overview
The integrated safety functions of SINUMERIK Safety Integrated are used in the machine tools 
sector. They are integrated with two channels in the NC, the drive and the internal PLC, and are 
used to monitor speed, standstill and position. Such monitoring is necessary if the danger zone 
of the machines and systems is not blocked off.

During operation, the integrated safety functions provide effective operator protection as well 
as protection of tools, materials and machines.

In the TIA Portal, you can select one of three modes in conjunction with the SINUMERIK:

Mode Requirement
SINUMERIK Safety Inte‐
grated not active

-

Safety Integrated (SPL) ● No additional license is required in the TIA Portal: SIMATIC STEP 7 
Safety without license corresponds to the F-configuration tool from 
STEP 7 V5.x)

● Appropriate software option for SPL
 

Safety Integrated plus (F-
PLC)

● NCU V4.8 or newer
● Appropriate software option for F-PLC

Refer to Section Changing the Safety Integrated mode for a description of how to set the Safety 
Integrated mode.

10.6.2 Software options for Safety Integrated (SPL)
To configure SINUMERIK Safety Integrated (SPL), SIMATIC STEP 7 Safety Advanced (TIA 
Portal) without license suffices. (SIMATIC STEP 7 Safety Advanced without license 
corresponds to the F-configuration tool from STEP 7 V5.x)

To use the configuring in SINUMERIK Operate, you require the appropriate software options:

Table 10-2 Software options for use of Safety Integrated (SPL)

Software option Purpose
SI Basic Activate SPL

Contains a license for one axis/spindle, up to four SPL I/O
SI Comfort Activate SPL

Contains a license for one axis/spindle, up to 64 SPL I/O
SI High Feature Activate SPL

Contains a license for one axis/spindle, up to 192 SPL I/O
SI Axis/Spindle
 

Additional license for one axis/spindle, multiple licensing in order to be able to use 
further axes/spindles.
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Software option Purpose
SI Axis/Spindle 
package

Additional license for 15 axes/spindles, multiple licensing in order to be able to use 
further axes/spindles.

SI-Connect Make more than three FSEND and three FRECV connections available.

Depending on the functionality used, you must license the appropriate software options and set 
in the machine data:

● MD19120 $MN_NUM_SAFE_AXES: Number of SI axes/spindles

● MD19122 $MN_NUM_SPL_IO: Number of SPL I/Os
1 = 4 SPL I/O or SI-Basic software option
2 = 64 SPL I/O or SI-Comfort software option
3 = 192 SPL I/O or SI-High Feature software option

● MD19510 $MN_SAFE_FUNCTION_MASK: Number of FSEND and FRECV connections
SI-Connect software option: Bit 0 = 1

See also:

● SINUMERIK 840D sl Basic Software and Operating Software Commissioning Manual, 
Section SINUMERIK Operate (IM9).

● Function Manual, SINUMERIK Safety Integrated

10.6.3 Software options for Safety Integrated plus (F-PLC)
For the use of Safety Integrated plus (F-PLC), you require the appropriate software options for 
the RT function:

Table 10-3 Software options for the use of Safety Integrated plus (F-PLC)

Software option Purpose
SINUMERIK Safe‐
ty Integrated plus
/SI logic

Activate the F-PLC in SINUMERIK 840D sl in order to process the fail-safe sensors 
and actuators in an F-program.

SINUMERIK Safe‐
ty Integrated plus
/SI axis/spindle

Use the motion control functions of the SINAMICS Integrated in the SINUMERIK 
Safety Integrated plus (F-PLC) mode.
License for one axis/spindle, multiple licensing in order to be able to use further 
axes/spindles.

SINUMERIK Safe‐
ty Integrated plus
/SI multi-axis pack‐
age

Use the motion control functions of the SINAMICS Integrated in the SINUMERIK 
Safety Integrated plus (F-PLC) mode.
License for any number of axes/spindles.

Depending on the functions used, you must license the appropriate software options and set in 
the machine data:

● MD19500 $MN_SAFE_PLC_LOGIC: Safety Integrated plus /SI-Logic basic option

● MD19121 $MN_NUM_DRIVEBASED_SAFE_AXES: Number of axes/spindles in Safety 
Integrated plus (F-PLC) mode
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See also:

SINUMERIK 840D sl Basic Software and Operating Software Commissioning Manual, Section 
SINUMERIK Operate (IM9)

Function Manual, SINUMERIK Safety Integrated plus
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10.7 Configuring Safety Integrated (SPL)

10.7.1 Introduction
With the aid of safe programmable logic (SPL), safety-related sensors and actuators can be 
directly connected to the control's I/O and evaluated by means of software without external 
evaluation units.

In order to check that the NCK SPL and PLC SPL are functioning, the system program 
organizes a cyclic data cross-check between the PLC and the NCK.

Figure 10-10 SPL - data cross-check

The Safety Integrated (SPL) mode is supported by all NCU versions available in the TIA Portal.

The Safety Integrated (SPL) mode has the following characteristics:

● SINAMICS Integrated or connected NX use the SINUMERIK "SI Motion Monitoring"
telegrams, not the PROFIsafe telegrams.

● The user program is programmed like a standard user program in the editors for STL, FBD
or LAD. Each safety-related program must be created in two programming languages in
order to allow the data cross-check (PLC SPL and NCK SPL).

● During the programming, the SGE/SGA of the data block SPL [DB18] is used that you
assign on the NCU (e.g. via SINUMERIK Operate) to the I/O addresses of the field devices.
See: Function Manual, SINUMERIK Safety Integrated

10.7.2 Configuring the F-peripherals
During the configuring of F-peripherals with Safety Integrated (SPL), you can orient yourself on 
the following handling overview with sample configuring sequence. This serves, however, only 
as an introduction to the configuring and programming of SINUMERIK Safety Integrated (SPL).

Therefore, observe the following documentation prior to configuring Safety Integrated (SPL):

● Function Manual, SINUMERIK Safety Integrated
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WARNING

Depending on the application area, the SINUMERIK NCU, being a part of plants and systems, 
requires the observance of special standards and regulations. Observe the appropriate safety 
and accident prevention regulations, e.g. IEC 60204-1 (general requirements placed on the 
safety of machines).

This sample handling overview serves only as an introduction to the configuring and 
programming of STEP 7 Safety Advanced with SINUMERIK. It cannot always be used for 
effective regular operation. Before you do this, ensure that you reference the current version 
of the SINUMERIK Safety Integrated Function Manual. The warnings and other notes 
contained in that manual must be observed, even when they are not repeated in this 
document!

The non-observance of these regulations can lead to severe injuries and damage to machines 
and equipment.

Requirement
● The devices to be configured have been inserted

(at least one NCU and one peripheral device)

● The "Safety Integrated (SPL)" mode is activated in the NCU properties.
See: Changing the Safety Integrated mode (Page 177)

Note
Activating Safety Integrated mode at the start of the configuring work

If you activate the Safety Integrated mode first at the end of the configuring work, it is 
possible that all parameters are no longer assigned automatically by the system and you 
must match these values.

Consequently, activate the desired Safety Integrated mode directly after inserting the NCU.

● The required modules, submodules and telegrams are inserted on the peripheral device.

● The devices are interconnected with each other using the desired interfaces (PROFINET or 
PROFIBUS).
You can also connect devices to the interfaces of both types (PROFINET and PROFIBUS) 
and operate in the Safety Integrated (SPL) mode.

Procedure overview

Step Description
1 Configuring the basis for PROFIsafe addresses

See also: TIA Portal online help, keyword "Basis for PROFIsafe addresses".
2 Configure the input modules. (Page 191)
3 Configure the output modules. (Page 194)
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Step Description
4 If necessary, set the F-monitoring time manually:

● You can configure the parameterization of the F-monitoring time for all devices on a specific interface in the 
interface settings under "F-parameters > Default F-monitoring time for F-peripherals of this interface".

● You can configure each F-module individually under "F-parameters" in the settings of the associated module.
A valid current safety telegram must be received from the F-CPU within the F-monitoring time. Otherwise, the F-
module enters the safe state.
The F-monitoring time should be sufficiently long so that telegram delays are tolerated, but sufficiently short so that 
the process can respond as fast as possible in a fault situation and run without impairments. The Excel file for the 
response time calculation provides help with the time determination.
See also: SIMATIC Safety Help, keyword "Monitoring and response times"

5 Enter the PROFIsafe addresses in the NCU MD. (Page 194)
6 Assign the F-destination addresses. The procedure depends on the associated device:

● For devices with DIP switches, set the DIP switches on the F-modules to set the PROFIsafe destination 
addresses as configured in the TIA Portal.

● For the ET200SP fail-safe modules, assign the F-destination address.
Further information and information for other devices is available in the documentation for your device and from the 
manufacturer.

To use the configuring in SINUMERIK Operate, you require the appropriate software options.

10.7.3 Parameterizing F-input modules
The F-modules and F-submodules to be configured must be selected individually in order to 
make the desired settings in the "Properties" inspector window. You can select the modules 
and submodules in the device view or device overview (in the case of GSD-based devices, only 
in the device overview).

You can set the I/O addresses in the properties of the F-modules and F-submodules. These I/
O addresses must lie within the process image of the PLC. (default setting: 1024 bytes; can be 
configured under "Cycle" in the PLC properties).

You can select F-modules and F-submodules in the device view or device overview of the rack.

Procedure
To configure the inserted F-input modules, select them successively and make the settings 
individually for each module in the inspector window. Proceed as follows:

1. In the device view, select the rack and open the device overview.

2. In the device overview, select on the rack one of the modules to be configured.

3. In the "Properties > General" inspector window, select the "I/O addresses" entry.

4. Select the "OB1-PA" in the "Process image" dropdown list in each of the "Input addresses" 
and "Output addresses" sections.
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5. Enter the desired address in the associated "Start address" text field. Note the following:

– The I/O addresses must lie within the process image of the PLC (default setting: 1024 
bytes; can be configured under "Cycle" in the PLC properties).

– Do not use any I/O addresses that are used for some other purpose, e.g. by the machine 
control panel.

6. In the "Properties > General" inspector window, select the "DI parameters" entry.
The properties will be displayed. Safety-relevant settings are marked yellow.

7. Make the required settings, e.g.

Setting Purpose
Encoder power supply Select the type of the encoder power supply:

● Internal: VS1, VS2 are used; the short-circuit test is 
active

● Internal: VS1, VS2 are not used; the short-circuit test is 
inactive

Encoder evaluation Select the encoder evaluation:
● 1oo2 (2v2) evaluation: Dual-channel activation 2v2
● 1oo1 (1v1) evaluation: Single-channel activation 1v1

Type of encoder connection Select between equivalent or non-equivalent encoder inter‐
connection.

Discrepancy time Specify the discrepancy time in ms.
Reintegration after discrepancy error Select whether Test 0 signal is required.

(Test 0 signal, for example, is required for the EMERGEN‐
CY STOP button)

10.7.4 Configuring drives with F-functions
During the configuring of drives Safety Integrated, you can orient yourself on the following 
handling overview with sample configuring sequence. This serves, however, only as an 
introduction to the configuring and programming of SINUMERIK Safety Integrated (SPL).

Therefore, observe the following documentation prior to configuring Safety Integrated (SPL):

● Function Manual, SINUMERIK Safety Integrated
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WARNING

Depending on the application area, the SINUMERIK NCU, being a part of plants and systems, 
requires the observance of special standards and regulations. Observe the appropriate safety 
and accident prevention regulations, e.g. IEC 60204-1 (general requirements placed on the 
safety of machines).

This sample handling overview serves only as an introduction to the configuring and 
programming of STEP 7 Safety Advanced with SINUMERIK. It cannot always be used for 
effective regular operation. Before you do this, ensure that you reference the current version 
of the SINUMERIK Safety Integrated Function Manual. The warnings and other notes 
contained in that manual must be observed, even when they are not repeated in this 
document!

The non-observance of these regulations can lead to severe injuries and damage to machines 
and equipment.

Requirement
● The devices to be configured have been inserted

(at least one NCU and one drive device)

● The "Safety Integrated (SPL)" mode is activated in the NCU properties.
See: Changing the Safety Integrated mode (Page 177)

Note
Activating Safety Integrated mode at the start of the configuring work

If you activate the Safety Integrated mode first at the end of the configuring work, it is 
possible that all parameters are no longer assigned automatically by the system and you 
must match these values.

Consequently, activate the desired Safety Integrated mode directly after inserting the NCU.

● The required modules, submodules and telegrams are inserted on the drive device.

● The devices are interconnected with each other using the desired interfaces (PROFINET or
PROFIBUS).
You can also connect devices to the interfaces of both types (PROFINET and PROFIBUS)
and operate in the Safety Integrated (SPL) mode.

Procedure overview

Step Description
1 Configuring the basis for PROFIsafe addresses

See also TIA Portal online help, keyword "Basis for PROFIsafe addresses".
2 Configure the PROFIsafe telegrams. (Page 200)
3 Enter the PROFIsafe addresses in the NCU MD. (Page 198)
4 During the commissioning of the drive, enter the PROFIsafe addresses as hexadecimal value in p9610 and p9810.

Further information is available in the documentation for your device and from the manufacturer.

Safety configuration
10.7 Configuring Safety Integrated (SPL)

SINUMERIK 840D sl STEP 7 Toolbox V16
Configuration Manual, 12/2019, 6FC5397-0GP40-0BA1 193



To use the configuring in SINUMERIK Operate, you require the appropriate software options.

10.7.5 Parameterizing F-output modules

Procedure
To configure the inserted F-output modules, select them successively and make the settings 
individually for each module in the inspector window. Proceed as follows:

1. In the device view, select the rack and open the device overview.

2. In the device overview, select on the rack one of the modules to be configured.

3. In the "Properties" inspector window, select the "I/O address" entry.

4. Enter the desired address in the "Input addresses > Start address" field. Note the following:

– The I/O addresses must lie within the process image of the PLC (default setting: 1024 
bytes; can be configured under "Cycle" in the PLC properties).

– Do not use any I/O addresses that are used for some other purpose, e.g. by the machine 
control panel.

5. In the  "Properties" inspector window, select the "DO parameters" entry.
The properties will be displayed. Safety-relevant settings are marked yellow.

6. Make the required settings, e.g.

– Enter the desired value (in ms) under "Read-back time". This time should be set to at 
least 200 ms for large capacitive or inductive loads.

– "Diagnosis: Wire breakage" should be activated

10.7.6 Configuration of the PROFIsafe addresses (peripherals)
The PROFIsafe addresses (F-source address, F-destination address) are used to uniquely 
identify the source and the destination.

Note
Problem solution for the 27220, 27221 alarms (Safety Integrated (SPL))
● Alarm 27220: "PROFIsafe: Number of NCK-F modules (6) <> number of S7-F modules (0)"
● Alarm 27221:  "PROFIsafe: NCK-F module MD $MN_PROFISAFE_IN_ADDRESS[0] 

unknown or "PROFIsafe: NCK-F module MD $MN_PROFISAFE_OUT_ADDRESS[0] 
unknown"

Even if you reuse the existing machine data settings (e.g. using an existing SINUMERIK 
archive), you can change the PROFIsafe addresses. In this case, alarms 27220 and 27221 are 
displayed in SINUMERIK Operate.

You must also modify or augment the details in MD10385, as described here.
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Rules for configuring F-source addresses
When Safety Integrated (SPL) is used, you must enter the associated F-source addresses in 
the MD10385[0..2]. A maximum of three different F-source addresses are permitted throughout 
the system.

You can view the assigned F-source addresses in the PLC properties under "Fail-safe > F-
source addresses".

The assignment methods of the F-source address in the TIA Portal depend on the used F-
peripherals, not on the controller or the used Safety Integrated mode:

● F-peripherals based on the device description file:
The configured F-source address can be set in the properties of the module under 
"PROFIsafe > F_Source_Add".

● F-peripherals for PROFIsafe address type 1 (e.g. F-module ET 200S)
The F-source address has the constant value "1".
(The unique identification is made using the set F-destination address.)

● F-peripherals for PROFIsafe address type 2 (e.g. F-module ET200SP)
The unique identification is made using the F-source address and F-destination address

The "Basis for PROFIsafe addresses" parameter differs in its effect from STEP 7 V5.x. This 
parameter is not used in the TIA Portal to influence the F-source address for fail-safe I/O of the 
PROFIsafe address type 1 (e.g. ET200S).

Requirement
● The software options for Safety Integrated (SPL) are licensed and enabled in the associated 

machine data. 

● A maximum of three different F-source addresses are used in the configuration.
You can view the used F-source addresses in the PLC properties under "Fail-safe > F-
parameters". If more than three different F-source addresses are used, you must 
standardize the F-source addresses because a maximum of 3 different F-source addresses 
can be entered in the MD10385.

● The current configuration is compiled and loaded into the PLC.

● The MD10385, MD10386, MD10387, MD10388 and MD10389 machine data items are not 
yet filled.

● No red LED illuminates on the F-peripherals.
If a red LED illuminates, check and correct the DIP switch setting or the F-source address, 
e.g. using online diagnosis.
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Procedure
To enter the PROFIsafe addresses in the NCK machine data, proceed as follows:

1. In the TIA Portal, open the properties of the associated object:

– Click the PLC and switch in the "Properties" inspector window to "Fail-safe > F-source 
addresses".
A tabular view with the used F-source addresses and the associated values for 
MD10385 is displayed.

– Click the DI/DO modules and switch to "Module > F-parameters > F-destination address" 
in the "Properties" inspector window.

2. In SINUMERIK Operate, call the general machine data and enter the values:

Machine data Value to be entered Property in the TIA Por‐
tal

MD10385[0..2]
 

F-source addresses
$MN_PROFISAFE_MASTER_ADDRESS
Notation: <Identifier for PROFIsafe (5000)><F source 
address as hexadecimal number>
For example, enter "5000001" for F-source address 1.

PLC > Fail-safe > F-
source addresses

MD10386[0..47]
 

F-destination addresses of the F-DI modules
$MN_PROFISAFE_IN_ADDRESS
 
Format: 0s 0x aaaa
s: Bus segment (5 = DP connection on the PLC side)
x : Sub-slot address
Range of values: 0...2
x = 0 addresses the F net data signals 1...32
x = 1 addresses the F net data signals 33...64
x = 2 addresses the F net data signals 65...96
aaaa: Hexadecimal PROFIsafe address of the F mod‐
ule
 
Example:
For example, enter "50000C8" for F-destination ad‐
dress 200.

Module > F-parame‐
ters > F-destination ad‐
dress

MD10387[0..47] F-destination addresses of the F-DO modules
$MN_PROFISAFE_OUT_ADDRESS
 
Format: See above (MD10386)
 
Example:
For example, enter "50000C7" for F-destination ad‐
dress 199.

Module > F-parame‐
ters > F-destination ad‐
dress
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Machine data Value to be entered Property in the TIA Por‐
tal

MD10388[0..47] Inputs of the F-DI modules
$MN_PROFISAFE_IN_ASSIGN
For example, enter "1004" when INSE/INSEP 1 to 4 is 
used.

-

MD10389[0..47] Outputs of the F-DO modules
$MN_PROFISAFE_OUT_ASSIGN
For example, enter "1004" when OUTSE/OUTSEP 1 to 
4 is used.

-

MD10098 Factor for PROFIsafe cycle
$MN_PROFISAFE_IPO_TIME_RATIO
The PROFIsafe cycle is displayed in MD10099 and is 
constructed as follows:
MD10098 (factor for PROFIsafe clock cycle) x 
MD10071 (IPO clock cycle)
The value should lie between 16 ms and 24 ms.

-

The sequence and the index entered for the PROFIsafe addresses is irrelevant.

3. Restart the NCK.

4. Check the enabled input bytes in DBB 138 "Profisafe input bytes". One bit must be set for
each byte.

5. Check the enabled output bytes in DBB 140 "Profisafe output bytes". One bit must be set for
each byte.

Further information
● Detailed information about the SINUMERIK Safety Integrated safety concept and for

MD10385 can be found in the "SINUMERIK Safety Integrated" Function Manual.

● Information about individual machine data items is contained in the online help for
SINUMERIK Operate and in the "SINUMERIK 840D sl detailed description of the machine
data" Lists Manual.

● Information on the parameterization of machine data in SINUMERIK Operate can be found
in the SINUMERIK 840D sl Basic Software and Operating Software Commissioning Manual
in Section SINUMERIK Operate (IM9).
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10.7.7 Configuration of the PROFIsafe addresses (drives)
The PROFIsafe addresses (F-source address, F-destination address) are used to uniquely 
identify the source and the destination.

Note
Problem solution for the 27220, 27221 alarms (Safety Integrated (SPL))
● Alarm 27220: "PROFIsafe: Number of NCK-F modules (6) <> number of S7-F modules (0)"
● Alarm 27221:  "PROFIsafe: NCK-F module MD $MN_PROFISAFE_IN_ADDRESS[0]

unknown or "PROFIsafe: NCK-F module MD $MN_PROFISAFE_OUT_ADDRESS[0]
unknown"

Even if you reuse the existing machine data settings (e.g. using an existing SINUMERIK 
archive), you can change the PROFIsafe addresses. In this case, alarms 27220 and 27221 are 
displayed in SINUMERIK Operate.

You must also modify or augment the details in MD10385, as described here.

Rules for configuring F-source addresses
When Safety Integrated (SPL) is used, you must enter the associated F-source addresses in 
the MD10385[0..2]. A maximum of three different F-source addresses are permitted throughout 
the system.

You can view the assigned F-source addresses in the PLC properties under "Fail-safe > F-
source addresses".

The assignment method of the F-source address in the TIA Portal depends on the used device 
type:

● Drive device based on the device description file:
The configured F-source address can be set in the properties of the telegram under
"PROFIsafe > F_Source_Add".

See also: SIMATIC Safety Help, keyword "Recommendation for allocating PROFIsafe 
addresses"

Requirement
● The software options for Safety Integrated (SPL) are licensed and enabled in the associated

machine data.

● A maximum of three different F-source addresses are used in the configuration.
You can view the used F-source addresses in the PLC properties under "Fail-safe > F-
parameters". If more than three different F-source addresses are used, you must
standardize the F-source addresses because a maximum of three different F-source
addresses can be entered in the MD1385.

● The current configuration is compiled and loaded into the PLC.

● The MD10385, MD10386, MD10387, MD10388 and MD10389 machine data items are not
yet filled.
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Procedure
To enter the PROFIsafe addresses in the NCK machine data, proceed as follows:

1. In the TIA Portal, open the properties of the associated object:

– Click the PLC and switch in the "Properties" inspector window to "Fail-safe > F-source 
addresses".
A tabular view with the used F-source addresses and the associated values for 
MD10385 is displayed.

– In the device overview of the drive device, select the telegram and switch in the 
"Properties" inspector window to "PROFIsafe > F_Source_Add".

2. In SINUMERIK Operate, call the general machine data and enter the values:

Machine data Value to be entered Property in the TIA Por‐
tal

MD10385[0..2] F-source addresses
$MN_PROFISAFE_MASTER_ADDRESS
Notation: <Identifier for PROFIsafe (5000)><F source 
address as hexadecimal number>
For example, enter "5000001" for F-source address 1.

PLC > Fail-safe > F-
source addresses
 
Telegram > PROFI‐
safe > F_Source_Add

MD10386[0..47] F-destination addresses of the F-DI modules
$MN_PROFISAFE_IN_ADDRESS
 
Format: 0s 0x aaaa
s: Bus segment (5 = DP connection on the PLC side)
x : Sub-slot address
Range of values: 0...2
x = 0 addresses the F net data signals 1...32
x = 1 addresses the F net data signals 33...64
x = 2 addresses the F net data signals 65...96
aaaa: Hexadecimal PROFIsafe address of the F module
 
Example:
For example, enter "50000C8" for F-destination ad‐
dress 200.

Telegram > PROFI‐
safe > F_Dest_Add

MD10387[0..47] F-destination addresses of the F-DO modules
$MN_PROFISAFE_OUT_ADDRESS
 
Format: See above (MD10386)
 
Example:
For example, enter "50000C7" for F-destination ad‐
dress 199.

Telegram > PROFI‐
safe > F_Dest_Add

MD10388[0..47] Inputs of the F-DI modules
$MN_PROFISAFE_IN_ASSIGN
For example, enter "1004" when INSE/INSEP 1 to 4 is 
used.

-
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Machine data Value to be entered Property in the TIA Por‐
tal

MD10389[0..47] Outputs of the F-DO modules
$MN_PROFISAFE_OUT_ASSIGN
For example, enter "1004" when OUTSE/OUTSEP 1 to 
4 is used.

-

MD10098 Factor for PROFIsafe cycle
$MN_PROFISAFE_IPO_TIME_RATIO
The PROFIsafe cycle is displayed in MD10099 and is 
constructed as follows:
MD10098 (factor for PROFIsafe clock cycle) x 
MD10071 (IPO clock cycle)
The value should lie between 16 ms and 24 ms.

-

The sequence and the index entered for the PROFIsafe addresses is irrelevant.

3. Restart the NCK.

4. Check the enabled input bytes in DBB 138 "Profisafe input bytes". One bit must be set for 
each byte.

5. Check the enabled output bytes in DBB 140 "Profisafe output bytes". One bit must be set for 
each byte.

Further information
● Detailed information about the SINUMERIK Safety Integrated safety concept and for 

MD10385 can be found in the "SINUMERIK Safety Integrated" Function Manual.

● Information about individual machine data items is contained in the online help for 
SINUMERIK Operate and in the "SINUMERIK 840D sl detailed description of the machine 
data" Lists Manual.

● Information on the parameterization of machine data in SINUMERIK Operate can be found 
in the SINUMERIK 840D sl Basic Software and Operating Software Commissioning Manual 
in Section SINUMERIK Operate (IM9).

10.7.8 Parameterizing PROFIsafe telegrams
The modules and submodules to be configured must be selected individually in order to make 
the desired settings in the "Properties" inspector window. You can select the modules and 
submodules in the device view or device overview (in the case of GSD-based devices, only in 
the device overview).

You can set the I/O addresses in the properties of the telegrams. These I/O addresses must lie 
within the process image of the PLC. (Default setting: 1024 bytes; can be configured under 
"Cycle" in the PLC properties.)

You can select telegrams in the device view or device overview of the rack.
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Procedure
To configure the inserted input modules, select them successively and make the settings 
individually for each telegram in the inspector window. Proceed as follows:

1. In the device overview of the drive device, select one of the telegrams to be configured.

2. In the "Properties > General" inspector window, select the "I/O addresses" entry.

3. Select the "OB1-PA" in the "Process image" dropdown list in each of the "Input addresses"
and "Output addresses" sections.

4. Enter the desired address in the associated "Start address" text field. Note the following:

– The I/O addresses must lie within the process image of the PLC (OB1-PA).

– Do not use any I/O addresses that are used for some other purpose, e.g. by the machine
control panel.
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10.8 Configuring Safety Integrated plus (F-PLC)

10.8.1 Introduction
New safety functions are available with the Safety Integrated plus (F-PLC) mode. 

The following safety functions are used in the SINUMERIK Integrated plus (F-PLC) mode:

● Use of PROFIsafe telegrams for SINAMICS Integrated or connected NX modules

● Programming of F-blocks with F-logic via the editors for F-FBD or F-LAD

● Handling of configurations and the F-library in the same way as with SIMATIC F-CPUs

● Configuration via the Safety Administration Editor (see below)

Safety Administration Editor
In the SINUMERIK Safety Integrated plus (F-PLC) mode, the "Safety Administration Editor" is 
also available in the project tree.

It supports the following tasks:

● Display of the safety program status

● Display of the F-collective signature

● Display of the safety mode status

● Creation/organization of F-runtime groups

● Display of information on the F-blocks

● Definition/change of the access protection

● Definition/change of the general settings for the safety program

The Safety Administration Editor is divided into the following sections:

● General

● F-runtime groups
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● F-blocks

● Access protection

● Settings

F-libraries
You can not only store F-blocks in global libraries and project libraries as master copies, but 
also use them as already tested and approved safety functions. 

However, you must observe additional conditions, which are described in the following help 
functions:

Help on SIMATIC Safety, Section "Acceptance of the system"

TIA Portal online help, Section "Libraries"

Reserved block numbers for SINUMERIK Safety Integrated plus (F-PLC)
An F-runtime group is created when you activate Safety Integrated plus (F-PLC) mode. An 
associated F-FB, F-FC and F-DB is created in the reserved number range for F-runtime groups:

Reserved number range for F-runtime groups

● F-FB 1010..1019

● F-FC 1010..1019

● F-DB 1010..1019

Further reserved number range for F-runtime groups

● F-FB: 3999..7999

● F-FC: 3999..7999

● F-DB: 8000..16000

See also: Assignment overview (Page 66)Creating a second F-runtime group for Safety 
Integrated plus (F-PLC) (Page 205)

Further information
Detailed information on the Safety Administration Editor can be found in the Programming and 
Operating Manual SIMATIC Safety – Configuring and Programming, or in the section with the 
same name in the TIA Portal online help.

10.8.2 Configuring Safety Integrated plus (F-PLC)
The following basic procedure only roughly lists the project planning steps that are performed 
in TIA Portal and specific to SINUMERIK. Commissioning is described in detail in the following 
documentation:

● SINUMERIK Safety Integrated plus Commissioning Manual

The SINUMERIK Safety Integrated plus documentation only serves to clarify the special 
features in contrast to a S7-300 CPU and are only meant to be an introduction to configuring 
and programming SIMATIC Safety for SINUMERIK.
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Therefore, observe the following documentation prior to configuring Safety Integrated plus (F-
PLC):

● SIMATIC Safety - Configuring and Programming

● SIMATIC Safety - Getting Started

Note
Validity and scope of the information about SIMATIC STEP 7 Safety

This handling overview provided as example only serves as an introduction to configuring and 
programming of SIMATIC Safety for SINUMERIK in the TIA Portal. It cannot always be used for 
effective regular operation.

The following documentation is the main source of all information regarding functional safety 
relating to configuring and programming in the TIA Portal:
● SIMATIC Safety

This also applies in the case of discrepancies between this manual and the SIMATIC STEP 7 
Safety manual.

The warnings and other notes contained in that manual must be observed, even when they are 
not repeated in this document!

WARNING

Danger to life if the safety instructions and residual risks are not observed

If the safety instructions and residual risks in the associated software and hardware 
documentation are not observed, accidents involving severe injuries or death can occur - and 
machines and equipment could be damaged.
● Observe the safety instructions given in the documentation on SINUMERIK Safety 

Integrated plus, SIMATIC Safety and SINAMICS S120 Safety.
● Observe the safety instructions provided in the hardware documentation.
● When evaluating the risks, take into account residual risks.

Note
Compliance with applicable standards and regulations

Depending on the application area, the SINUMERIK NCU, being a part of plants and systems, 
requires the observance of special standards and regulations. It is absolutely crucial that you 
observe the appropriate safety and accident prevention regulations, e.g. IEC 60204-1 (general 
requirements placed on the safety of machines).

Requirement
● A project is created in the TIA Portal and an NCU added.
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Basic procedure
● Activate the SINUMERIK Safety Integrated plus (F-PLC) mode in the NCU properties

(Page 177).

● With the activation of the F-capability of the NCU, among other things, an F-execution group
is created and telegrams are inserted for PROFIsafe and SIC/SCC.

● Add the desired components (e.g. peripheral device, drive device, NX module, etc.).

● In the network view, interconnect the peripheral device or drive device with the PROFINET
interface X150 of the NCU.

● Check the PROFIsafe addresses. (Page 209)

● If necessary, set the F-monitoring time manually.

● Assign the F-destination addresses. The procedure depends on the associated device.

Information on the commissioning steps to be carried out in SINUMERIK Operate and on 
acceptance can be found in the SINUMERIK Safety Integrated plus Commissioning Manual.

See also
Programming and operating manual "SIMATIC Safety - Configuring and Programming" (https://
support.industry.siemens.com/cs/products?search=SIMATIC
%20Safety&dtp=Manual&pnid=24471)

10.8.3 Creating a second F-runtime group for Safety Integrated plus (F-PLC)
An F-runtime group is automatically created when you activate Safety Integrated plus (F-PLC) 
mode. The "Program blocks" folder contains the created F-blocks of the F-runtime group: 
CYC_INT5 [OB35], Main-Safety [FB1010] and Main-Safety_DB [DB1010].

The procedure how you can create a second F-runtime group is described below, e.g. to 
organize fast-running safety-oriented program sections in a dedicated F-runtime group.

Characteristic SINUMERIK-specific features are described in particular. Detailed information 
can be found in the SIMATIC Safety help, Chapter "Defining F-runtime groups".

Procedure
To create a second F-runtime group, proceed as follows:

1. In the project tree, double-click the command "Safety administration", e.g. under "CNC_1 >
PLC_1".

2. In the Safety Administration Editor, select the "F-runtime group" entry in the sector tree.
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3. Click "Create new F-runtime group".
The "Add new F-runtime group for PLC_1" dialog opens.

Figure 10-11 "Add new F-runtime group for PLC_1" dialog

4. Adjust the settings:

– In the "Calling block" section, you select the desired block, e.g. the organization block
with the number 32 [OB32].
(You can then adapt the cyclical execution time of the calling block in the properties of
the PLC under "Alarms > Watchdog interrupts".)

– In the "Main safety block" section, enter a free block number reserved for Safety
Integrated in the "Number" text field: 1010..1019.
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5. Confirm the entries with "OK".
The "Call options for PLC" dialog opens.

Figure 10-12 "Call options for PLC_1" dialog

6. In the "Number" text field, enter a free block number reserved for Safety Integrated: 
1010..1019.

7. Confirm the creation of the data block with "OK".

8. Right-click the NCU in the project navigation and select the "Compile > Hardware and 
software (only changes)" command.
The configuration will be compiled. This may create further program blocks and F-constants 
that are useful for programming.

Result
The F-runtime group has been created in the "Program blocks" folder. The Safety 
Administration Editor provides an overview of all available F-blocks.

Further information
● Information about the reserved number range can be found under Introduction (Page 202).

● Information on block assignments can be found in the SINUMERIK 840D sl Function 
Manual Basic Functions.

10.8.4 Configuring PROFIsafe
The safety functions can be controlled via PROFIBUS DP using the PROFIsafe profile. 
Telegrams are available for the data exchange with the higher-level controller which enable the 
triggering of the safety functions in the converter by the controller as well as the feedback of the 
status of the safety functions from the converter to the controller.
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PROFIsafe address type for SINAMICS Integrated and NX
SINAMICS Integrated, as integrated subcomponent of the NCU as well as of NX modules are 
considered as F-I/O of PROFIsafe address type 1 in the TIA Portal. (This address type is also 
valid for other SINAMICS drives.)

For the I/Os of PROFIsafe address type 1, the uniqueness of the PROFIsafe address is only 
ensured by the F-destination address (F_DEST_ADD). The F-source address has no effect on 
the uniqueness of the PROFIsafe address.

The F-destination address must therefore be unique throughout the network and CPU (see 
SIMATIC Safety Help, keyword "Rules for address assignment").

Configuration of safety telegrams
Safety telegrams can be configured in the properties of SINAMICS Integrated or NX under 
"Cyclic data traffic".

Safety-relevant parameters, such as the fields for PROFIsafe addresses, are displayed if a 
PROFIsafe telegram was added:

● The telegram configuration of SINAMICS Integrated or NX modules is automatically
adapted when you activate the Safety Integrated plus (F-PLC) mode. PROFIsafe telegrams
are added here.

● For additionally connected drive units, add a PROFIsafe telegram in the device overview.

Unique PROFIsafe addresses
For safe operation, you must check whether the used PROFIsafe addresses are unique before 
starting the communication.

The uniqueness of the PROFIsafe address is only ensured by the fail-safe destination address. 
The PROFIsafe address must be unique throughout the network and the CPU.

You can configure the fail-safe destination address under "Cyclic data exchange" in the 
properties of the PROFIsafe telegrams (Safety actual value or Safety setpoint value).

WARNING

Unique PROFIsafe addresses

You must ensure the unique assignment of the PROFIsafe address throughout the network 
and the CPU. 
● The fail-safe I/O of PROFIsafe address type 1 is addressed clearly by its fail-safe

destination address.
● The fail-safe destination address of the fail-safe I/O (drive units in this case) must be

unique for the entire fail-safe I/O throughout the network and the CPU (system-wide). The
fail-safe I/O of PROFIsafe address type 2, e.g. modules of the ET 200SP type, must also
be taken into account.

● Note also the corresponding documentation in the TIA Portal online help in Section
"SIMATIC Safety - Configuration and programming".
(SIN001)
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Acceptance of the system
Information on the acceptance of a safety configuration with controller can be found in the TIA 
Portal information system under "Acceptance of the system".

Note
Error-free hardware and software transmission

Error-free HW and SW transmission is the prerequisite for the creation of the safety printout for 
acceptance purposes. Only then is it assured that all consistency checks have been performed 
and therefore the safety printout created for a consistent project.

10.8.5 Checking the PROFIsafe address

Unique PROFIsafe address
To ensure safe communication, unique PROFIsafe addresses are required throughout the 
CPU and the network.

For this reason, it is also necessary that you check the settings of the PROFIsafe addresses 
carefully.

WARNING

Unique PROFIsafe addresses

You must ensure the unique assignment of the PROFIsafe address throughout the network 
and the CPU. 
● The fail-safe I/O of PROFIsafe address type 1 is addressed clearly by its fail-safe

destination address.
● The fail-safe destination address of the fail-safe I/O (drive units in this case) must be

unique for the entire fail-safe I/O throughout the network and the CPU (system-wide). The
fail-safe I/O of PROFIsafe address type 2, e.g. modules of the ET 200SP type, must also
be taken into account.

● Note also the corresponding documentation in the TIA Portal online help in the section
"SIMATIC Safety - Configuration and programming".
(SIN001)

During compilation of the safety program, a warning indicates the importance of unique 
PROFIsafe addresses:
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Creating and checking the safety printout of the PLC
Create the safety printout by right-clicking on "Safety administration" and selecting "Print" in the 
shortcut menu.

All the relevant data is listed in the safety printout. 

Note
Error-free hardware and software transmission

Error-free HW and SW transmission is the prerequisite for the creation of the safety printout for 
acceptance purposes. Only then is it assured that all consistency checks have been performed 
and therefore the safety printout created for a consistent project.

Example of a safety printout
Here is an example of an NCU 730.3 PN with SINAMICS Integrated standard configuration (6 
drive objects).

In the SINAMICS Integrated overview table, the PROFIsafe addresses of the individual drive 
objects are listed under "F-destination address".

Figure 10-13 PROFIsafe address in the safety printout

In the tables below, further details on the PROFIsafe telegrams of the individual drive objects 
are listed.

Checking the PROFIsafe address in the safety printout
● Compare the PROFIsafe address with the value of the drive parameter p9610 in

SINUMERIK Operate.

● Compare this PROFIsafe address with the values of all other nodes and ensure uniqueness.
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Further information
● Information on the configuration of drives with PROFIsafe via SINUMERIK Operate can be

found in the SINUMERIK Safety Integrated plus Commissioning Manual.

● Further information on the unambiguousness of PROFIsafe addresses can be found in the
Programming and Operating Manual, SIMATIC Safety – Configuring and Programming, or
in the section with the same name in the information system of the TIA Portal, particularly in
chapter "PROFIsafe addresses for F-I/Os of PROFIsafe address type 1".
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